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1 Introduction
Curious World Maps has for years kept its position as the broadcast industry’s 
number one tool for the creation of branded 2D maps and geographic animations. 
Vizrt has taken the leading map creation tool to a new level by adding support for 
real-time 3D maps and adding the option to extend it to a client-server solution. 
Viz Curious Maps (CM) takes branded map imagery and provides it to different 
clients that are embedded within Vizrt’s control applications like Viz Trio and Viz 
Content Pilot. Templates created within CM can also be accessed by Viz Weather, 
through a newsroom plugin, Viz Artist, and even NLE systems.

This tight integration allows users to seamlessly create branded, animated maps 
and add them to graphic templates or insert them directly into a 3D scene.

The map-making capabilities of CM can be further expanded with different map 
data types in resolutions of up to 60 cm/pixel. High-resolution satellite imagery 
from around the world can instantly be browsed, download and incorporated. 

Viz World Client (WoC) Integrates CM mapping ability and database into Viz Artist 
and Viz Engine graphics. By utilizing a set of geographic referencing plugins and 
the maps produced by WoC, the creation of location based graphics using maps, 
3D objects, texts, and so on, is seamless.

WoC includes a set of Viz Artist plugins and the Viz World Maps Editor (WME). The 
editor is integrated into Vizrt products, simplifying production and control of the 
graphics.

Usage of WoC clients requires one or more Viz World Servers (WoS) installed, 
running and connected to the network. WoS is a software module used for 
creating template based maps and managing client requests. All the map styles, 
map projects and designs are stored on the server. The server’s license 
determines the number of concurrent client connections and the available data 
sets. For more information, please refer to other Viz Curious Maps and Viz World 
related user and administrator guides.

This section contains information on the following topics:

• Document Structure
• Related Documents
• Contact Vizrt

1.1 Document Structure
This section gives a short introduction to the WoC, and what part it plays in the 
complete CM solution.

The About section gives an overview of the new features and basic workflow.

The Requirements section describes the license, software and hardware 
requirements for both WoS and WoC.
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The Viz Curious Maps section introduces the Viz Curious Maps (CM) application 
which is the tool for creating map templates with different styles, projections and 
so on. It also describes how to create a basic template, explaining the connection 
between CM, WoC and the WoS.

The Viz World Server section describes how to install, run and remove Viz World 
Server (WoS).

The Server Configuration section describes the map server configuration tool, and 
in addition it explains how to add a license file.

The Server Launcher section describes the possible server configurations that 
allow users to configure single or multiple servers to balance the server load and 
optimize redundancy.

The Cache Configuration section describes the maps caching mechanism.

The Viz World Client section gives a brief overview of the Viz World Client (WoC), 
some requirements and recommendations, installation and removal notes.

The Viz World Maps Editor section describes the Viz World Maps Editor (WME) user 
interface and how to select and edit maps for use with graphics templates and 
scenes.

The Maps Plugins section describes all plugins available to designers that design 
Viz Artist scenes. As an extension to the plugins section, you also have a section 
on Geographically Referenced Maps.

1.2 Related Documents
For complementary information, see the following documents:
1. Viz Artist User’s Guide: Information on how to create graphics scenes in Viz 

Artist.
2. Viz Content Pilot User’s Guide: Information on how to create content based on 

templates and how to play out elements in playlists based on these templates.
3. Viz Curious Maps User’s Guide: Information on how to create map projects 

and map project templates.
4. Viz NLE Administrator’s Guide: Information on how to use your graphics in a 

non-linear editing tool.
5. Viz Trio User’s Guide: Information on how to create real-time character 

generated content based on templates and how to play out pages in shows 
based on these templates.

6. Viz Weather User’s Guide: Information on how to create real-time generated 
weather information and interactive shows using branded maps.

1.3 Contact Vizrt
We encourage your suggestions and feedback regarding the product and this 
documentation. Our support E-mail address is support@vizrt.com. You are also 
welcome to use the web-based support at www.vizrt.com, or to contact your local 
Vizrt support personnel by telephone.
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2 About
This section describes the new features of the Viz World Client and Server, and the 
basic workflow from design to playout.

This section contains information on the following topics:

• New Features
• Workflow

2.1 New Features
• Support for new Digital Globe imagery.
• New Plugin 3D Map Telestrator.
• New Plugin Label AddOn.
• New plugin Hops Manager.
• Place Finder plugin has many improvements and is now official.
• NavFade plugin supports fading on movement.
• NavFinder link option has many improvements.
• Geo Text plugins supports location options.
• NavCom plugin supports multitouch navigation and search options.
• This version comes with its own Viz World Server REST Support.
• Map server supports moving of locations from database.

2.2 Workflow
The basic workflow from design of templates to playout is as follow:
1. First step of the process is to create a single (or multiple) in-house map 

project template that sets the look and feel of all the produced maps later in 
the production chain. This is done using Viz Curious Maps (CM), selecting for 
example style and color on the selected map area, type of border lines, label 
fonts and available marker icons.

2. The designed map project template is made available to users of Vizrt client 
software via the Viz World Server (WoS).

3. A graphic designer creates Viz scenes that include maps, based on the same 
map project template now residing on the Viz World Server. The designer has 
the option to create 2D or 3D labels and markers inside Viz, instead of using 
the ones exposed in Viz Curious Maps.

4. Based on the Viz scenes, graphical templates can be made for other Vizrt 
applications.

5. An editor opens a template, from for example the Viz Content Pilot or Viz 
Weather system, and creates a map to fit the main news or weather story of 
today.



3 Requirements
This section describes the prerequisites such as the licensing, software and 
hardware requirements.

To install and configure the software, please see Viz World Server, Viz World 
Client and Server Configuration.

This section contains information on the following topics:
• License Requirements
• Software Requirements
• Hardware Requirements
• Ports and Connections

3.1 License Requirements
The following licenses are needed to run Viz World Server and Viz Engine:
• A USB dongle license for Viz Engine.
• A USB dongle license for Viz World Server

Note: Viz World Server is a feature included in the license file. If the server has 
additional features enabled, make sure the new license covers those features as well.

3.2 Software Requirements
• Viz World Server (WoS) and Viz World Client (WoC) version 11.0 installation is 

required.
• It is recommended to install the server on a different machine.

• Viz Curious Maps (CM) database version 11.0 or later is required.
• Microsoft .NET Framework 4 is required for the Map Builder wizard.

To set up a Viz Curious Maps solution for graphics design, the following software 
and version numbers are needed.
• Viz Artist 3.2.2 or later
• Viz Artist 2.8 patch level 4 or later and Extra Viz 2 Plugins 1.9 or later

For a newsroom/control room operation with Viz Curious Maps solution, the 
following version numbers are required:
• Viz Trio 2.7 or later
• Viz Content Pilot 5.3 or later
• Media Sequencer 1.19 or later.

3.3 Hardware Requirements
Minimum server hardware configuration:
• CPU: Intel Core2 CPU, 2.0 GHz
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• Memory: 4GB
• Hard disk space: A full installation requires 1.3 GB free disk space. Optional 

data packages will require between 4GB to 500GB free disk space.
• OS: Microsoft Windows XP Professional.

Recommended server hardware configuration:
• CPU: 2 x Intel Xeon CPU, 3.2 GHz
• Memory: 8GB
• Hard disk space: A full installation requires 1.3 GB free disk space. Optional 

data packages will require between 4GB to 500GB free disk space.
• OS: Microsoft Windows XP64 Professional or Microsoft Windows Server 2003.

When using more than one server on a single machine (with Server Allocator) the 
recommend hardware is needed.

Also note that fast and multiple CPU cores are the most important component of 
WoS.

See Also
• Server Launcher Configuration

3.4 Ports and Connections
The following describes all connections and default listening port numbers that 
are important for any system/network administrator to know of. However, it is, if 
possible, recommended to run the system on a network without firewalls.

102 (TCP) is a Viz World Server listener port for Viz World Client connections when 
Server Allocator is not in use or only has one Viz World Server running.

103 (TCP) is a Viz World Server listener port for configuration tool connections to 
the first Viz World Server instance (as configurations are controlled by the first 
server instance).

10100 (TCP) is a Server Allocator listener port for Viz World Client connections, 
and is only used in order for clients to get connection details about Viz World 
Server(s). The first client connection will always be diverted to port 102. In case of 
Multiple server instances port numbers are assignmed according to a predefined 
schema. In case there is no Server Allocator, Viz World Server will itself switch to 
port 102.

10100 (UDP) is a Viz World Server listener port for Server Allocator 
communication.

10200 (UDP) is a Server Allocator listener port for Viz World Server 
communication.

Both UDP ports are internal ports used between the servers.

Multiple server instances
If a machine is running multiple Viz World Server instances every extra instance 
(second and above) opens other ports by this formula:
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• Viz World Server listener port (TCP): 10100 + ID – 1.
• Server Allocator listener port (UDP): 10200 + ID – 1 (this is an internal port 

between servers) (where ID indicates the instance, e.g. 3rd server, ID = 3).

If four Viz World Server instances are configured, the following listener ports will 
be used:
• 102 (TCP): 1st instance
• 10101 (TCP): 2nd instance
• 10102 (TCP): 3rd instance
• 10103 (TCP): 4th instance

• 10100 (TCP) : Viz World Client(s) connection to the Server Allocator.
• 103 (TCP): Configuration tool connection to the Viz World Server.

Internal ports used by Server Allocator and Viz World Server(s) to communicate 
between themselves:
• 10100 (UDP): Server Allocator 
• 10200 (UDP): 1st instance
• 10201 (UDP): 2nd instance
• 10202 (UDP): 3rd instance
• 10203 (UDP): 4th instance
6 Chapter 3: Requirements



4 Viz Curious Maps
 Figure 1: Viz Curious Maps

This chapter introduces Viz Curious Maps (CM) which is the design tool for all 
map templates used by Viz World Client (WoC) and Vizrt’s control applications. 
This guide will not cover the aspects of maps design; however this chapter will 
explain important elements to note when creating a basic map template. For more 
information on template design see the Viz Curious Maps User’s Guide.

CM is a powerful design tool with a database back-end, used for the creation of 
branded maps and geographic animations. By extending CM to a server edition, it 
can provide real-time, branded map imagery to several clients embedded within 
Vizrt’s control applications. Templates created within CM can be dynamically 
accessed through Vizrt’s control applications using the WoC.

CM has a comprehensive vector based database that includes regions, cities, 
roads, rivers, and so on. The vector data is supplied to Vizrt under license from 
Bartholomew Mapping (a division of Harper Collins publishers).  CM also includes 
global 1km relief data in the DEM (Digital Elevation Model) format.  The DEM data 
is from the United States Geological Survey (USGS).  Essentially, CM uses the best 
mapping data available and is a full animation and compositing system.

This section contains information on the following topics:
• Project Template
• Styles Editor
Chapter 4: Viz Curious Maps 7



• Markers
• Map Projection
• Map Position and Project Area Offset
• Layer Stack and No Animation

4.1 Project Template
It is good practice to place all template (TPL) files in a single static location.

The recommended location is:
• ..\Program Files\Curious Software\Curious World 

Maps\Users\Default\Projects

This folder and any sub-folders are automatically scanned for TPL files when the 
Map Server is launched.

Note: The template location should be exactly the same on both the Maps Server and 
any Viz Curious Maps standalone design systems.  If the paths are not identical it 
may well break the link to any image elements, e.g. Markers.

This section contains information on the following topics:
• To open a project template
• To save a project template

To open a project template
1. Select Open... (CTRL+O) from the File menu.
2. Select Project Template (*.tpl, *.tpt, *.cgt) from the Files of type drop-list.
3. Select the template file and click Open.

To save a project template
1. Select Save (CTRL+S) from the File menu.
2. Select Project Template (*.tpl) from the Save as type drop-list.
3. Enter a filename, and click Save.
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4.2 Styles Editor
 Figure 2: Styles Editor

Using the Viz Cuious Maps (CM) Styles Editor, users can choose to modify an 
existing default Style Sheet or create a new one.

The user has the ability to define and fully customize all of the available map data 
elements via the CM’s Styles Editor.  For example, the user can set region colors, 
select any font (TrueType only), assign any static image (images with alpha are 
supported) as a marker, modify shadow settings, change relief scale and lots 
more!

The map Style Sheets defined within the CM Styles Editor are then saved as Project 
Templates (TPL files).  Each Project Template can include any number of Style 
Sheets.  These Project Templates can then be accessed via the Viz World Maps 
Editor (WME) within other Vizrt products, such as Viz Artist, Viz Trio, Viz Content 
Pilot, and so on.

4.3 Markers
Many users work with customized Markers; hence, image files can be imported to 
Viz Curious Maps (CM) from any location. CM will create a Relative or Absolute file 
path to the actual image file (depending on its distance from the TPL).  If CM 
cannot locate an image file it will replace it with a ‘missing material’ red X.
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 Figure 3: Markers

It is good practice to place all Markers in a single static location, as opposed to 
multiple folders on a local computer and/or network.

The recommended, and default, location is:
• ..\Program Files\Curious Software\Curious World Maps\Markers

Note: When exporting a map related Viz Artist scene archive it is important to also 
include the TPL files and any referenced image files (used for Markers, and so on).
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4.4 Map Projection
 Figure 4: Map projection

An essential setting for 3D globe building in Viz Artist is To set the map 
projection to an equidistant cylindrical projection (also known as equirectangular 
or geographic projection). When using the map on a 3D globe in Viz Artist it will 
give the right (or more correct) representation of the world.

Note: In Viz Artist vertex mapping should be used when creating 3D globes.
Chapter 4: Viz Curious Maps 11



 Figure 5: Wrong and correct projection

Using the wrong projection within Viz Artist, for example, with the Map Tiler 
plugin to build a 3D globe, will produce a distorted projection.

This section contains information on the following topics:
• To set the map projection

To set the map projection
1. Select the Properties tab.
2. Select from the Projection drop-list the Cylindrical Equidistant projection.
3. Select “The World” from the View drop-list (lower-right corner) to check that 

the map is a flat and not a globe view of the World.
4. Click Apply.

Note: This test also works well via the WME in Viz Artist, and so on.

4.5 Map Position and Project Area Offset
Within Viz Curious Maps (CM) there are two sizes to be aware of, the Project Size 
and the Map Size.  Both of these sizes have their own specific purpose and can 
have different values; however, if the sizes are different or if the Map Position 
does not match the Project Area exactly, the map will not look right when used in 
Viz Artist, Viz Trio, Viz Content Pilot, and so on. Even a miniscule offset will break 
the map. 

Example: The Map Rectangle Tool (on the vertical toolbar) allows the user to freely 
move the map around and can easily move the map out of position.

To avoid the issue entirely, one should delete the Map Layer and add a new one.  
This automatically adds a map that fits the current Project Size, but note that it 
will be using the Globe projection and requires correction.

This section contains information on the following topics:
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• To set the project size
• To set the map size
• To add a new layer

To set the project size
1. Select Project Settings from the File menu.
2. In the Project Settings dialog box set the Width and Height parameters.
3. Click OK to confirm the new project settings.

To set the map size
1. Select the Properties tab on the Properties panel.
2. Select the Transform options, and set the same Size (X and Y) that was used To 

set the project size.
3. Press Enter to confirm and update the map.

To add a new layer
• Select Add Layer > Map from the Layer menu.

4.6 Layer Stack and No Animation
To avoid problems with the template (TPL) file, it is good practice to ensure that 
only one layer is present in the Layer Stack. It is also important to remain at frame 
1 in the timeline and refrain from adding any animation keyframes.
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5 Viz World Server
This section describes how to install, run and remove Viz World Server (WoS).

This section contains information on the following topics:
• Installing Viz World Server

See Also
• Viz World Server REST Support

5.1 Installing Viz World Server
Before an installation, check that the following hardware and software is available:
• Viz World Server USB license dongle and license file
• Viz Curious Maps full version (available locally or on the network)

This section contains information on the following topics:

• To download the software
• To install Viz Curious Maps Data
• To install Viz Curious Maps
• To install Viz World Server
• To run the Server
• To remove Viz World Server

To download the software

Whilst you have an active map support contract, you have a personal login to the 
Vizrt FTP server (first year support is included).

• Download the software from the Vizrt FTP at ftp://download.vizrt.com/ under 
the Viz Curious Maps folder.

Note: You will need to use an FTP Client to access this site and not a regular web 
browser.

Please use the FTP server to find the latest Vizrt software releases, 
documentation, help files, drivers and more. You can also use the FTP to upload 
and exchange files with Vizrt.

To install Viz Curious Maps Data
1. Start the Viz Curious Maps Data installer
2. Click Next
3. Click Install to begin the installation
4. Click Finish
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To install Viz Curious Maps
Before Viz Curious Maps is installed, you have To install Viz Curious Maps Data.

Note: Exit all Windows programs before running the Setup Program.

1. Start the Viz Curious Maps installer
2. Click Next
3. Click Yes to accept the license agreement
4. Select destination directory, and click Next

• C:\Program Files\Curious Software\Curious World Maps

5. Choose the components to install, and click Next
6. Select a start menu group, and click Next
7. Click Next to start the installation
8. Click Next to accept the Sentinel SuperPro Drivers installation
9. Confirm the installation of the Sentinel SuperPro Drivers
10.Click Finish
11.Optional: Install QuickTime if it is not previously installed.

• If a newer version of QuickTime is installed the installation will be stopped.

Tip: If you do not already have QucikTime installed you can download the installer 
from the Apple website.

12.Click Next to continue
13.Choose setup language, and click OK
14.Click Yes to accept the license agreement
15.Choose destination folder, and click Next
16.Configure file and MIME types, and click Finish
17.Place the relevant Natural Earth files in the following location:

..\Program Files\Curious Software\Curious World 
Maps\MapData\NaturalEarth

18.Place any relevant street data in the following location:
..\Program Files\Curious Software\Curious World 
Maps\MapData\StreetData

19.Place the large DEMGlobal90m folder in a location of your choosing. 
• Once Viz Curious Maps is up & running point the application to the data via:

View\Options\Map Data\Locations\CDEM Data

20.Optional: Install the dongle driver in the following location:
..\Program Files\Curious Software\Curious World 
Maps\Installers\AladdinHardLock

• Installing the driver will allow Viz Curious Maps to detect and work with the 
provided Vizrt dongle.

21.Start Viz Curious Maps.

To install Viz World Server
1. Run the installation file: VizWorldServer_x.x.x.exe
2. Click Next
3. Click Next to start the file transfer
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4. Click Finish

To run the Server

1. Double-click the desktop shortcut, or
2. Select the program from the Start menu.

• All Programs > Curious Software> Viz World Server
3. A console window appears that loads the database. When done, the server is 

ready to receive requests from clients.

To remove Viz World Server
1. Open the Add or Remove Programs tool
2. Select Viz World Server, and click the Change/Remove button
3. Click Finish
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6 Viz World Server REST Support
This section contains a list of searches and functionalities of Viz World Server that 
can be accessed with a Representational State Transfer (REST) architecture using 
the atom protocol.

The Viz World Server has the following entry point:

http://<hostname>:10301/Directory

This section contains information on the following topics:

• Browsing Regions
• Browsing Projects and Favorite Folders
• OpenSearch Support
• PlaceFinder

6.1 Browsing Regions
Viz World Server allows browsing regions (e.g. administration levels country, 
admin1, admin2) by form of returning a feed that represent each region and 
contains entries for each sub-region (or if none, entries representing towns in 
that region).

Each entry contains an atom description of the region, link to its feed, links to 
towns contained in that region, link to a map of the region (using the PlaceFinder 
functionality shown later) and an XML representation that is used by the Viz World 
clients.

The below URL is the main URL that returns a feed of all countries.

http://<hostname>:10301/Browse

The below URL is an example region URL that returns a feed containing an entry 
for each sub-region of the queried region. If no sub-regions exist, a list of towns 
in that region wil be returned.

http://<hostname>:10301/Browse?id=91296a0a00000600

The following describes the main fields (XML tags) of each entry:

• Id: Viz World database unique id of the region/town.
• Title: Viz World database name of the region/town.
• Summary: http text containing feature details - thumbnail, feature type, name, 

link to map (using PlaceFinder URL), link to major/minor/both towns of the 
region (if exists).

• Content: Contains an xml representation of the feature, containing 
information like log/lat, full region description (i.e. “Paris France” for Paris), 
feature type and more information that the querying application might need.

• Link (down): Contains the same link as the link (alternate). Required by Viz 
FeedBrowser.
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The summary (depicted above) is displayed in browsers like this (circled in red). 
For more details, see the XML Example below.

Example
<entry>
<id>1000000000001200</id>
<title type="text">Belgium</title>

<summary type="html">&lt;table&gt;&lt;tr&gt;&lt;td&gt;
&lt;img src="http://<hostname>:10301/FeatureThumbnail/
?feature=Country"&gt;&lt;/td&gt;&lt;td&gt;Country&lt;br&gt;&lt;a 
href="http://<hostname>:10301/PlaceFinder/?Search=(null)"&gt;Get 
Image&lt;/a&gt;&lt;br&gt;See Towns:&lt;a href="http://
<hostname>:10301/Browse/?id=71f2d1c100001200&amp;filter=Capital,Town 
1m,Town 100k"&gt;13 Major Towns&lt;/a&gt;&lt;/td&gt;&lt;/tr&gt;&lt;/
table&gt;</summary>

<updated>2010-07-07T15:22:39Z</updated>

<author><name>VizWorldServer</name></author>

<thumbnail url="http://<hostname>:10301/FeatureThumbnail/
?feature=Country"/>

<link rel="up" type="application/atom+xml;type=feed" href="http://
<hostname>:10301/Browse/"/>
<link rel="self" type="application/atom+xml;type=entry" href="http://
<hostname>:10301/PlaceFinder/?Search=Belgium"/>
<link rel="alternate" type="application/atom+xml;type=feed" 
href="http://<hostname>:10301/Browse/?id=71f2d1b900001200"/>
<link rel="down" type="application/atom+xml;type=feed" href="http://
<hostname>:10301/Browse/?id=71f2d1b900001200"/>

<content type="application/atom+xml;type=feed">
<MapFeature>
<FeatureID>1000000000001200</FeatureID>
<Name>Belgium</Name>
<DBName>Belgium</DBName>
<AlterName>Belgium</AlterName>
<Type>Country</Type>
<GeoPoint>4.466875, 50.259453</GeoPoint>
<Diameter>280.409729</Diameter>
<FullDesc>Belgium</FullDesc>
</MapFeature>

</content>

</entry>

6.2 Browsing Projects and Favorite Folders
Viz World Server allows browsing folders of projects (tpl files) and favorites (cxp 
files) that are stored in the browser.
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A folder feed contains an entry for each sub-folder and project/favorite contained 
in the folder.

A project feed contains an entry for each stylesheet contained in the browser. A 
favorite link and project-style link returns an image of the favorite/style.

Main URLs:
http://vizworldserver:10301/ProjectsFolder/
http://vizworldserver:10301/FavoritesFolder/

Each favorite/project/style entry also contains a thumbnail tag that contains a 
URL of a thumbnail image of the project/favorite/style for use by Viz 
FeedBrowser. The thumbnail URL is also included in the summary of the entry, for 
use by browsers.

6.3 OpenSearch Support
Viz World Server supports using OpenSearch to search features in the server 
database, plugins and web.

OpenSearchDescription URL:
http://<hostname>:10301/OpenSearchDescription

OpenSearch template:
http://<hostname>:10301/
OpenSearch?q={searchTerms}&pw={startPage?}&visible={viz:visible?}&filt
er={viz:filter?}&source={Internal/All/MapDB/ExtraData/Web}

Examples URLs:
http://<hostname>:10301/q=Paris&filter=Capital&source=MapDB
http://<hostname>:10301/q=Salem&filter=Town 10k

6.4 PlaceFinder
Viz World Server allows receiving maps of locations/features, same as the Place 
Finder plugin. This can be used by Escenic or any other web applications, or for 
demos of VizWorld.

Example URLs:
http://vizworldserver:10301/PlaceFinder/
?Longitude=40.0&Latitude=40.0&FrameMapBy=Country&AddRegions=Full
http://vizworldserver:10301/PlaceFinder/
?Search=USA&MapWidth=1000&MapHeight=500&AddSearchLabel=1

Most parameters are taken from the configuration server (and stored in registry). 
Upon first use (or if missing in registry) the default values below are used. For 
parameters that are not stored in registry use the default values below.

• ProjectName: Desired project (default is VizDefProject.tpl)
• Style: desired stylesheet
• MapWidth: Sets the width of the map (default is 512)
• MapHeight: Sets the height of the map (default is 512)
• Longitude, Latitude: Defines the center of the map if Search is empty (default 

is 0.0, 0.0)
• Search: Desired feature name
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• AddSearchLabel: If search is used, adds the found label to the map.
• DefaultMapSizeDeg: Size of map to be retrieved in degrees (used when 

FramMapBy = DefaultMapSize)
• FrameMapBy: Can be DefaultMapSize, Country, Admin1, Admin2 or Search
• PlaceText: Add text label to map (if not empty)
• FullDescription: Displays full-description feature labels (i.e. “Paris France” for 

Paris)
• AddRegions: Can be Disabled, FrameOnly, FrameAndBelow or Full
• ReturnImage: 1 for image (default), 0 for representing xml
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7  Server Configuration
The server configuration tool is used to remotely configure the server settings . 
The configuration tool is installed with Viz World Server (WoS) and can be installed 
with Viz World Client.

From Windows start menu, select:
• Server: Programs > Curious Software > Server Config, or
• Client: Programs > Vizrt > Viz World Client > Server Configuration tool

CAUTION! The server is locked when using the configuration tool; hence, no client 
connection will be accepted.

Note: When using Server Allocator with multiple servers, each machine running the 
servers must be configured separately. Use the configuration tool to connect to all 
the servers and configure them.

This section contains information on the following topics:
• User Interface
• Template
• Locations
• Users
• License
• Maps
• Symbols
• Timeouts
• Proxy Server
• Server Logging

See Also
• Server Launcher
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7.1 User Interface
 Figure 6: Disconnected main configuration window

The server configuration window has two panes, the left pane displays the 
configuration sections and the right pane displays the parameters of the selected 
section.

Before using the configuration tool, a connection to the server must be 
established. When a connection is established, the Connect button will be 
disabled and the Disconnect button will be enabled. The right pane will be 
populated with the parameters of the selected section.
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 Figure 7: Connected main configuration window

• Send Logoff Message: Sends a logoff request will to the server. The server will 
end the session normally.

• Force Logoff: Sends a logoff message to the server, ending the session 
immediatlly.

• Restart: Restarts the server instantly. The configuration tool will be 
disconnected from the server. When a Map Server is defined (see Server 
Launcher Configuration tool), and more than one instance of Viz World Server 
is defined, all instances will be restarted.

Note: Most configuration changes requires a server restart before they take effect.

CAUTION! When Viz Maps Server Config tool is running the server is locked. No 
client connection will be accepted.

To connect to the server
• Enter the server name or IP address in the Map Server field, and click Connect.

See Also
• See Also
• Locations
• Users
• License
• Maps
• Standalone Clients
• Symbols
• Timeouts
• Proxy Server
• Server Logging
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7.2 Template

• Project Template: Defines the default project that will be used by the server 
when initially asking for a map or the client requestes a project that does not 
exist.

• Project Template Folder: Defines the folder in which the project templates are 
stored. When the user clicks the Open New Template button on WME’s Map 
Tool Options toolbar, the displayed templates list will be fetched from the 
template files in the Project Template Folder.

7.3 Locations
The Locations section defines the path to required Viz Curious Maps software 
components.

• Root: Defines the installation folder for Viz Curious Maps
• Licenses: Defines the license file(s) folder for Viz Curious Maps.
• Settings: Defines the path to the settings folder for Viz Curious Maps.

7.4 Users
The Users section displays the users configured on the server. Viz World Clients 
use the pre-defined Guest user to log on to the server. The Users > Guest screen 
is used to set some of the guest user permissions.
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Note: Users are added and removed from Viz Curious Maps only. 

• Allow <user name>: Allows the user to connect to the server when running 
WME or Viz.

• Allow <user name> Projects: Allows the user to access projects defined in the 
<user name> Project Folder.

• <user name> Project Folder: Defines the path to a folder containing the user’s 
projects.

7.5 License
 Figure 8: License parameters

The License section displays information about the current server license and 
enables the user to load other license files.

• Add License From File: Opens a file browser that enables the user to load 
additional license features from a different license file and to add it to the 
system. After a new license file is added, the Apply button is enabled.

• Dump License Info: Saves the license information, that is displayed in the text 
box, to a file.

• Apply: Applies the new license information to the system’s license file.
Chapter 7: Server Configuration 25



This section contains information on the following topics:
• To manually add a license file
• To add a license file using the Maps Server Configuration tool
• To add a license file using Viz Curious Maps

To manually add a license file
• Locate the License file (*.lic), copy and paste it into the Licenses folder (see 

example path below). 

Note: If the license is not valid, the server will not start, and the server console will 
exit.

Example: C:\Program Files\Curious Software\Curious World Maps\Licenses

To add a license file using the Maps Server Configuration tool
1. Start the server configuration tool.
2. Select the License section.
3. Click the Add License From File ... button.
4. Locate and select the file and click Open to add the new license file.

• The license becomes visible in the Edit License window.
5. Click Restart to start the server with the new license.

Note: If the license is not valid, the server will not start, and the server console will 
exit.

To add a license file using Viz Curious Maps
When starting the Viz Curious Maps design application without a license, a 
window appears telling that no license can be found.
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1. Start the Viz Curious Maps application
2. Click the License button to open the Software License window
3. Click the Edit License File ... button to open the Edit License window
4. Click the Add License from a File ... button to browse for the License file (*.lic)
5. Select the License file and click Open

• The license becomes visible in the Edit License window
6. Click OK to save the License. The license is saved to the License folder
7. Exit the application and run the Viz World Server.

Note: If the license is not valid, the server will not start, and the server console will 
exit.

7.6 Maps
The Maps section is used to define general map settings. 

This section contains information on the following topics:
• Database
• Database Features
• Disputed Regions
• Default Projection
• Map Legend
• Locations
• User DEMs
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• Attribution
• Microsoft Bing Maps Platform
• Digital Globe
• Display
• Street Admin

7.6.1 Database
 Figure 9: Maps Database parameters

• Database: Select the data base type. It only displays location entries that are 
visible in the map area.

• Shared User Map Data: Defines the source of data used by the database.

7.6.2 Database Features

• Accented characters: Handles accent characers in labels such as ~ in Frãczak.
• DataBase Features: Defines if the WME search tool will use additional 

databases in the system or only the main database of Viz Curious Maps.
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7.6.3 Disputed Regions

• Region: Displays a list of the disputed regions defined in the system. Select 
one of the dsputed regions to be configured.

• Configuration: Displays a list of region and border options related to the 
selected disputed region in the Region parameter. Select an option from the 
list and the graphic display will change according to the selected option.

7.6.4 Default Projection
 Figure 10: Default projection parameters

Sets the default projection for when a client opens a template that does not have a 
map layer. The following options can be set:
• Globe: Sets a globe projection.
• Cylindrical Equidistant: Sets an unprojected map. Longitude and latitude are 

are mapped directly into Xand Y coordinates.
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• Miller Equidistant (37 30): Relative distances are correct. Angles are correct 
around 37 degrees 30 minutes North.

• Miller Equidistant (43): Relative distances are correct. Angles are correct 
around 43 degrees North. Minimum scale distortion over continents.

• Miller Equidistant (50 28): Relative distances are correct. Angles are correct 
around 50 degrees 28 minutes North.

• Gall Isographic: Relative distances are correct. Angles are correct around 45 
North.

• Lambert Cylindrical Equel Area: A cylindrical equal area projection which uses 
the equator as the parallel of no distortion.

• Behrman Cylindrical Equel Area: A cylindrical equal area projection which uses 
30 degrees North as the parallel of no distortion.

• Tristan Edwards: A cylindrical equal area projection which uses 37 degrees 
38.3 minutes North as the parallel of no distortion.

• Peters: De-emphasizes area exaggeration in high latitudes.
• Gall Orthographic: A cylindrical equal area projection which uses 45 degrees 

North as the parallel of no distortion.
• Balthasart Cylindrical projection: An orthographic projection onto a cylinder 

secant at the 50 degrees parallels. It is cylindrical equal area, but distortion of 
shape increases with distance from the standard parallels. Scale is true along 
the standard parallels and constant between two parallels equidistant from the 
equator. This projection is not equidistant.

• Mercator: Mercator projection. Scale and angles correct only at the equator. 
Very distorted at the poles.

• Miller: Distances and angles are only correct on the equator. Shapes and areas 
are distorted, especially at the poles - but less than with Mercator.

• Albers Equal Area Conical: A conical projection which is useful for maps which 
are wider than they are high, such as the continental United States.

• Stereographic, Polar Stereographic (North and South): A projection which has 
minimal distortion at the center of the map. Most useful for maps that are 
zoomed to show whole countries.

• Tranverse Mercator: A projection which has minimal distortion at the center of 
the map. Most useful for maps that are zoomed to show whole countries.

7.6.5 Map Legend

Sets the default unit titles for map legends.
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7.6.6 Locations
 Figure 11: Maps Locations parameters

The Locations parameters define the path to folders containing relevant data for 
the specified parameters.

The Natural Earth option can be used to add, remove and color correct global 
and/or local CMR imagery. Global imagery is what is typically used as base maps, 
whereas local imagery are more detailed imagery of local places (e.g. coastal 
areas and cities).
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7.6.7 User DEMs
 Figure 12: Maps User DEMs parameters

The User DEMs (Digital Elevation Model) define the path to a folder containing Viz 
Curious Maps elevation data.

7.6.8 Attribution
 Figure 13: Attribution image placement

Defines where the attribution should be placed on the screen.

• Attribution image (gray rectangle): Sets the location of the attribution image 
on screen.

• Output Attribution Font: Sets the font used for the on screen credit.

To position the attribution image
• Drag the gray rectangle that represents the attribution image area to the 

desired position.
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7.6.9 Microsoft Bing Maps Platform
 Figure 14: Bing Maps Platform parameters

Bing Maps Platform (previously known as Virtual Earth) is a set of images (satellite 
and others) stored on Microsoft’s Bing Maps Platform servers. The images can be 
used in Viz Curious Maps, but requires a credit mark (Attribution image) to be 
displayed on screen.

• Bing Maps Platform: Defines a cache folder for the images retreived from the 
Bing Maps Platform server.

• Empty Cache: Deletes all files from the cache folder.
• Test Connection: Checks that the Bing Maps Platform server is online.

7.6.10 Digital Globe
 Figure 15: Digital globe

Sets the location of the digital globe cache.
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7.6.11 Display
 Figure 16: Maps Display parameters

• Alternate Label Display: Defines the labels source priority, effecting the list of 
label options displayed to the user.

• Street Data: Defines the visual properties of street edges when drawn on the 
maps.
34 Chapter 7: Server Configuration



7.6.12 Street Admin
 Figure 17: Maps Street Admin parameters

The Street Admin section is used to display information about the loaded roads 
data in the system and road data licensing information.

• Re-Scan: When pressed, the configuration tool will check the loaded street 
data and refresh the display.

7.6.13 Standalone Clients
 Figure 18: Standalone Client parameters

A standalone client is an application running WME on machines without a Viz 
installation.

• Export Folder: Defines the save path for standalone client applications.
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• Export Formats: Image formats are presented to users when saving images. 
Add a format for each combination of file format and compression options you 
wish to use. The Options button allows you to set color (black and white, 
grayscale, 256 colors etc.), and filter options.

7.7 Symbols
Symbols are created and exported from Viz Curious Maps, and can be imported 
using the server configuration tool such that client users can add them to their 
maps.

See Also
• Symbols Tab
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7.8 Timeouts
 Figure 19: Timeouts parameters

This section is used to set server timeout values.

• User Timeouts: Sets the timeout values for clients logged onto the server:
• Minutes Inactivety (Plugins): Sets the timeout for client connections when 

the WME is opened through the CMWClient plugin. If no map requests are 
sent to the server during the period of time (in minutes) specified in this 
parameter, the server will disconnect the client.

• Minutes Inactivety (Interactive Navigator): Sets the timeout for client 
connections when an interactive Navigator scene is used. If no map requests 
are sent to the server during the period of time (in minutes) specified in this 
parameter, the server will disconnect the client.

• Periodic Restart: Enables automatic restarts of the server. It is mainly targeted 
at 24/7 stations, where Viz Engines are up and constantly requesting maps. 
The Automatic restart enables the server to restart at the specified time or 
after a defined period of time, disconnecting all clients and clearing used 
memory. This is imprtant when the server is used heavily and a lot of maps are 
generated.
• Restart server periodically: Sets the server to restart periodically based on 

the After or At Time parameters.
• After: Sets the amount of time (hours) for how long the servers should be 

running before the server should be automatically restarted.
• At Time: Sets the time for when the server should be restarted.
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7.9 Proxy Server
 Figure 20: Proxy Server parameters

This section is used to define the proxy server conncetion settings. Viz World 
Server will connect to the internet to fetch data from Bing Maps Platform or 
Imagery on Demand servers. If the system uses a Proxy Server that requires 
authentication, this page is used to provide the login details for the Proxy Server.

• Name: Sets the user name.
• Password: Sets the user password.

See Also
• Microsoft Bing Maps Platform
• Digital Globe

7.10 Server Logging
 Figure 21: Server Logging parameters

This section defines if the server will log system messages to a log file or not.
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8 Server Launcher
 Figure 22: Viz World Server Launcher

Viz World’s Server Launcher is a tool used to start, stop and configure the Viz 
World Server and Server Allocator. The Server Launcher is by default run as a 
service.

The Server Launcher is an application installed as part of the Viz World Server, and 
can be found on the programs menu.

When the Server Launcher is configured, the Server Allocator distributes client 
requests between the registered servers and server machines, balancing server 
loads and the number of client requests. When configured in a complex 
environment, multiple map servers with multiple Server Allocators can be used to 
allow full redundancy and optimal resource distribution.

Starting a single instance of the maps server can be done from the program menu 
or by using the desktop icon.

Starting the Server Allocator, in order to setup a redundant system and/or 
configure more than one instance of the map server on one server, is done using 
the Server Launcher.

When the Server Launcher is running it will typically be floating on top of the 
desktop; however, it can be minimized to tray. The tray icon allows you to 
minimize the application to tray and restore it.

• Restore / Minimize To Tray: Restores or minimizes the Server Launcher from 
or to tray.

• Start / Stop Server: Starts and Stops the Server Allocators and the Viz World 
Server without exiting the Server Launcher application.

• Options: Opens the Options window for configuring the number of Viz World 
servers and Server Allocators. See Server Launcher Configuration for more 
information.
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• Exit Launcher: Closes the Server Launcher application. Server Allocator and Viz 
World server will still be running.

• Exit & Shutdown (Not Recommended): Closes the Server Launhcer application. 
Stops all Server Allocator services and the Viz World server.

This section contains information on the following topics:
• Server Launcher Configuration
• Configuration Options

8.1 Server Launcher Configuration 

Viz World Server is configured using the Server Launcher.

Click the Server Launcher’s Options button in order to configure the map server.
• Preferences: Allows the user to set the local server count and enable the Server 

Allocator.
• Local Server Count: Defines the number of server instances that will run on 

the machine simultaneously. Default value is 1.

CAUTION! When setting the number of instances for each machine, machine 
hardware should be considered. Every server instance requires physical memory 
(RAM) and makes intense use of the CPU. Do not abuse this parameter, since client 
and server performance will be affected.

• Run Server Allocator: When disabled (not selected), the Server Allocator will 
not run on the machine. When enabled (selected), the Server Allocator will 
run and use the parameters defined in the Server Launcher’s Options 
window. Default mode is disabled. Server Allocator does not require any 
license and can be run on any machine.
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IMPORTANT! If the Server Allocator is enabled, even for just 1 machine, a machine 
must be defined in the Controlled WoS list.

• Launch Options: Allows the user to run Viz World Server and the Server 
Launcher as a service, or in console mode. If run as a service, the system can 
automatically start all server instances when the machine starts without the 
need to login. If run in console mode, all instances must be manually started.

• Controlled WoS: When enabled (see Run Server Allocator), the Controlled WoS 
settings allows the user to configure the controlled WoS instances.
• Machine: Sets the name of a machine running Viz World Server.
• Count: Sets the number of instances running on the machine. Default is 1.
• Priority: Sets the machine’s priority. If more than one machine is defined, 

the priority must be set for each machine.
• Instances: Sets the number of instances that are controlled by the machine. 

If the machine has more than one instance running, it is possible to open 
the Instance Control (click Set) To set the controlled instances.

Note: When the Server Allocator allocates a server to a client, it will pass this name to 
the client, hence, its hostname/ip address must be accessible to all clients.

This section contains information on the following topics:
• Setting Priorities
• Configuring the Server

8.1.1 Setting Priorities
Normally all servers will use the same priority (1). In more complex scenarios a 
lower priority can be used, for example when two servers are running two 
instances each and an allocator.

One server is typically dedicated to an On Air engine and another to a Viz Artist 
(designer) client such that a designer client will not steal a token from an On Air 
engine.

Example setup:
• Map server  A is for the On Air engine and it controls two instances on map 

server A with priority 1, and two instances on map server B with priority 2.
• Map server B is for the Viz Artist designer and it controls two instances on 

map server B with priority 1, and two instances on map server A with priority 
2. 

The Server Allocator will not redirect any clients with map server A as default to 
map server B if it can give them an instance on map server A because map server 
B has a lower priority. So, only if the instances on A are out of license tokens, or 
not responding, the Server Allocator will direct clients to map server B. And the 
same for B.

Another example is in a scenario where there are two allocators (one in Location 1 
and another in Location 2), all clients from Location 1 should be connected to the 
server in Location 1, and all clients from Location 2 should be connected to the 
server in Location 2, and only if any thing goes wrong should clients be allowed to 
connect from Location 1 to Location 2.
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8.1.2 Configuring the Server

To add or remove instances
• Click the + or - buttons in the Options window to add or remove instances.

To set the controlled instances

1. Click the Set button in the Server Launcher’s Options window.
2. Double-click the instance to set the control mode to Controlled or Not 

Controlled.
3. Click OK.

Note: The number of controlled instances is displayed in the Instances field and 
column seen in the Options window.

See Also
• Server Launcher Configuration
• Configuration Options

8.2 Configuration Options
When using multiple map servers, running multiple map servers on each machine, 
with a Server Launcher launched on each of the machines, optimal usage of 
system resources can be obtained. The system can be configured with one 
allocator for multiple map servers, one allocator on one machine with multiple 
servers or multiple allocators with multiple server machines.

This section contains information on the following topics:
• Single Server Allocator Configuration
• Multiple Server Allocator Configuration: Classic Redundancy

See Also
• Hardware Requirements
42 Chapter 8: Server Launcher



8.2.1 Single Server Allocator Configuration
The simple environment setup is when running one map server with multiple map 
server instances and a Server Launcher. In this configuration, the Server Allocator 
will accept client requests and divert them to the server instances on the same 
machine. Client connections will be equally divided between the map server 
instances, allowing better response time and load balancing of server processes.

8.2.2 Multiple Server Allocator Configuration: Classic Redundancy
Having multiple servers, where in each there is a Server Allocator running
that controls all WoS instances of all machines.

This configuration guarantees most redundancy as each Server Allocator is 
updated with the current status of all WoS servers, and in case of a failure in one 
of the machines, other Server Allocators can provide redirection to any available 
WoS.

 Figure 23: Multiple Server Allocators with Multiple Map Servers.

The above diagram describes a system with two machines running a Server 
Allocator and two map server instances on each machine. If the client is 
configured with both machine names, full redundancy within the system will be 
accomplished.

Note: Any configuration combination between the Server Allocators and the map 
server instances is valid.
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9 Cache Configuration
When working with Viz World in a server/client environment, a cache is used to 
reduce load time of scenes in Viz. The cache is a shared network storage folder, 
common to all Viz Engines in the system. The cache is managed by the Viz Engine 
machines.

Note: In complex environments, Viz Engine machines can be grouped so a different 
cache is defined to each group.

Map data flow
The maps data stored in the cache is produced by the Viz Engine machines, 
running Viz World Client applications. When WoC is launched, it connects to the 
server and enables the user to select a map and add information to the map. 
When the user accepts the selected map (by pressing the OK button in the maps 
editor (WME)), the map information will be sent to the scene (and to the relevant 
WoC plugins used in the scene) from the server. WoC plugins will load the 
recieved data and then store it in the cache. Now, when a scene is initialized, the 
WoC plugins will look for the data in the cache and load it, without connecting to 
the server. 

Since the most time-consuming task in this process is generating the maps, using 
the cache reduces that time to a minimum and the maps are generated only once.

Note: Before setting a cache folder in a server/client environment, a shared network 
drive, mapped on all Viz Engine client machines should be created. The cache folder 
is defined on the shared drive, so all machines will have access to the cache.

This section contains information on the following topics:
• Cache Location
• Defining the Cache
• Cache Folder Structure
• To activate the cache

9.1 Cache Location
The following are some simple guidelines that will ensure caching is optimized 
when using one or several Viz Engines.
• One: Set the cache location local to that renderer.
• Two or more: Set the cache location to the map server (or other shared 

network drive) so that one renderer is not favored over others.
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9.2 Defining the Cache
The Viz client cache is defined using Viz Engine’s configuration tool (Viz Config). 
When configuring the cache environment make sure that the following parameters 
are identical on all Viz machines:
• Cache Directory
• On Disk (Days)

Tip: Control machines should have their cache location set to the same location as 
defined by the Viz Engine(s).

This section contains information on the following topics:
• To activate the cache
• To configure Viz Engine

To activate the cache

 Figure 24: Maps cache configuration, Viz Config 3.2

Note: The below procedure is also valid for Viz 2.x users.

1. Run Viz Config or open the configuration interface by clicking the Config 
button on the main menu in Viz Artist.

2. Select the Maps section.
3. Activate Cache usage.
4. Set the Cache Directory to the defined shared network drive and the folder 

used as the cache’s main folder.

Note: The Cache Directory has to be identical on all Viz Engine machines that share 
the cache. UNC paths are also supported.
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5. Set the Memory (Images) to the required value (default is 32). This parameter 
defines the maximum number of map images stored in Viz memory when 
initializing a playlist.

IMPORTANT! Set the number of images to zero (or a low value) on control machines 
used in the system. The control machines are inferior to Viz Engine machines and it 
makes no sense to load a large number of images when it is only used for preview.

6. Set the On Disk (days) parameter to the maximum number of days that the 
images will be stored in the cache. When Viz is launched, it will clean the 
cached map images that are older than the value defined in the On Disk (days) 
parameter.

9.3 Cache Folder Structure
When using cache in a client/server configuration, WoC plugins will manage the 
cache and sort generated data in several folders under the cache folder. The 
cache folder hierarchy is created automatically. Only the cache root directory is 
configured in Viz. The defined cache folder for all clients is the root cache folder. 
Under the root cache folder, a version sub folder is created using the WoC plugins 
version. Under each version folder, several sub folders are created, according to 
the requested data:

• 3DLine-Cache: Stores lines from the WME as OpenGL vertices.
• 3DBorder-Plugin-Cache: Stores selected borders based on the Region-Cache 

data.
• 3DRegion-Plugin-Cache: Stores selected regions based on the Region-Cache 

data.
• AtlasCacheFolder: Stores Downloaded images from Microsoft to enable a 

smooth animation and faster response time during navigation. Images are 
stored under sub-folders according to the texture compression used.

• BorderManagerFullWorld-Cache: Stores unselected borders based on the 
Region-Cache data. 

• CWMClient-Cache: Stores map images and label information that is reused by 
Viz when loading the scene.

• Region-Cache: Stores region vector data.
• Street-Cache: Stores street vector data.
• StreetManager-Cache: Stores unselected streets based on the Street-Cache 

data.

Note: The 3DBorder, 3Dregion and BorderManagerFullWorld cache is based on 
Region-Cache data after a projection is set, and converted to an OpenGL format.

Example: The country Norway will only have one cache file under Region-Cache 
(since there is only one Norway), but could have many under other folders with 
different projections.

General Caching Rules
The CWMClient-Cache folder is cleaned when Viz is launched (any of the Viz 
Engines using the cache), according to the On Disk parameter value.
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The data in the cache folders (except for the CWMClient cache) are not deleted 
when cleaning the cache since it does not change and it can be reused all the 
time.

See Also

• To activate the cache

9.4 Control Applications and Caching
This section describes commands/actions and setups that will result in maps data 
being cached when using the Viz Trio and Viz Content Pilot control applications.

This section contains information on the following topics:
• Viz Trio
• Viz Content Pilot

9.4.1 Viz Trio
This section describes Viz Trio specific commands/actions that influence how 
map data is cached when Loading pages, Initializing all pages and performing a 
Direct Take.

IMPORTANT! Set the same cache directory for the local Viz, and program and 
preview channels.

This section contains information on the following topics:
• Loading pages
• Initializing all pages
• Direct Take

Loading pages
Opening a scene for preview generates all cache files needed for the scene in the 
file cache. Any change to the page through Viz Trio (CWM location, hop locations, 
labels, selected regions and so on), immediately generates all required cache files. 
When pressing Take, Viz Engine will load to memory all needed map cacheable 
elements through the file cache that the preview machine just generated without 
the need to connect to the map server.

Note: Applies only if both of them have same cache folder.

Initializing all pages
The Initialize All button/command will load all scenes to memory (program & 
preview renderers). All necessary map data will be loaded from the cache files.

Note: It is assumed that each page has been loaded in preview once before, and that 
cache files have been created.
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Direct Take
The Direct Take button/command will immediately load the scene into Viz Engine. 
All necessary map data will be loaded from the cache files that the preview has 
generated once.

Note: It is assumed that each page has been loaded in preview once before, and that 
cache files have been created.

See Also
• To activate the cache
• Viz Content Pilot

9.4.2 Viz Content Pilot
When running Viz Content Pilot in a non-preview configuration, any change to any 
map element that requires caching will not create cache files. This will result in 
longer loading time of the Viz Engine because data maps, labels and polygon data 
has to be requested from the map server. It is important to request at least a 
single image preview, such that cache files will be created.

IMPORTANT! If you are running a local Viz, set the same cache directory for the local 
Viz as for the program and preview channels.

See Also
• To activate the cache
• Viz Trio
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10 Viz World Client
This section describes the procedures on Installing the Client and Configuring Viz 
Engine.

Viz World Client (WoC) is used to integrate maps and geographical data into 
scenes. Its components are the Viz World Maps Editor and the Maps Plugins.

This section contains information on the following topics:
• Installing the Client
• Configuring Viz Engine
• Software Requirements

10.1 Installing the Client
Viz World Client (WoC) installs new components in three places:
• Viz 2.X (c:\Program Files\vizrt\viz\)
• Viz 3.X (c:\Program Files\vizrt\viz3\)
• Common files (c:\Program Files\vizrt\common\)

There are two ways of installing the client; a standard installation which requires 
the user to perform and confirm all actions during the intallation, or a silent 
installation that enables the user to install Viz World Client without using the 
installer user interface.

A silent installation can be performed in two ways; a standard silent mode 
installation is performed by setting the /s flag before running the installer. This 
option is used when a large number of client installations is performed, and will 
install the Typical configuration option. The advanced silent installation enables 
the user to perform a custom installation, by creating an InstallShield Silent 
Response (ISS) file, should a Typical installation not fit the user requirements. 

This section contains information on the following topics:
• To install the client
• To install the server configuration tool
• To install the client in silent mode
• To record a silent mode installation
• To install the client in silent mode using an ISS file
• To remove the client

To install the client
1. Double-click the VizCuriousMapsClient_10.x.x.exe installer to start the 

installation.
2. In the Setup Type window, select Typical, and click Next

• Select Custom To install the server configuration tool.
3. Select the Yes, I want to restart my computer now option and click Finish.
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To install the server configuration tool
1. Double-click the VizCuriousMapsClient_10.x.x.exe installer to start the 

installation.
2. In the Setup Type window, select Custom, and click Next.
3. In the Select Features window, select the Viz World Server Config option, and 

click Next.
4. Select the Yes, I want to restart my computer now option and click Finish.

To install the client in silent mode
1. Create a shortcut of the client installer’s executable file.
2. Right-click the new shortcut and select Properties from the appearing context 

menu.
3. Select the Shortcut tab, and in the Target path add the following flag:

/s

1. Click the OK button to confirm the change.
2. Run the shortcut to install the client in silent mode.

Note: The default installation for new installers (first time) includes the client and the 
Standalone Clients. An upgrade will update the existing installation.

IMPORTANT! Any unexpected events during silent installation will result in a failure. 
Unexpected  events can be:  Need to restart the computer and Viz not installed in 
default path.
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To record a silent mode installation

 Figure 25: Setting the Target path, Silent installation

Note: One manual run of the installer is required to record user actions. After the 
sequence of user actions is recorded, the installer can run in silent mode, repeating 
the recorded user actions.

1. Create a shortcut of the client installer’s executable file.
2. Right-click the new shortcut and select Properties from the appearing context 

menu.
3. Select the Shortcut tab, and in the Target path add the following flags and file 

name with the suffix .iss.:  

/r /f1”My_File_Name.iss”

Note: The path to the file should be a full path or a relative path and it should be 
double quoted

Note: There should be a space between the /r flag and the /f1 flag, but there is no 
space between the/f1 flag and the specified file name.
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4. Click the OK button to confirm the change.
5. Run the shortcut manually To install the client. Make the selections to create 

the desired silent installtion.
6. After completing the installation, check that the specified .iss file was created.

Note: The procedure described above, using an application shortcut, can be 
executed from a command shell running the installtion file with the described flags.

To install the client in silent mode using an ISS file
1. Create a new shortcut of the client installer’s executable file.
2. Right-click the new shortcut and select Properties from the appearing context 

menu.
3. Select the Shortcut tab, and in the Target path add the following flags and the 

pre-recorded file name with the suffix .iss.:  

/s /f1”My_File_Name.iss”

Note: The path to the file can be a full path or a relative path; however, it must be 
double quoted.

Note: There should be a space between the /s flag and the /f1 flag, but there is no 
space between the /f1 flag and the specified file name.

4. Click the OK button to confirm the change.
5. Run the shortcut to install the client in silent mode.

Note: The procedure described above, using an application shortcut, can be 
executed from a command shell running the installtion file with the described flags.

Tip: Check that the required files were installed.

To remove the client
1. Start Add or Remove Programs and click the Change/Remove button next to 

the Vizrt Viz World Client item to start the client installer, or
2. Run the installer
3. Select the Remove Installed Files option and click Next
4. Click Finish

See Also
• Configuring Viz Engine
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10.2 Configuring Viz Engine
For the Viz World Client tto be able to connect to Viz World Server, a Viz Engine 
must be present. Viz Engine has its own configuration tool (Viz Config) that is 
used to configure the connection to the Viz World Server.

Before proceeding with the procedures, make sure that the following is installed:
• A license file (*.lic)
• A USB hardware dongle
Provided that project templates are available, the Viz Config window, after a 
successful configuration, will look something like the picture above. It is 
recommended to set a default project; however, this is not required. Project 
templates are made in Viz Curious Maps by designers, offering different sets of 
maps, label styles and so on.

To configure Viz Engine

 Figure 26: Maps configuration, Viz Config 3.2

Note: For details on how to install Viz Engine, see the Viz Artist User Manual.

1. Start Viz Config
2. Select the Maps section, and click the Active button to activate the 

configuration window and connection.
3. Enter the Server name of the map server (hostname or IP address).

• In a Server Allocator setup, with multiple servers and/or full redundancy, 
add the map server names only separated by comma(s).

4. Click Save and restart Viz Config.
5. Select the Maps section again, and select a Project template from the Available 

project template list.
• This becomes the default map setting when using Viz World Client. It is 

possible, in Viz World Client, to select alternative project templates.
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6. Set the Default Width & Height which will set the default image size for the 
maps.
• The image size can be changed by the CWMClient plugin in Viz Artist.

7. Save and close Viz Config.

See Also
• Installing the Client
• Cache Configuration
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11 Viz World Maps Editor
Viz World Maps Editor (WME) is a core component of the Viz World Client (WoC) 
installation. WME can be integrated with numerous Vizrt products that enables 
users to select, frame and populate maps and use them in Viz. The WME connects 
to the Viz World Server (WoS) and retrieves the map to be used.

This section contains information on the following topics:
• User Interface
• Using the Editor

11.1 User Interface
 Figure 27: Main window

The WME window includes the map area, navigation and map editing area, map 
details area and the map tool bar. The user can select (zoom and pan) a region on 
the map, or use the search tool to find the requested location. The user can add 
information to be displayed over the map by selecting objects from the database 
or by manually marking a place on the map. The added objects are displayed in 
the Map Details area.

This section contains information on the following topics:
• Map Area
• Navigation and Map Editing Area
• Search Tab
• Explorer Tab
• Extra Data Tab
• Images Tab
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• Symbols Tab
• Map Tool Bar
• Map Details Area

11.1.1 Map Area
The map area displays the current map and enables the user to modify the map 
interactively, according to the selected tool in the buttons toolbar and by using 
the integrated Zoom Options.

Zoom Options
In the upper left corner of the Map Area there are two rectangular blue shaped 
buttons that can be used to zoom in and out of the map. In addition it is also 
possible to use the mouse (left button) and/or in combination with the keyboard.

The zoom options, besides menus and buttons, are:
• Drag and draw a rectangle to zoom in to fit.
• Click the left mouse button to zoom in.
• Hold down SHIFT to zoom out.
• Hold down CTRL to zoom in in smaller steps.
• Hold down CTRL and ALT to zoom out in smaller steps.

11.1.2 Navigation and Map Editing Area
The navigation area enables the user to locate places by searching the database or 
selecting a place from the explorer list. When a place is found (or selected) the 
user can fit the map to the requested area, add information to the map, highlight 
the region and modify the map using the Viz Curious Maps database.

Using the Results
After conducting a search or using the explorer, the results will be displayed as a 
list. When an entry is selected, the buttons on the right side of the list will become 
enabled:

• Add to map: Adds the selected entry to the map. The selected entry will be 
added to the map graphically as defined in the selected map style. A map style 
defines map symbols, fonts, icons, colors, and so on. For map styles see also 
Map Tool Bar and the Map Style drop-down menu.

• Center map: Pans the map to center the selected entry (keeping the current 
map scale size).

• Fit to fill: Centers the map and scales the map to fill the map area.
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• Show details: Opens the browsing tool, which displays the context information 
for the selected detail. The context information includes the regions 
containing the detail (that is country, state and county) and the capital of that 
country.

11.1.3 Search Tab
 Figure 28: Search result, Turkey

The search tab is used for searching the database for a place, using a string or 
sub string typed in the name text box. The search results can be filtered by using 
the radio buttons and the drop down list.

Searching is instant (after the first three characters) and optimized according to 
relevance; hence, if you search for Paris your result will show all places named 
Paris, but if you search Paris TX you will get Paris in Texas, USA.

If you have street data (see Extra Data Tab) you can also search for crossroads 
using AND or & (e.g. Broadway AND 44th).
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Search Parameters
• Find All: When selected it displays all matching entries in the database.
• Find Visible: When selected it only displays matching entries visible in the 

current map. 
• Addr and Cross st.: Enables the user to search for specific addresses.
• Type: Limits the result list according to the selected Type. For example region, 

capitals, tourist attraction, and so on.
• Source: Searches a range of sources.

• All: Searches all sources.
• Internal: Searces the map database and extra data.
• Map DB: Searches the built-in database that comes with the Viz Curious 

Maps installation.
• Extra Data: Searches all extra data packages bought in addition to the 

standard Viz Curious Maps installation (see Map DB).
• Web: Searches Yahoo for online point data.

Note: Searching for addresses requires licensed street data installed on the server.
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11.1.4 Explorer Tab
 Figure 29: Explorer result of British Columbia

The explorer tab is used for selecting a location from a list of places derived from 
the server’s database. The list is displayed in a tree format showing countries, 
regions, cities, and so on.

Explorer Parameters (list filter)
• Visible: Only displays location entries visible in the current map.
• Type: Limits the search result list to the selected type like region, capitals, 

tourist attraction, and so on, when one of the entries in the list of available 
types are selected.

• Filter: Filters the search result further.

Note: To find New York, type N, then type E, etc. with every character typed in the 
string filter the list will be smaller.
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11.1.5 Extra Data Tab
 Figure 30: Extra Data tab, Points of Interest

The Extra Data tab is used for selecting a street from the streets database on the 
server, and Keyhole Markup Language (KML) files.

Note: Streets data requires additional license features and the installation of street 
data on the server.

This section contains information on the following topics:
60 Chapter 11: Viz World Maps Editor



• Streets
• Import KML

Streets

Streets data is available from the Streets node, and are sorted by Motorways, 
Primary Roads, Main Roads and Other Roads. Use the Filter search to search for 
streets.

Import KML

Keyhole Markup Language (KML) files can be imported and added to the map. The 
KML data will be accessible from the Extra Data tab as with street data. By clicking 
the KML Files node, all the imported KML files will appear as sub nodes. Click one 
of the imported KML files to open the KML file windowthe respective file will be 
file.
Chapter 11: Viz World Maps Editor 61



KML files currently must be manually imported into the server. Files are placed in 
the KML folder under the Curious Software folder.

Example: C:\Program Files\Curious Software\Curious World Maps\KML

11.1.6 Images Tab

The Images tab displays geo referenced satellite images that are added through 
the Viz Curious Maps standalone client.

• View as icons: Displays the available images as icons or display the available 
images as a list.

To add geo referenced images
1. Start Viz Curious Maps, preferably on the maps server.
2. Create or open a map project.
3. From the Contents panel, select Overlays.
4. Click the Add Satellite Image button to open the Image Manager.
5. Click the + symbol to search and select a geo referenced image.
6. Close Viz Curious Maps.
7. Restart the Viz World Server to load the new images.

Note: Images should ideally reside on the map server or on a shared drive.

11.1.7 Symbols Tab

Symbols are added using Viz Curious Maps, and can be imported using the Server 
Configuration tool or Viz Curious Maps.

To add symbols
1. Start Viz Curious Maps, preferably on the maps server.
2. Create or open a map project.
3. From the Tools menu, select Symbols.
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4. In the Symbols dialog box, click the + symbol (bottom) to search and select 
for a symbol.

5. Close Viz Curious Maps.
6. Restart the Viz World Server to load the new images.

Note: Images should ideally reside on the map server or on a shared drive.

11.1.8 Map Tool Bar
 Figure 31: Map tool bar

The map tool bar includes a row of buttons controlling the map interactive mode. 
The map area enables an interactive map selection and manipulation and the map 
tool bar is used for selecting the map interactive behavior.

This section contains information on the following topics:
• Map Tool Options
• To create a map using the Quick Map location browser
• To set the map location
• To pick a label and add it to the map
• To move a label

Map Tool Options

• Available Map Stylesheet: Displays a list of available map styles of the selected 
template. Select a map style to apply the style’s design to the displayed map.

• View Presets: Displays a set of view presets. Available options are: The World, 
United States, N America, S America, Americas, Africa, Asia, Middle East, S 
Asia, Europe and United Kingdom.

• Open New Template: Loads one of the defined templates installed on the 
server creating a blank map with the template’s styles and settings. When 
pressing this button a confirmation window will open. When confirmed, the 
template window will open. Select one of the projects in the list and click OK. 
A new map will appear in the map area using the new template’s default styles 
and settings.

• Undo button: Cancels the last change on the map.
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• Redo button: Cancels the last canceled change on the map.

• Bird’s Eye: Displays the available imagery Bird’s Eye imagery from the Bing 
Maps Platform. When clicking the button, the imagery for the area of the 
current map will be displayed enabling the user to select an image for the 
map.

• Quick Map: Opens the Quick Map location browser that enables the user To 
create a map using the Quick Map location browser.

• Set Location: Opens the Set Location dialog which enables the user To set the 
map location using longitude, latitude and map size values (radius around the 
defined point).

• Region Zoom: Enables the user to click and drag the mouse on the map to 
create a rectangle surrounding an area on the map (rubber band).
• The rectangle displays two icons; a cancel icon in the upper right corner and 

accept icon in the lower left.
• The rectangle keeps the aspect ratio set for the map unlike regular zoom 

(see below).
• Region zoom can be adjusted before accepting the area selection.

• Zoom: Zooms into the map on every click on a point in the map centering the 
clicked point in the Map Area. Another option is to drag and create a selection 
area. When the mouse button is released, the selected area will become the 
selected map. Selecting an area using the zoom option does not maintain the 
aspect ratio.

Note: Both Region Zoom and Zoom allows for area selection in the Map Area; 
however, Region Zoom will maintain aspect ratio and allow the user to cancel the 
operation after the selection was made.

• Pan: Enables the user to click and drag on the map to move the map in the 
direction of the drag.

• Pick Feature: Shows a group of available places from the database as 
“phantom labels”. This feature enables the user To pick a label and add it to 
the map. The labels will appear over the map only when an entry is selected in 
the explorer tab or in the search area.
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• Browse Map: When clicked any click on the Map Area will update the browse 
window with context information for the clicked position. The context 
information includes regions containing the position (for example country, 
state and county) and the capital of the country.

• Move Label: Enables the user To move a label in the Map Area. Map Label 
enables the user to move the tip and the caption of user-created labels or to 
rotate them. In other labels only the caption can be moved and rotated.

Note: Rotation of labels in WME will not effect label objects generated by Viz (3D 
labels). The rotation is noticed only when using labels as part of the map texture.

• Add Label: Adds a label at the click point, enabling the user to enter and select 
a label text and label icon type.
• Remember label and publish to all users: When this option is checked, the 

new label will be added to the database. Whenever the place is selected all 
the customized labels will be available for selection by the user. When the 
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option is unchecked, the modified label will be used only by the current 
map.

• Streets: Enables the user to selectand label streets on the map. Street data 
must be loaded for this feature to work (see Extra Data Tab).

• Add Shape: Adds shapes to the map. Select between points (straight) and 
bezier (curved). Selecting the Add Shape button also opens a small toolbox for 
selecting shape designs. Available options are:
• Area: Fills the drawn shape, and will also close the line (see Closed Line).
• Closed Line: Allows the user to close the shape without setting the final 

point (e.g. 2 points will draw a third closing the line with the first point).
• Open Line: Allows the user to draw a line that is not closed.
• Delete Last: Deletes the last drawn line.
• Cancel: Cancels the draw opertion.

• Edit Shape: Allows the user to edit the shapes and streets added to the map. 
Streets (roads) can be offset, while shapes can be adjusted using the Point 
toolbox that appears when the Edit Shape button is selected.

Note: Shapes and streets can be edited further using the maps plugins (e.g. 3D Line 
and 3D Line Manager.
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To create a map using the Quick Map location browser

1. Click the More button’s Quick Map option in the WME.
2. Select or search for a country in the Country list.

• The map area will fit to the selected country and the State/Region list will 
show a list of available regions of the selected country.

• When a country is selected in the list, the Add to map and Mark Area 
buttons will be enabled.

3. Select an entry from the list, the County/sub region list will be filled.
4. Click Finish to close the location browser and create the map.

Tip: Clicking the Search button switches the Quick Map tool to the search tool mode.

To set the map location

1. Click the Set Location button in the WME to open the Set Location dialog box.
2. Enter the longitude, latitude, and map size radius in miles, kilometers, meters 

or yards.
3. Click OK to calculate and display the map in the Map Area.
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To pick a label and add it to the map

1. Perform a search and select a location.
2. Click the Pick Feature button to display all the phantom labels for the selected 

area.
3. Click a label to add it to the map.

To move a label

1. Click the drop-down button to open a list of options.
2. Select one of the options and then select a label on the map and move the 

label around in the graphic display.
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11.1.9 Map Details Area
 Figure 32: Map details area

The Map Details area displays a list of all the added locations over the map. The 
user can modify the map, by selecting one of the added places and the control 
buttons on the right side of the map details area.

Map Details parameters
• Style: Sets or modifies the graphic display representing the selected place on 

the map. The style selection will affect the highlighting color used to mark the 
selected place, the label, and so on.

• Font Size: Sets the font size used for the label in the graphic display. Font size 
is only relevant for the display in the editor and for text labels that are 
exported as part of the map texture; hence, it will not affect the size of labels 
rendered by Viz.

• All Caps: Uses only capital letters in the graphic display when showing the 
selected place’s label.

• Rename label button: Opens the Rename Label dialog box that will allow the 
user to customize and add other labels to the database by entering a new label 
for the selected place or by selecting an existing label from the list of labels or 
modifying an existing label.
• Remember change and publish to all users: When this option is checked, the 

renamed label will be added to the database. Whenever the place is selected 
all the customized labels will be available for selection by the user. When 
the option is unchecked, the modified label will be used only by the current 
map.
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Note: The label will be used in the graphic display and in the map details area.

• Delete place from map: Removes the selected entry from the map (and from 
the map details list).

• Delete all places from map: Removes all added places from the map (and from 
the map details list).

11.2 Using the Editor
This section describes how to use the Viz World Maps Editor (WME) with Viz Artist, 
Viz Content Pilot, Viz Trio and Viz Weather.

This section contains information on the following topics:
• To test with Viz Artist
• To test with Viz Content Pilot
• To test with Viz Trio
• To test with Viz Weather
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To test with Viz Artist

Viz Artist requires no additional setup as long as the Viz World Client is installed, 
and the map server settings in Viz Config’s Maps section have been activated.

1. Open a map scene
2. Locate and click the CWMClient icon in the tree structure to open the 

CWMClient Editor.
3. In the editor, click the Viz World Maps Editor (WME) button to open the editor.
4. Search and select a map, and click OK to add a map to the scene

Note: Make sure that ControlMap plugins are placed on the same containers as the 
CWMClients in order for Viz Content Pilot to be able to change their maps.
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To test with Viz Content Pilot

Viz Content Pilot’s (VCP’s) map server parameters are stored on the VCP database. 
The parameters can be set or changed using the VCP client (Options > 
Preferences > Viz World).

For an operator or journalist to be able to change maps, the map scenes must use 
the ControlMap plugin. Also, before the scene can be used in the VCP client or 
Newsroom Component a map template must be created using Viz Template 
Wizard.

1. Start Viz Template Wizard
2. Import a Viz Artist map scene to the Viz Template Wizard

• If a ControlMap plugin is used by the designer an image component will be 
automatically added to the template

• A template user clicking the image component will then be able to open the 
Viz World Maps Editor to select a map

3. The ImageSources property should be set to IsAdvancedCuriousMap
4. Save the template to a concept

Once the template is stored it can be opened by the VCP client or Newsroom 
Component.
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1. Start the VCP client or Newsroom Component, and open the newly created 
template.

2. Click the image in the template to open the WME.
3. Enter a search criteria (for example London)
4. Select London City, England from the list
5. Tick London City, England, and click the zoom button (map icon) for England
6. Click OK to close the WME.
7. Save a data element of the template and add it to the playlist.
8. Play or preview the scene on a local Viz Engine renderer to see the map 

animations.
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To test with Viz Trio

Viz Trio’s map server parameters are set by the local Viz Engine that Viz Trio uses 
to render the scenes locally; hence, there is no need to configure Viz Trio.

1. Start Viz Trio
2. Select Import Scenes from the drop-list in the Editing window.
3. Locate and import a tutorial scene to create it as a Viz Trio template.
4. Select and double-click to open the newly added template.
5. Click the Browse Viz World button to open the editor.
6. Enter a search criteria (for example London)
7. Select London City, England from the list
8. Tick London City, England, and click the zoom button (map icon) for England
9. Play the scene in Viz Trio so see the map animations
74 Chapter 11: Viz World Maps Editor



To test with Viz Weather

To enable the Viz Curious Maps capabilities, add the following entry to the Viz 
Weather INI file:

[CURIOUS]
cwm_enabled=y
simplified=n

1. Open a map enabled scene in the editor
2. Click the Map button on the editor toolbar
3. Click the Map icon to select a map
4. Select From Server

• When selected, a full version of the map editor opens
5. Select a map project
6. Enter a search criteria (for example London)
7. Select London City, England from the result list
8. Enter a new search criteria (for example England)
9. Select England from the result list

10.Adjust the view and style of the map
• Use the map buttons (lower right) in Viz World Client

11.Click OK to close the map editor.
12.Play the scene in Viz Weather to see the map animations.
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12 Maps Plugins
The Viz World Client (WoC) installation includes a package of plugins used for 
enhancing the geographic referencing ability in Viz Artist. The WoC plugins 
includes geometry plugins, container function plugins, shader plugins and scene 
plugins.

The Container Function plugins are divided into four plugin folders: 
• Maps: Contains commonly used plugins.
• Maps-Adv: Contains advanced plugins.
• Maps-Man: Contains a set of manager plugins used for batch creation of 3D 

Objects such as regions, borders, and so on.
• Maps-Obs: Contains obsolete plugins, installed only for backward 

compatibility. These plugins should not be used when designing new scenes. 

Tip: Refer to the scene design tutorial for additional information. The tutorial is 
available for download on Vizrt’s FTP.

Note: When pressing the button labeled with “?” in the plugins UI, the relative help 
topic in the user guide will open.
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This section will describe the parameters and usage of the plugins (in alphabetical 
order).

Table 1: Map plugins

Geometry Container Shader Scene

2D Label
3D Border
3D Border 
Control
3D Line
3D Line Control
3D Region
3D Region 
Control
3D Roads
Atlas
Flat MR
GeoImage
Globe
Pyramid Control
Shadow Agent

3D Border Manager
3D Line Manager
3D Map Telestrator
3D Region Manager
3D Road Manager
Center Map
CWM Client
Focus On Map
Geo Text
Globe Zoom
Hop Sync
Hops Manager
KML Reader
Label AddOn
Label It
Locator Control
Map Layers
Map Layers Control
Map Pyramid
Map Tiler
Mute
NavCom
NavFade
NavFinder
Navigator
NavScale
NavSlave
Place Finder
Publish To Design
Region Halo
Trace It
World Image 
Refresh
World Position

3D Line Shader
Color Matrix
Region Halo 
Shader
Curious 3D 
Terrain Shader
Fade Texture

3D Map Setting
Light On Globe
Label Manager
Map Builder
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12.1 2D Label

The plugin can be found in the following folders:
• Viz Artist 2: Object -> Built in.
• Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

 Figure 33: 2D Label example

The 2DLabel plugin is used for creating two dimentional labels on the map, based 
on labels received from the selected map or automatically generated labels 
generated by the LabelManager plugin according to the map information received 
from the Navigator plugin.

Note: When adding a 2DLabel plugin to a container, a World Position plugin and an 
Alpha plugin will be added automatically to the same container. The Label Manager 
scene plugin has to be added manually to the scene when using the 2DLabel plugin 
without a Navigator plugin.

This section contains information on the following topics:
• Plugin Description

See Also
• Navigator plugin
• Label Manager plugin
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12.1.1 Plugin Description
The 2D Label plugin has five sections of parameters (GUI Options).

This section contains information on the following topics:
• Label
• Bevel
• Caption
• Special
• Fade

Label

 Figure 34: Label, 2D Label editor

• Margin Options:
• Equal Spaced: Uses equal spacing for the side margins and top/buttom 

margins.
• Separate: Uses different margins for each side of the labels.

• Width Margins: Sets the margin between the sides of the text and the label 
background edges.

• Height Margins: Sets the margin between the top and bottom of the text and 
the label background edges.

• Outline Width: Sets the width of the label’s background outline.
• Label Color: Sets the color of the label’s background fill.
• Outline Color: Sets the color of the label’s background outline.

Note: The numeric values next to the color parameters are the alpha values of the 
label and the label outline.

Note: The color palette effects only the selected color parameter (label or outline), 
and it will appear when one of the color parameter is selected. (Viz 3). When using 
Viz 2 the color palette is displayed in all tabs.
Chapter 12: Maps Plugins 79



Bevel

 Figure 35: Bevel, 2D Label editor

• Bevel: This parameter defines the bevel value of the label’s background 
corners. 

• Roundness: This parameter defines if the background corners will be rounded 
or not.

• Detail: Defines the quality of the label object (when a higher value is selected, 
more polygons will be used to build the label object).

• Lock Aspect: When enabled (On), the bevel and roundness parameters will be 
applied to the corners of the label object equally. When disabled (Off), the 
bevel and roundness parameters will be applied to the corners using the 
object’s height and width ratio.
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Caption

 Figure 36: Caption, 2D Label editor

• Pivot: Defines the label’s object shape and location in relation to the label’s 
geographic location:
• Pointer: The label object includes a pointer going out of the label 

background and pointing at the label’s geographical position. When 
selected, additional parameters will be enabled: Width and Connection 
Bevel.

• Outline: The label object has a rectangular shape and the outline of the 
shape is on the label’s geographical position.

• Center: The center of the label is placed over the label’s geographical 
position.

• Offset: The label is placed at the defined offset from the label’s 
geographical position.

• Width Type: Defines if the (strap) width should change as the caption is 
moving away from the tip or stay fixed.

• Width: Defines the width of the pointer’s base overlapping the label 
background. This parameter is only enabled when Pointer is selected.

• Connection Bevel: Defines if the area connecting between the pointer and the 
label background is to be rounded or sharp. This parameter is only enabled 
when Pointer is selected.

• Rotate Labels: Defines if labels, created in Viz (3D labels), will be rotated like 
the labels in Viz World Maps Editor (WME). If set to Disabled, all labels will be 
displayed horizontally. If set to Enabled, labels that were rotated in Viz World 
Maps Editor will be rotated in Viz. 

• Caption Source: Defines how the labels will be placed on the map.
• When WME is selected, the labels will be placed as they were placed on the 

map in the Viz World Maps Editor.
• When Presets is selected, the LabelManager plugin will use the defined 

presets to place the labels over the map. The LabelManager plugin will 
optimize the label position such that the labels will not overlap.
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• When WME is enabled the Number of Presets and Current Preset options are 
hidden and the option WME Offsets Distance paramater is enabled.

• Number of Presets: Defines the number of label position presets available to 
the user (one to four presets). This parameter is only enabled when Caption 
Source is set to Presets.

• Current Preset: Selects the preset number to be configured, using the 
Direction and Distance parameters. Each preset should be selected and the 
label position should be adjusted. This parameter will be enabled only when 
Caption Source is set to Presets

• Direction: Sets the angle of the label in relation to its geographic position.
• Distance: Sets the distance of the label from its geographical position.
• WME Offsets Distance: When WME is enabled, this parameter enables the WME 

to offset the distance (default ON). When disabled (OFF) only the direction 
offsets from WME is used and the distance ignored.
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Special

 Figure 37: Special, 2D Label editor

• Shape: Defines the pointer shape:
• None: The pointer will have a sharp point shape.
• Circle: The pointer will have a circle at the tip of the pointer.
• Square: The pointer will have a circle at the tip of the pointer.
• Straight: The pointer will have straight lines at the tip of the pointer.
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• Size: Defines the size of the shape at the tip of the pointer. The parameter is 
only enabled if the pointer is selected and a tip shape is set.

• Navigator Overlay: Defines how the label will be displayed over the map. 
Available options are Disabled, Fixed, Scaling, Near Scale and Far Scale.
• Disabled: Places the label on the map using its geographical referencing.
• Fixed: Places the label by keeping its geographical referencing but using a 

different camera (either with dynamic image or with a front layer). The label 
size will remain fixed.

• Scaling: Places the label by keeping its geographical referencing but using a 
different camera (either with dynamic image or with a front layer). The Label 
will scale trying to imitate the camera movement.

• Near Scale: Defines the maximal size of the label on the screen (that is when 
zooming in what will be the final size of the label). 

• Far Scale: Defines the minimal size of the label on the screen (that is when 
zooming out what will be the final size of the label).

• Static Map Scale: Defines if scaling of the label will be performed over a static 
map (no Navigator plugin used). When disabled (Off), no scaling will be 
applied to the labels. When enabled (On), an additional parameter will be 
enabled:
• Scale: Sets the scaling factor of the labels when used over a static map (no 

Navigator Plugin). 
• Collision Mode: Defines how the labels will be placed when an overlap or 

collison between two labels occur:
• Tip Based: The pointers of overlapping labels can cross or touch, but no 

overlap of label bodies are allowed.
• BBox Based: A bounding box is calculated around the entire label (label 

body and pointer). Overlap between a label’s bounding box is not allowed.

Fade
Fade defines the fade effect parameters to be used with the duplicated labels. 
Fade has two fade modes; Stand Alone and Controlled.

 Figure 38: Stand alone fade mode, 2D Label editor

• Stand Alone: The label appearance is manually defined by setting the 
additionally enabled parameters:
• Fade On Time: Defines a label fade effect, beginning at a relative point to 

the defined hop duration. An additional parameter will be enabled, Time To 
Hop, defining when the fade will occur. 

• Fade On Distance: Defines a label fade effect, beginning at a relative 
distance from the hop final location. 

• Fade On Lat/Long: Defines a label fade effect, beginning at a Longitude and 
Latitude offset from the hop final location. An additional parameter will be 
enabled, Lat/Long, defining the offset from in degrees.

Note: The Fade On Distance parameter is only enabled if Navigator Overlay is set to 
Scaling.
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 Figure 39: Controlled fade mode, 2D Label editor

With Fade Mode set to Controlled, the label appearance is automatically set by the 
2DLabel plugin. It can also be based on the Label Manager plugin settings and the 
Navigator plugin animation (hops).
• Step: Controls when the label will fade in and out in relation to an animation. 

In general the fade can be based on the camera distance (for example; captials 
are in view when disctance is below 1000KM) or on timing in relation to the 
hop:
• Auto: When a label is of type point (added by the user) it will fade in and out 

based on distance to hop. If the label is of type place/region it will be faded 
in and out based on the distance set in Label Manager plugin. If the hop is 
not close enough for the label to show and the label was added by the user 
it will be faded in based on hop timing and not distance.

• On Hop: Links the fade to the hop timing.
• Point 1/Point 2: These are reserved for labels where the distance is 

configured by the Label Manager plugin.
• Selected Label Timing: If the label’s fading is based on hop timing, this 

parameter sets the time in relation to the hop time. It is disabled if Step is set 
to Point 1 or Point 2. Since the label appearance is automatically calculated 
this timing offset will be used in the calculation. Select one of the options:
• At End: Labels appear at the end of the animation.
• Close to End: Labels appear just before the end of the animation.
• Ahead: Labels appear before the end of the animation.
• Well Ahead: Labels appear well before the end of the animation.

• Label Priority: Defines the priority of the currently edited label in relation to 
other labels when a conflict between label positions occurs. The highest 
priority will be preferred when displaying the labels. 
• Auto: Sets the label priority using the Label Manager plugin.
• Normal, High: When there is a conflict between two normal (or high) priority 

labels, the Label Manager plugin decides which label to show.
• Always: When always is selected, the label will be displayed even if it 

conflicts with another label (with any priority).
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12.2 3D Border

The plugin can be found in the following folders:
• Viz Artist 2: Object -> Built in.
• Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

 Figure 40: 3D Border example

The 3DBorder plugin is used for applying graphic designs to the border data 
retrieved by the 3D Map Setting scene plugin. Each 3DBorder plugin is used to 
filter and define which borders will be drawn.

Note: When adding a 3DBorder plugin to a container, a 3D Line Shader plugin will 
be added automatically to the same container. The 3D Map Setting plugin has to be 
added manually when using the 3DBorder plugin.

This section contains information on the following topics:
• Plugin Description

See Also
• 3D Line Shader plugin
• 3D Map Setting plugin

12.2.1 Plugin Description
The 3D Border plugin has five sections of parameters, and a Rebuild button.
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The Data tab is used for defining which borders will be displayed by the plugin. 
The Width tab is used for defining the border width and other graphical related 
attributes. The Outline tab is used for adding an outline to the borders. The Effect 
tab is used for defining an animation of the border. The Advanced tab is used for 
defining general parameters of the border.

This section contains information on the following topics:
• Data
• Width
• Outline
• Effect
• Advanced
• Rebuild button

Data

 Figure 41: Data, 3D Border editor

• Draw: Sets the border type that will be drawn by the plugin. Available options 
are Country, Region and All.
• Country: Draws country borders only. When Country is selected, additional 

options are made available: Country, Coastline and Both (see Select).
• Region: Draws region borders only. When Region is selected, additional 

options are made available: Region, Sub Region and Both (see Select).
• All: Draws all available borders retrieved by the 3D Map Setting plugin.

• Select: Displays the available Country or Region options when either of the two 
buttons are selected.
• Country: Draws inland country borders only.
• Coastline: Draws country coastline borders only.
• Both (Country & Coastline): Draws both inland and country coastline 

borders.
• Region: Draws region borders only.
• Sub Region: Draws sub region borders only.
• Both (Region & Sub Region): Draw both region and sub region borders.

• Selection: Defines if the plugin will use the selected regions in the map 
(received from the CWMClient plugin) or not. If enabled, only the borders of 
the selected regions in the map will be drawn. If disabled, all borders will be 
drawn according to the plugin settings (country, region, and so on).
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Width

 Figure 42: Width, 3D Border editor

• Fixed (Pixels)– Uses a fixed width when drawing the line. This parameter will 
cause the line to maintain the same width regardless of camera position/
distance. Available parameters are Width and Fade Edge. 
• Width (Pixels): Sets the line width in pixels. 
• Fade Edge (%): Sets the percentage of softness added to the edges of the 

line. When set to 0% the line edges will be sharp and when set to 100% the 
edges will be soft. 

• Scaling: When selected, line width will vary according to the camera distance 
from the map. Available parameters that allow the user to set the line 
attributes are Width, Minimum Width, Maximum Width, Minimum Draw Width 
and Fade Edge. 
• Width (Meters): Sets the line width in meters on the map. The closer the 

camera to the map, the wider the line will be drawn. 
• Minimum Width (Pixels): Sets the minimal line width in pixels. If the 

calculated line width (according to the Width parameter) is smaller than the 
Minimum Width value, then the Minimum Width value will be used. 

• Maximum Width (Pixels): Sets the maximal line width in pixels. This value 
will be used when the camera distance is small and the line width should 
have been larger than the Maximum Width value (in pixels).

• Minimum Draw Width (Pixels): Sets the minimal line width in pixels. If the 
calculated line width (according to the Width parameter) is smaller than the 
Minimum Draw Width value, and larger than the Minimum Width parameter, 
then the line will not be drawn. 

• Fade Edge (%): Sets the percentage of softness added to the edges of the 
line. When set to 0% the line edges will be sharp and when set to 100% the 
edges will be soft. 

• Fixed (Mm)– Uses a fixed width, in viz units, when drawing the line. This 
parameter will cause the line to maintain the same width regardless of camera 
position/distance. Available parameters are Width and Fade Edge. 
• Width: Sets the line width in pixels. 
• Fade Edge (%): Sets the percentage of softness added to the edges of the 

line. When set to 0% the line edges will be sharp and when set to 100% the 
edges will be soft. 
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Outline

 Figure 43: Outline, 3D Border editor

• None: No outline to the borders is drawn by the plugin. 
• Master: Acts as the master plugin for outline behavior. Other 3DBorder plugins 

can be set as clients of this plugin. The same outline attributes will be applied 
to borders drawn by the master plugin and by all other slave plugins. When 
selected, additional parameters will be enabled:
• Outline Width (%): Sets the width of the outline, as a percentage of the 

border width, where 0% is the border width. 
• Outline Fade (%): Sets the percentage of softness applied to the outline 

edges.
• Outline Color: Sets the color of the outline and the alpha value of the 

outline.
• Slave: Draws the outline according to the defined outline in the master plugin 

above it in the scene hierarchy. All other parameters will be disabled, 
displaying the master’s values.

• Stand Alone: Defines the outline parameters for the borders drawn by this 2D 
Label plugin only:
• Outline Width (%): Sets the width of the outline, as a percentage of the 

border width, where 0% is the border width. 
• Outline Fade (%): Sets the percentage of softness applied to the outline 

edges.
• Outline Color: Sets the color of the outline and the alpha value of the 

outline.

Note: The hierarchy structure is important when using the master/slave outline 
configuration. The master plugin should always reside as the first container in the 
group of 3DBorder containers. An Expert plugin should be added to the map (above 
the 3D Roads containers) and Z-Buffer Draw should be set OFF.
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Effect

 Figure 44: Effect, 3D Border editor

The Effect tab is used for creating an animation on the line size. After the line 
object is created, it can be animated by setting keyframes of the length 
parameter.
• Length: Sets the line length, where the value 100 represents 100% of the line 

length.
• Fade: Defines the softness that is added to the line edge as the length 

animation advances. When the length is 100, the end of the line will not be 
affected by the Fade parameter.

• Height Offset: Offsets the borders from the map (on the fly).

Advanced
The Advanced tab is used for defining general prameters for the 3DBorder object.

 Figure 45: Advanced, 3D Border editor

• Border Quality: Selects the quality of the border line:
• Controlled: Border quality is calculated by the navigator distance from the 

border object.
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• High: Uses high quality when drawing the border line (performance will be 
slower).

• Medium: Uses medium quality when drawing the border line.
• Low: Uses low quality when drawing the border line. Border line will look 

pixelized when zomming into the map.
• Culling Threshold: Defines the size of the borders that will be drawn. Select an 

option that will fit the graphic design or other factors. For example; If a 
country has small islands and the threshold is set too high, the islands will not 
be drawn correctly or drawn at all.

• Add Level Down: Defines if the sub region borders will be drawn with the 
region borders, or if regions will be drawn with countries.

• Control Mode: Defines if the 3DBorder object is externally controlled by the 
3DBorderControl plugin or not. Border objects are controlled by groups. Set 
the group number for the object.

• Update Texture Mapping: Should the texture coordinates be updated based on 
line width.

• Low Angle Compansation: Lines become too thin at low camera angles as a 
result of the perspective distortion. When that happens, there are not enough 
pixels to support a smooth, antialiased line, and the lines look jaggy and 
aliased. This mode compensates for that by both widening the lines and 
applying transparency when they are viewed at too low angles.

• Wireframe: Shows the border object as a wireframe.

Rebuild

 Figure 46: Rebuild, 3D Border editor

The Rebuild button triggers the plugin to redraw the borders according to the 
plugin parameters. Some parameters are updated as the parameters are changed 
and do not require a rebuild command, but it is good practice to rebuild the 
borders after setting the parameters.

12.3 3D Border Control

The plugin can be found in the following folders:
• Viz Artist 2: Object -> Built in.
• Viz Artist 3: Built Ins -> Geom Plugins -> Maps-Adv.

The 3DBorderControl plugin is used to control the attributes of a group of 
3DBorder objects. The plugin controls the applied material, border width, edge 
softness and visibility.
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Note: The 3DBorderControl plugin does not build the 3DBorder objects. The 
controlled 3DBorder objects should be built before the 3DBorderControl is used.

This section contains information on the following topics:
• Plugin Description

12.3.1 Plugin Description

The 3DBorderControl plugin has two modes: Control for defining the control 
mode and Width for setting the border parameters.

• Container: Placeholder for the top container of the 3DBorder objects. All 
controlled 3DBorder objects must reside directly under the top container. Any 
lower level containers will not be effected.

This section contains information on the following topics:
• Control
• Width

Control

 Figure 47: Control mode Level, 3D Border Control editor

• Control Mode: Defines how the objects will be grouped when controlled by the 
3DBorderContol plugin. When set to Level, the 3DBorder objects will be 
grouped by their data type (that is country, region and sub-region).

• Draw: Defines what data types will be drawn. 3DBorder objects with other data 
types will not be switched off:
• Country: Shows 3DBorder objects displaying country borders only.
• Region: Shows 3DBorder objects displaying region and sub region borders 

only, according to the user selection. Available options are; Region (draws 
region borders), Sub-Region (draws sub-region borders) and Both (draws 
both region and sub-region borders).

• All: Draws all border types (that is country, region and sub-region).
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 Figure 48: Control mode Group, 3D Border Control editor

Group: Defines the group number that will be visible and controlled by the 
3DBorderControl plugin. Groups are defined in the 3D Border plugin in the 
Advanced tab’s Set Groups parameter.

Width

 Figure 49: Width, 3D Border Control editor

• Fixed (Pixels)– Uses a fixed width when drawing the line. This parameter will 
cause the line to maintain the same width regardless of camera position/
distance. Available parameters are Width and Fade Edge. 
• Width (Pixels): Sets the line width in pixels. 
• Fade Edge (%): Sets the percentage of softness added to the edges of the 

line. When set to 0% the line edges will be sharp and when set to 100% the 
edges will be soft. 

• Scaling: When selected, line width will vary according to the camera distance 
from the map. Available parameters that allow the user to set the line 
attributes are Width, Minimum Width, Maximum Width, Minimum Draw Width 
and Fade Edge. 
• Width (Meters): Sets the line width in meters on the map. The closer the 

camera to the map, the wider the line will be drawn. 
• Minimum Width (Pixels): Sets the minimal line width in pixels. If the 

calculated line width (according to the Width parameter) is smaller than the 
Minimum Width value, then the Minimum Width value will be used. 

• Maximum Width (Pixels): Sets the maximal line width in pixels. This value 
will be used when the camera distance is small and the line width should 
have been larger than the Maximum Width value (in pixels).

• Minimum Draw Width (Pixels): Sets the minimal line width in pixels. If the 
calculated line width (according to the Width parameter) is smaller than the 
Minimum Draw Width value, and larger than the Minimum Width parameter, 
then the line will not be drawn. 
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• Fade Edge (%): Sets the percentage of softness added to the edges of the 
line. When set to 0% the line edges will be sharp and when set to 100% the 
edges will be soft. 

• Fixed (Mm)– Uses a fixed width, in Viz units, when drawing the line. This 
parameter will cause the line to maintain the same width regardless of camera 
position/distance. Available parameters are Width and Fade Edge. 
• Width: Sets the line width in pixels. 
• Fade Edge (%): Sets the percentage of softness added to the edges of the 

line. When set to 0% the line edges will be sharp and when set to 100% the 
edges will be soft. 

12.4 3D Border Manager

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Maps-Man.
• Viz Artist 3: Built Ins ->Function-> Maps-Man.

The 3DBorderManager plugin is used for creating 3D Border objects based on 
shape files. The plugin uses a 3D Border design to create borders according to the 
defined settings.

This section contains information on the following topics:
• Plugin Description
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12.4.1 Plugin Description
 Figure 50: Target set to Container, 3D Border Manager editor

• Design: Sets the 3D Border design container that is used for building lines. 
The design container should be built with a 3D Border object and a material. 
No special naming convention is required.

• Target: Defines the container to be used as the parent container for the border 
containers:
• Me: The 3D Border objects will be built under the current container (holding 

the 3D Border Manager plugin).
• Next: The 3D Border Objects will be built under the next container (next 

container in the tree and at the same level as the 3D Border Manager 
container).

• Down: The 3D Border objects will be built under the first child container.
• Container: The 3D Border objects will be built under the container dragged 

into the Target container place holder.
• Target Container: Specifies the container that will hold all the 3DBorder 

objects.
• Shape File: Defines a path to the shape file (*.shp), containing the border 

definitions. Shape files are bought from vendors specialized in Geographic 
Information System (GIS) and holds the actual shape data; polygons, splines, 
and others. Note that shape files must be stored in individual folders.

• Simplify Threshold: Sets the detail reduction factor for the shape borders.
• Persistent Data: Defines if the data will be removed from Viz memory when the 

scene is closed or not. When enabled references are kept, and load time is 
quicker.

• Border Type: Defines which border type will be associated with the created 
objects. If Advanced is selected, additional parameters will be enabled 
allowing the configuration of border type according to the data associated 
with the shape file.
• Border’s Type: Specifies the column name that holds each border type. 

Country ID, Region ID, Sub Region ID and Coastline ID: Specifies the string 
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in the database file (*.dbf) that matches to each type (e.g. Country, Region 
and so on).

• Clear and Build: Removes all child objects of the target container and re-
builds the obejcts, using the plugin settings.

• Clear Target Tree: Removes all child objects of the target container.

12.5 3D Line

The plugin can be found in the following folders:
• Viz Artist 2: Object -> Built in.
• Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

 Figure 51: 3D Line example

The 3DLine plugin has several graphic uses:
• Drawing shape lines created in Viz World Maps Editor (WME) when selecting a 

map. A line design is created in the hierarchy and defined in the CWM Client 
plugin (see 3D Objects and Shapes, CWM Client editor).
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• Drawing a line between label locations, defined in the WME, from the first label 
in the list to the last label in the list. Labels in the CWM Client plugin must be 
enabled when using this mode.

• Drawing a line along hop points defined in a Navigator scene. The line will 
follow the path af the Navigator animation between the hops.

• Drawing a line using a Long/Lat coordinates list. The line will be drawn from 
the first Long/Lat pair to the last.

Note: When adding a 3DLine plugin to a container, a 3D Line Shader plugin will be 
added automatically to the same container. The 3D Map Setting plugin has to be 
added manually when using the 3DLine plugin with Navigator plugin.

Note: Some of the uses of 3Dline plugin as described above requires the use of the 
Label Manager plugin in the scene.

This section contains information on the following topics:
• Plugin Description

See Also
• 3D Line Manager
• 3D Line Shader
• 3D Map Setting
• Label Manager
• Navigator

12.5.1 Plugin Description
The 3D Line plugin has four sections of parameters, and a Rebuild button.

This section contains information on the following topics:
• Width
• Outline
• Effect
• Control
• Advanced
• Rebuild button
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Width

 Figure 52: Width, 3D Line editor

Note: Width parameters, Fixed (Pixels) and Scaling, will effect the line object only if 
the scene uses a Navigator plugin. In case of a static map, use the Fixed (Mm) to set 
the line width.

• Fixed (Pixels)– Uses a fixed width when drawing the line. This parameter will 
cause the line to maintain the same width regardless of camera position/
distance. Available parameters are Width and Fade Edge. 
• Width (Pixels): Sets the line width in pixels. 
• Fade Edge (%): Sets the percentage of softness added to the edges of the 

line. When set to 0% the line edges will be sharp and when set to 100% the 
edges will be soft. 

• Scaling: When selected, line width will vary according to the camera distance 
from the map. Available parameters that allow the user to set the line 
attributes are Width, Minimum Width, Maximum Width, Minimum Draw Width 
and Fade Edge. 
• Width (Meters): Sets the line width in meters on the map. The closer the 

camera to the map, the wider the line will be drawn. 
• Minimum Width (Pixels): Sets the minimal line width in pixels. If the 

calculated line width (according to the Width parameter) is smaller than the 
Minimum Width value, then the Minimum Width value will be used. 

• Maximum Width (Pixels): Sets the maximal line width in pixels. This value 
will be used when the camera distance is small and the line width should 
have been larger than the Maximum Width value (in pixels).

• Minimum Draw Width (Pixels): Sets the minimal line width in pixels. If the 
calculated line width (according to the Width parameter) is smaller than the 
Minimum Draw Width value, and larger than the Minimum Width parameter, 
then the line will not be drawn. 

• Fade Edge (%): Sets the percentage of softness added to the edges of the 
line. When set to 0% the line edges will be sharp and when set to 100% the 
edges will be soft. 

• Fixed (Mm)– Uses a fixed width, in viz units, when drawing the line. This 
parameter will cause the line to maintain the same width regardless of camera 
position/distance. Available parameters are Width and Fade Edge. 
• Width: Sets the line width in pixels. 
• Fade Edge (%): Sets the percentage of softness added to the edges of the 

line. When set to 0% the line edges will be sharp and when set to 100% the 
edges will be soft.
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Outline

 Figure 53: Outline, 3D Line editor

• Outline: Enables (On) or disables (Off) outline.
• Outline Width (%): Sets the width of the outline, as a percentage of the 

border width, where 0% is the border width.
• Outline Fade (%): Sets the percentage of softness applied to the outline 

edges.
• Outline Color: Sets the color of the outline and the Alpha value of the 

outline.

Note: The color palette is visible in all tabs of the editor, but it will only effect the 
outline color.

Effect
The Effect tab is used for creating an animation on the line size. After the line 
object is created it can be animated by setting keyframes on the length 
parameter.

 Figure 54: Effect, 3D Line editor

• Length: Sets line length, where 100 is 100% of the line length.
• Fade: Defines the softness that will be added to the line edge as the length 

animation advances. When length is 100 the end of the line will not be 
affected by the Fade parameter.

• Animation Length (frames): Sets the default length of the reveal animation in 
frames (relates to the Run Animation option) and allows you to run a simple 
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reveal animation by pressing the Run Animation button (used by 3D Map 
Telestrator)

• Lock To Navigator: When using the 3D Line plugin with a Navigator plugin, the 
line will animate with the Navigator animation. The starting point of the line 
will be the first hop location and the ending point of the line will be the last 
hop position. The line will animate as the hop animations are playing.

Control
The Control tab is used for defining external control parameters. External control 
is done by the 3DLineControl plugin.

 Figure 55: Control, 3D Line editor

• Control Mode: Defines if the object is externally controlled or not.
• Set Groups: Defines the groups that the currnet 3DLine object is a member of. 

The same group names should be used in the 3DLineControl.
• Shared Memory: What type of shared memory (viz 3 only) can be used in order 

to control the lines
• Identifier: Shared memory name and general purpose Identifier for this line. 

Can be used to control the line or to share a display list data between scenes.
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Advanced

 Figure 56: Advanced, 3D Line editor

• Cap Edges: Sets the line’s cap shape:
• None: The line edges will not change.
• Round: Adds a a filled round shape to the line caps,
• Square: Adds a filled square shape to the line caps,
• Feather: Adds a feather shape to the line caps, An additional parameter will 

be enabled when Feather is selectd: Cap Fade SIze.
• Wireframe: When enabled (On), the 3DLine object will be drawn as a 

wireframe.
• Height Offset: Sets the height offset for the 3D Line object on the map (on the 

fly).
• Line Offset: Sets the line offset for the 3D Line object on the map (on the fly).
• Split International Date Line: When enabled (On), a line object that crosses the 

date line will continue from the other side of the map. When disabled (Off), it 
will continue across the date line.

• Update Texture Mapping: Should the texture coordinates be updated based on 
line width. You have the following options; Disabled, Always or Stationary. 
Stationary will only update the texture mapping when navigator is moving.

Note: When enabled, symbols are easier to control, but as line width changes the 
cause texture changes which might be disturbing.

• Low Angle Compensation: Lines become too thin at low camera angles as a 
result of the perspective distortion. When that happens, there are not enough 
pixels to support a smooth, antialiased line, and the lines look jaggy and 
aliased. This mode compensates for that by both widening the lines and 
applying transparency when they are viewed at too low angles.

• Debug: Enables debug messages in the console.
• Min Angle: If the angle between the camera and the ground below the line is 

lower than "Min Angle", then line width and transparency will not be changed.
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• Max Angle: If the angle between the camera and the ground below the line is 
higher than "Max Angle", then the line width is increased by the "Width Factor" 
and the transparency is scaled by the "Alpha Factor". If the angle is between 
Min Angle and Max Angle then the width and transparency are interpolated.

• Outline Angle Offset: For outline width, apply an offset to the angle calculation 
in order to make the outlines affected at higher angles than the lines 
themselves

• Width Factor (%): A factor for modifying line width when applicable.
• Alpha Factor (%): A factor for modifying line alpha when applicable.

Rebuild

The Rebuild button triggers the plugin to redraw the lines according to the plugin 
parameters. Some parameters are updated as the parameters are changed and do 
not require a rebuild command but it is good practice to rebuild the lines after 
setting the parameters.

12.6 3D Line Control

The plugin can be found in the following folders:
• Viz Artist 2: Object->Built in.
• Viz Artist 3: Built Ins ->Geometry -> Maps-Adv.

The 3DLineControl plugin is used for controlling 3D Line object groups. The 
Groups are then controlled in terms of width and color. The groups are derived 
from the settings in the 3DLine objects.

This section contains information on the following topics:
• Plugin Description

12.6.1 Plugin Description
 Figure 57: Control tab, 3DLineControl plugin.

• Container: Sets the top container above the controlled 3DLine objects. 
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• Group: Defines the controlled group number. A group is defined in every 
3DLine object.

 Figure 58: Width tab, 3DLineControl editor

• Width: Select one of the options to control the line width, Fixed (in pixels or in 
mm), or scaling.
• Width: When fixed width is selected (pixels or mm), set the width value. 

Fixed width the line will maintain the width value through all camera zoom 
range. When Scaling is selected, width is set in actual kilometers and the 
line width will be calculated according to the camera zoom.

• Minimum Width (Pixels): Set the minimal value of line width in pixels. this 
value will be used if the calculated width according to the width parameter 
is smaller than the minimum width value (when zooming far out).

• Maximum Width (Pixels): Set the maximal value of line width in pixels. this 
value will be used if the calculated width according to the width parameter 
is larger than the maximum width value (when zooming in).

• Minimum Draw Width (Pixels): This value defines the minimal line width 
drawn.

• Fade Edge (%): Defines the edge fade width as a percentage of the line 
width.

12.7 3D Line Manager

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Maps-Man.
• Viz Artist 3: Built Ins ->Function-> Maps-Man.

The 3DLineManager plugin is used for controlling and creating 3D Line objects. 
The plugin uses a 3D Line design to create lines according to the defined settings. 
The plugin allows you to build 3D Line in four different modes: Navigator, 
Command, from WME and from a Shape file.
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This section contains information on the following topics:
• Plugin Description

12.7.1 Plugin Description
• Design: Sets the 3DLine design container that is used for building lines. The 

design container should be built with a 3D Line object and a material. No 
special naming convention is required.

• Target: Defines the container to be used as the parent container for the line 
containers:
• Me: The 3D Line objects will be built under the current container (holding 

the 3D Line Manager plugin).
• Next: The 3D Line Objects will be built under the next container (next 

container in the tree and at the same level as the 3D Line Manager 
container).

• Down: The 3D Line objects will be built under the first child container.
• Container: The 3D Line objects will be built under the container dragged 

into the Target container place holder.

 Figure 59: Target set to Container, 3D Line Manager editor

• Data Source: Defines the source from which the 3D Line objects will be 
created:
• Navigator: A 3D Line object will be created using the hop locations defined 

in the Navigator plugin. The line will start at the first hop location and end 
at the last hop location.

Note: When using the Navigator as the data source, the 3D Line Manager should 
reside under the Navigator container.

• Command: The 3DLine object will be created from a list of Long/Lat pairs 
defined by the user.

Example: MyLine: 0,0 0,50 30,30

• WME labels: Allows you to build a line between locations chosen in Viz 
World Maps Editor (WME) as WME labels (no line will be built if WME labels 
are not defined). Also, the WME source container must be specified and 
refresh should be applied by clicking the Refresh button in CWMClient 
(Rebuild button is disabled in this mode). The line between the labels starts 
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and ends in the order they where added (as seen in WME’s Map Details list). 
The first label location is the label at the top of the list, and and the last is at 
the bottom of the list. Rearrange the list to create a new order.

• Shape file: Uses a shape file as data source.

Note: In WME Labels option, the 3DLineManager should be attached to the CWM 
Client plugin container. The Labels in the CWMClient plugin must be enabled.

• Spline: Enables you to convert a line to a smooth curve in different modes:
• Off: no curve, straight line chunks between data points.
• Control Points: line is represented as smooth curve that passes between 

data points.
• Curve Points: line is represented as smooth curve that passes through data 

points.
• Controlled: same as Control Points, but smoothness (i.e. distance of the line 

from original points) can be controlled.

• Set Navigator Hops: Enables the scene to do a hop animation between the 
labels.
• The animation can be altered by using the Trace It plugin by setting and 

enabling a different Trace Camera, Lock Pan, Lock Tilt and Lock Distance 
mode/parameter (e.g. creating a flyby/flyover animation).

• In this case the Trace It plugin is added as a sub container of the 
Default_Design container (defines the 3D line’s default design) which is 
resides under the Map Start (M-S) container. Once changes are made you 
simply republish the design (see Publish To Design plugin).

• Exclude Hops: Excludes the hop animation for the following labels; None, 
First, Last or First&Last. Manual Shift allows you to define which destination 
that should be your starting point (limited to a selection of 30 destinations).

• Set Hops Height: Allows you to disable or enable the Hops Height setting.
• Hops Height: Enables you to define the height of the hops in Viz units.

12.8 3D Line Shader

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Shader (button) -> Maps.
• Viz Artist 3: Built Ins -> Shader -> Maps.

The 3DLineShader is used by the 3D Map Setting plugin to draw the borders using 
the parameters set in the various 2D Label plugins. The plugin has no parameters 
and it is added automatically when adding a 2D Label object to the scene tree.
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12.9 3D Map Setting

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Scene (button) -> Maps.
• Viz Artist 3: Built Ins -> Scene Plugins -> Maps.

The 3DMapSetting plugin is a scene plugin used for managing borders data from 
the server. The border data is retrieved from the Viz World Server (WoS), according 
to the setting in the 3DMapSetting plugin, is used for applying a graphic design to 
the borders in the map, drawn by the 2D Label plugins.

Note: Scene plugins are added under the Scene Settings’ Plugin tab.

This section contains information on the following topics:
• Plugin Description

12.9.1 Plugin Description
The 3DMapSetting plugin has two sections of parameters (General and Border 
Data) and a 3D Line button.

This section contains information on the following topics:
• General
• Border Data
• Window
• GUI
• Advanced

General

 Figure 60: General, 3D Map Setting editor

• Geographic Container: Draws the border of the selected map. Drag the 
CWMClient container that defines the map area to the container place holder.
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• 3D Global Designs Path: Sets the path to a Viz folder containg the global 
designs.

• 3D Global Designs: Drag the global designs container to the container place 
holder.

• 3D Global Holder: Defines the container that will hold all the global 3D objects 
created from the global designs.

Border Data

 Figure 61: Border data, 3D Map Setting editor

• World: Defines if the border data will be fetched for the entire world (country 
borders) or other data as defined in the Additional Region Data parameter.
• None: Retrieves the border data as defined in the Additional Region Data 

parameter.
• Full: Retrieves the country borders data for the entire world (country 

borders only).
• Additional Region Data: Defines additional border data that will be retrieved 

from the server with the data defined in the World parameter. The additional 
data will be limited to the selected region in the Region List parameter.
• None: No additional data will be used.
• Country: Country borders data in the selected region area will be used. 
• Region: Region borders data in the selected region area will be used.
• Sub-Region: Sub-Region borders data in the selected region area will be 

used.
• Region List: Defines an area of the world for which the additional region data 

will be retrieved from the server. The parameter limits the data size retrieved 
from the server.

• Rebuild: Retrieves the information from the Viz World Server (WoS).
• Rebuild (Force New): Recreates the data on the Viz World Server (WoS) and 

saves it to the cache folder, even if cached data already exists.
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Window

 Figure 62: Window, 3D Map Setting editor

• Window Active: Enables the user to define an area in the renderer as an active 
window. All maps data created by the Viz World Client will be redrawn to fit 
into the defined window. When set to ON additional paramters will be enabled:
• Effect Culling: Defines if the window will effect the culling of the vector data 

(streets, borders, etc.).
• Window Mode: Defines the source of the window aspect: Manual sets the 

window aspect to be user defined, Camera sets the window aspect to be the 
same as the render window, and Image sets the window aspect to be the 
same as the the image aspect of the map.

• Window Units: Defines the units used to set the window size and position. 
When set to Percents, the window size will be calculated as the defined 
percentage of the Viz render window size. The window position will be 
calculated as the defined offset percentage of the render window.

• Window Width: Defines the width of the window in percents or pixels.
• Window Height: Defines the height of the window in percents or pixels. This 

parameter is enabled only if window mode is set to Manual.
• Window Center Offset X: Defines the X position (percents or pixels) of the 

window in relation to the render window (center to center).
• Window Center Offset Y: Defines the Y position (percents or pixels) of the 

window in relation to the render window (center to center).
• Control Win Mask: Defines if a WindowMask plugin (added to the map) will 

be controlled by the 3DMapSettings plugin to mask the defined window or 
not.

• Window Mask Scale: Defines the scale of the mask over the defined window.
• Show Debug Window Mask: When enabled (on), a red rectangle around the 

defined window will be displayed.

GUI
GUI defines general parameters for controlling container names and container 
colors in the Viz GUI (effecting the Viz scene tree display), and the creation of 
Control Channels from added Viz World Client objects. The Control Channels in 
Viz are displayed under the Control tab and serve as an index for the scene tree. 
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For additional information about Control Channels please refer to the Viz Artist 
user guide.

 Figure 63: GUI, 3D Map Setting editor

• Hops: Defines GUI parameters for hop containers in the scene tree:
• None: No control channel or name conversion will be applied to the hop 

containers.
• Control: Only a control channel will be added for the hop containers.
• Name: The created hop containers will be named Hop-1, Hop-2, etc., 

according to the hop point selected in the NavFinder plugin. No control 
channel will be added.

• Full: A control channel will be added for every hop container and the hop 
containers will be renamed Hop1, Hop2, etc.

• Designs: Defines GUI parameters for any design containers (region designs, 
road designs, label designs, and so on) in the scene tree:
• None: No control channel or name conversion will be applied to the design 

containers.
• Control: Only a control channel will be added for the design containers used 

in the scene. The containers will not be renamed.
• Name: The design containers (dragged to the CWM Client plugin) will be 

renamed Label-Designs, Region-Designs, and so on. No control channel 
will be added.

• Full: A control channel will be added for every design container and the 
design containers will be renamed.

• Holders: Defines GUI parameters for any object holder containers (regions, 
roads, labels , and so on) in the scene tree:
• None: No control channel or name conversion will be applied to the holder 

containers.
• Control: Only a control channel will be added for the holder containers used 

in the scene. The containers will not be renamed.
• Name: The holder containers (dragged to the CWM Client plugin) will be 

renamed Label-Holder, Region-Holder, and so on. No control channel will 
be added. If the holder container is dragged to a hop CWM Client, it will be 
named with a sufix indicating the hop number: Label-Holder-H1, Label-
Holder-H2, and so on.

• Full: A control channel will be added for every design container and the 
Holder containers will be renamed.

• Hops Color: Sets the color index, as defined in the User Interface parameter in 
Viz Config (Viz 3 only), that will be used for the Hop containers in the scene 
tree.
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• Design Color: Sets the color index, as defined in the User Interface parameter 
in Viz Config (Viz 3 ONLY), that will be used for the design containers in the 
scene tree.

• Holder Color: Sets the color index, as defined in the User Interface parameter 
in Viz Config (Viz 3 ONLY), that will be used for the generated objects holder 
container in the scene tree.

Advanced

 Figure 64: Advanced, 3D Map Setting editor

• Culling Threshold: Sets the size of polygons to be culled (not rendered). It is 
generally better to cull small polygons as they may not look good when 
rendered.

• Polygon Quality: Defines the quality of the drawn border lines. The higher the 
quality the smoother the line will be.

• Polygon Quality Factor (%): Enables the user to change the automatic polygon 
quality levels by setting a factor that will change the border quality. Values 
under 100% will decrease the quality of the lines. Values above 100% will 
increase the quality of the lines.

Tip: For more information about Viz Config and its configuration options, see the Viz 
Engine Administrator’s Guide.

12.10 3D Map Telestrator

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps-Adv
• Viz Artist 3: Built Ins -> Container Plugins -> Maps-Adv

3D Map Telestrator plugin enables you to draw strokes on maps (including 
globes) and arbitrary flat objects using screen input interface like mouse or "touch 
screen". The strokes, whether with geo or non-geo coordinates may be passed to 
other scenes on distant computers through the mechanism of shared memory.

3D Map Telestrator uses 3D Line for strokes visualization and thus it benefits 
from the rich design capabilities of this plugin.
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The obtained strokes may be smoothed to an arbitrary degree to obtain better 
looking final result of the drawing.

This section contains information on the following topics:

• Plugin Description
• Creating a 3D Map Telestrator Scene
• Non Geo-Reference Telestration
• Shared Memory Mechanism
• Using Multitouch Interface
• Using Perceptive Pixel Interface
• Brush Design Using 3D Line

12.10.1 Plugin Description

• Camera: Defines working camera to accept screen input (which is useful in a 
scene with layers where more than one camera is used).

• Line Pixel Resolution: Defines the required resolution of line during drawing, 
such that for example if resolution of 5 is set strokes less than five pixel size 
will be disregarded.

• Designs Holder: Container beneath which the required design will be 
searched.

• Design Name: A couple of designs may be implemented in the scene and here 
the desired one for current use will be set. If the required design does not 
exist, the first one found will be used. 

• Target: Defines where to build line strokes. If the Container option is used the 
desired container should be specified in "Target Container" section.

• Active: Defines when the plugin will be active. It may be switched off, active 
always or only be activated while pressing 'p' button on the keyboard. This is 
useful when other interactive capabilities are used in the scene (for example 
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interactive navigation) and a care should be taken in order not to interfere 
these modes.

• Spline: By choosing one of these options the final result will be smoothed for 
more pleasant look. The three spline types define three different methods for 
smoothing.
• Control Points: Uses a spline that paths between the points of the original 

curve. This will result in the smooth nice curve but may be not accurate 
enough since the line doesn't actually path through original route but may 
deviate from it. 

• Curve Points: Makes the spline path through points of interest of the 
original curves, but this method may also result in some artifacts causing 
the route to deform between points of interest, and that is due to a 
constraint that curve must be smooth.

• Combined: Is a kind of compromise between Control and Curve points (see 
Examples)

• Smoothness: If spline is used in order to obtain smoothed result the 
smoothness defines the threshold for such operation. The higher the 
threshold the softer the curve will be (see the examples at the end of this 
section).

• Close Stroke: If enabled strokes will be automatically closed.
• Control mode: While enabled evokes a shared memory mechanism to send 

and receive strokes to and from other 3D Map Telestrator plugins.
• Shared Memory: defines type of shared memory: 
• Global: Shared within the region of computer.
• Scene: Shared within the region of current scene only.
• Distributed: Shared between all the scenes and computers in the network.

• Shared Memory Name: Defines the name for connection, such that only 
3DMapTelestrators with the same name will share data between them.

• Input Interface: Selects interface type for line creation. See further remarks 
about "PPI" and "Multitouch" use.

• Animation Control: When enabled runs animation that is located on design 
container after line is created (mouse button released).

• Clear/Undo: Enables you to undo last strokes or clear the whole drawing 
instead.
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Examples

 Figure 65: Original curves

 Figure 66: Control points

 Figure 67: Curve points

 Figure 68: Combined
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 Figure 69: Influence of the smoothness parameter set to original, low, medium and high
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12.10.2 Creating a 3D Map Telestrator Scene

To create a 3D map telestrator scene

1. Prepare a blank workspace for the new scene, go to Geom Plugins -> Maps 
and drag an Atlas plugin to the scene
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2. Open the Atlas plugin’s editor, and in under Data Source switch to CMR, and in 
the CMR File locator locate the CMR with the desired map
• This will create a map to draw on
• If you have an Internet connection and license for Microsoft Bing maps you 

will see the world map as soon as you drop Atlas and there will be no need 
to load CMR

3. Go to Container Plugins -> Maps and drop the Navigator plugin onto the same 
container as the Atlas plugin
• Remember to enable interactivity by pressing the E button (to the left of the 

scene editor).
• Now navigation through the map is possible by pressing i button and using 

mouse. If the map suddenly disappeared after dropping Navigator plugin 
just click the Center Map button on the bottom of it.

4. Add a container above the one just prepared and name it LineDesigns
5. Add a new container as a child of LineDesigns and name it Red
6. Add the 3D Line plugin to the Red container
7. Open the 3D Line plugin’s editor and set the Width parameter to Fixed (Pixels)
8. Set the Width’s sliding parameter to 4
9. Switch to the Outline option on the topmost radio button row and set Outline 

to On and give it a width of 50 (Outline Width (%) parameter)
10.Add material to the container and make it to be red color. This will create the 

first design for the line.

11.Add another container beneath the Red container and name it Green
12.Add the 3D Line plugin to the Green container
13.Open the 3D Line plugin’s editor and set the Width parameter to Fixed (Pixels)
14.Add a material with a green color to the container

• This defines the second design for the line named "Green".

15.Add a new container as a child of the Atlas container and name it Telestrator 
and add the 3D Map Telestrator plugin to it

16.Open the 3D Map Telestrator plugin’s editor and drag the LineDesigns 
container onto the Designs Holder placeholder

17.Set the Design Name parameter to Red (in order to choose red design)
18.Set the Active parameter to the On 'P position
19.Set Shared Memory parameter to Distributed
20.Save the scene
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Now you should be able to draw on the map by pressing the P key on the 
keyboard and while holding the left mouse button down. Moreover, if you open 
the same scene on another computer in the network you should see the same 
drawings appearing on it too.

12.10.3 Non Geo-Reference Telestration
In the procedure on how To create a 3D map telestrator scene the drawing was 
done on the map, i.e. the path has geographic coordinates and as such it will be 
placed on the same geographical route when it will be sent to other computers (by 
using the Shared Memory Mechanism). The other map in the other scene may 
have different style and projection. It may also have globe geometry, and the path 
will still be geographically correct.

However, there is an option to use 3D Map Telestrator without map and 
geographic coordinates. In order to use this option two conditions must be met: 

• The plugin must not be located under geo-reference (in the example scene 
the Atlas was used as geo-reference), and

• The flat geometry about to be drawn on must be placed on the same container 
with 3D Map Telestrator plugin.

12.10.4 Shared Memory Mechanism

As explained in the 3D Map Telestrator Plugin Description section the plugin uses 
a shared memory mechanism in order to send and receive strokes to and from 
other 3D Map Telestrator plugins. In order for two plugins to interconnect they 
should have the same name for the shared memory data they are "listening" to. It 
must be mentioned that the given name will have a prefix of "Telestrator_", 
such that when a user enters the name "alpha" for the group of 3D Map 
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Telestrator plugins, the actual name of the shared memory parameter will be:  
"Telestrator_alpha".

The format of data consists of a unique id that each stroke receives, name of 
required design and data path that comes as a sequence of pairs of numbers 
representing  longitude and latitude (when non-geo-reference mode is used the 
flat geometry's bounding box is treated as if having the lat/lon coordinates of full 
world). All components of the data including design name and unique id are 
separated by commas.

12.10.5 Using Multitouch Interface
This interface uses touch screen of Multitouch type. In order for the plugin to 
receive information from the screen the Input Interface button should be switched 
to Multitouch mode and a container with the plugin should contain a geometry. 
Screen touches outside of this geometry will be disregarded. So, if the plugin is 
used in a non-georeference mode there is no problem since it already contains 
geometry you are drawing on. If it is used in a georeference mode the best 
practice would be to place the 3D Map Telestrator plugin on the container with 
the map.

See Also
• Using Perceptive Pixel Interface

12.10.6 Using Perceptive Pixel Interface
In a case of using a Perceptive Pixel Interface (PPI) screen the setup requires a 
couple of additional things to be done. A special plugin named Mt2dControl, that 
is a part of the PPI plugin package, will accept and process the inputs from the 
touch screen and the processed data will be sent to the 3D Map Telestrator plugin 
through a shared memory mechanism.

Continuing the procedure above on how To create a 3D map telestrator scene, 
you can add multi-touch capabilities to your graphics scene. Hence, the below 
procedure and example scene tree expands the aforementioned procedure.
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1. Open the 3D Map Telestrator plugin editor and set Input Interface to PPI (see 
Plugin Description) and chose a name for a shared memory connection with 
the PPI interface (i.e. a PPI variable name). Note that this must differ from 
shared memory connections with other 3D Map Telestrator plugins

2. Add the container somewhere in the scene which will not be a part of any 
hierarchy

3. Add a rectangle to the container and scale it to the maximum possible size
4. Add a Mute plugin on the container in order to avoid rendering it
5. Add a Multi-touch 2D control (Mt2dControl) plugin on the container
6. Open the Mt2dControl plugin editor and set the following parameters:

• Lock Rotation to On
• Lock Scale to On
• Shared Memory to On
• Shared Memory Type to Scene
• Shared Memory Prefix should be the same as the PPI variable name in the 

3DMapTelestrator plugin
• Hit Coordinate Type to World

7. Save the scene
• Now you should be able to draw lines by touching the screen

See Also
• Using Multitouch Interface

12.10.7 Brush Design Using 3D Line
The 3D Line plugin is used by the 3D Map Telestrator to visualize the strokes. The 
desired look of the line is set by various parameters in the design (inside the 3D 
Line plugin) and it is therefore important to understand these parameters in order 
to get the desired look and behavior for the line. 

The following are the most important parameters:
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Width
The options for the Width tab defines the width behavior of the line. Three options 
may be used to define width behavior: 

• Fixed (pixels): Defines constant width of line measured in pixels
• Scaling: line width may vary according to zoom and the minimum-

maximum parameters could be set
• Fixed (mm): Sets a fixed width in geographic units
• Fade Edge (%): Applies a fade effect to the side-edges

Outline
By using these options an outline of arbitrary width, fade amount and color can be 
set to a line.

Effect
Note that by default when a line comes to a 3D Map Telestrator plugin it plays an 
animation running from single point to a full path. The attributes of such an 
animation can be set beneath this tab. The length of animation in time is 
controlled by the Animation Length parameter and if it is set to '0' no animation 
will be played at all. Moreover, a nice fade effect to a running edge of the line 
could be set by the Fade parameter.

Advanced
A couple of options are available for this tab, the most important of which are:
• Cap edges: Defines shape for the beginning and end edge of the curve
• Height Offset: Defines an offset line from surface it is put on
• Update Texture Mapping: Note that a texture may be applied to a line. During 

zooms, line width is updated according to the setting we made in Width tab, 
while line length remains unchanged, thus texture mapped on the line may 
deform. In order to keep same aspect ratio for the texture this option must be 
enabled.

12.11 3D Region

The plugin can be found in the following folders:
• Viz Artist 2: Object -> Built in.
• Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The 3DRegion plugin is used for applying a graphic design to the selected regions 
in the map. The designs are defined in the scene and linked in the CWMClient 
plugin, to create the regions received from the maps server. 
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 Figure 70: 3D Region example

This section contains information on the following topics:
• Plugin Description

12.11.1 Plugin Description
The plugin has four different plugin editor views; General, Region, Sub Regions 
and Advanced.

The General parameters editor includes quality and performance parameters.

The Region parameters editor includes the object’s graphic properties.

The Sub Regions parameters editor includes the object’s sub regions graphic 
properties. This tab is enabled when the Sub Regions parameter, under the 
Advanced tab’s Data settings, is enabled (On).

The Advanced parameters editor define plugin behavior in special operation 
scenarios.

This section contains information on the following topics:
• General
• Region
• Sub Regions 
• Advanced
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General

 Figure 71: General, 3D Region editor

• LOD mode: Sets the level of details (LOD). When set to auto, the plugin will 
manage the level of details according to the camera distance from the region 
object. When set to manual, the level of details will not change when the 
camera moves, and will remain fixed. When set to Manual, the Polygon Quality 
parameter will be enabled.

• Polygon Quality: Sets the quality of the generated region object.
• Highest: Sets the highest level of detail. This option will use more polygons 

to build the region object but will have an effect on performance when many 
regions are selected.

• High: Sets a high level of detail.
• Medium: Sets a medium level of detail.
• Low: Sets a low level of detail.
• Lowest: Set the lowest level of detail. This option will enable better 

performance when adding a lot of regions, but will look poor when moving 
the camera closer to the region objects.

• Geo Reference: When enabled (On), references the region object to the map 
above the 3DRegion container. If disabled (Off), the longitude and latitude 
numbers will be transferred to the Viz Artist position X, Y values. The object 
will be free from referencing.

• Auto Rescale: Can be used when the region is not geographically referenced 
(on screen normal) and you want all regions to be the same size (e.g. Isreal 
uses the same screen real estate as a map of America) in Viz units.

• Center X Y: Defines where the axis of the region object will be placed: if 
Region is selected then the axis center will be the middle of the region object. 
If Map is selected the axis will be placed in the middle of the reference map.

• Sensible Culling: Defines whether to cut off areas that belong to the selected 
region but are geographically remote. If set to Off, all marked regions will be 
built. Use this feature to improve performance (usually set to On).

• Culling Threshold: Defines the level of details displayed in the regions. The 
higher the threshold value, the less details will be drawn (that is small islands, 
small regions, and so on).
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• Use Cache: When enabled (On), saves the objects to a cache folder. When 
using cache, the generated objects and parameters are saved in a cache folder 
and when switching between parameters the regions are not rebuilt, but taken 
from the cache (if they exist). If no (Off) cache is used, every change in the 
plugin interface will trigger a rebuild of the region objects.

Region

 Figure 72: Region fill, 3D Region editor

• Fill: Fill enables the user to add a region object to the map, and if fill is 
applied, how regions are built on the map (either flat on the map (no width) or 
extruded).
• None: No region object will be added to the map.
• Extrude: Regions will be added and extruded over the map. When extrude is 

used, additional parameters will be enabled.
• Flat: Adds a flat object (Extrude=0).

• Include Bottom: builds the bottom of the region when extruded.
• Center Z: Sets the Z axis location of the region object, with relation to the 

map: bottom, center or top.
• Type: Defines how the Height parameter will be calculated.

• Absolute Height: Defines the regions extrusion height value as Viz units. 
• Relative Height: Defines the regions extrusion height value as a percentage 

of the regions size. 

• Show Terrain: Enables 3DRegion to take into account any terrain data for a 
selected region. Adjust the Terrain Height Scale parameter (see next). For this 
to work you need to enable the Fetch Terrain Data option in the CWM Client.

• Terrain Height Scale: Adjusts the terrain height.
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 Figure 73: Region border, 3D Region editor

The border parameters define if a border will be drawn around the region objects, 
border color, width and the alpha. If the 3D Region object is in Controlled Mode 
(On) the border properties parameters will be disabled.
• Borders: Defines if the object will be drawn with a border. When enabled (On), 

the border will be drawn and the border properties parameters will be 
enabled.

• Line Width: Sets the number of GL lines for the border width.
• Line Color: Uses the color pallet to set the border color.
• Alpha: Sets the alpha value for the border

Note: The color palette is visible in all 3D Region editors but it will only affect the 
border color.

Sub Regions
The Sub Regions parameters are identical to the ones described for Regions with 
the exception for the terrain setting and parameter.

Advanced
A common parameter in the Advanced tab is Freeze. This parameter enables the 
designer to freeze the region object to Viz data folders (the region is saved as an 
image containing the region’s information).
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 Figure 74: Advanced data, 3D Region editor

The Data tab defines how data will be processed.
• Sub Regions: Defines if the object will use the sub regions data in the drawn 

object. When enabled (On), the sub regions data will be reflected in the 
geometry and the Sub Regions tab will display the sub regions parameters.

• Controlled Mode: Defines if the 3D Region object will be controlled by a 3D 
Region Control plugin in the hierarchy or not.

• Render Mode: Defines if the 3D Region object will be rendered by Viz or 
directly in OpenGL.

 Figure 75: Advanced election, 3D Region editor

The Election tab has one parameter, Command, containing text with region 
information used for elections. If Sub Regions is enabled (On), additional 
parameters will be enabled.
• Print SubRegion Data: Prints the data in the Viz console.
• Save Sub Regions Strings: Saves back the sub regions data to the file.
• Save Sub Region: Saves the current specific sub region information back to the 

file.
• Rebuild: Rebuilds the region objects from the file.
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 Figure 76: Advanced alpha, 3D Region editor

The Alpha tab is an advanced tab used for elections mainly. Alpha tab parameters 
will be enabled when the Sub Regions parameter is enabled (On). The parameters 
will affect the object only when an Alpha plugin is added to the object and the 3D 
Region plugin is in Controlled Mode. These parameters define what part of the 
region data will be affected by the alpha plugin.
• Draw: Defines what part of the object will be affected by the alpha settings.

• All: Both region and sub regions will be drawn in the object.
• Region: Draws only the region.
• Sub Region: Draws only the sub regions.
• None: Sets region and sub regions to be transparent.

• Region Alpha Mode: Defines what part of the data will be affected by the alpha 
plugin.
• Region: Affects only the region areas.
• Sub Regions: Affects only sub region areas.
• None: No data will be affected by the alpha plugin. 

• Border Alpha Mode: Defines what part of the border data will be affected by 
the alpha plugin.
• Region: Affects only the region borders.
• Sub Regions: Affects only sub region borders.
• None: No data will be affected by the alpha plugin. 
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 Figure 77: Advanced draw, 3D Region editor

The Draw tab defines advanced parameters for drawing the region objects.
• Day Line Mode: Relates to countries that reside on the 180 and -180 longitude 

line when using flat maps. 
• United: Draws the regions together. 
• None: Draws the regions on both sides of the map.

• Border Data: Defines the source data of the borders.
• Polygon: Draws borders using polygon data.
• Border: Draws borders using border data (higher memory consumption).

• Border Quality: Sets the required border quality.
• Wireframe: Draws a wireframe of the object.

Note: The color palette is visible in all 3D Region editors but it will only affect the 
border color.

12.12 3D Region Control

The plugin can be found in the following folders:
• Viz Artist 2: Object -> Built in.
• Viz Artist 3: Built Ins -> Geom Plugins -> Maps-Adv.
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 Figure 78: Region example, 3D Region Control

The 3D Region Control plugin is used to control one or more 3D Region objects 
and changing and applying graphic properties to the objects.

Typical use of the 3D Region Control is when producing election graphics where it 
is useful to distinguish regions by for example color.

This section contains information on the following topics:
• Plugin Description

12.12.1 Plugin Description
 Figure 79: Region, 3D Region Control editor

• 3DRegion Container: Container place holder for the container holding the 
region objects.
128 Chapter 12: Maps Plugins



• Control Mode: Defines the data segment of the object that will be controlled. 
Select Region or Sub Region and then select what part of the region/sub-
region to control:
• Region/Fill: Enables control of the region’s properties as defined in the Fill 

Mode parameter. 
• Region/Border: Enables control of the region’s border properties as defined 

in the Borders and Width parameter.
• Sub Region/Fill: Enables control of the sub region’s properties as defined in 

the Fill Mode parameter.
• Region/Border: Enables control of the sub region’s border properties as 

defined in the Borders and Width parameter.
• Fill Mode: Defines the fill of the regions.

• Interpolation (3): Sets three colors that will define the regions color range. 
The regions color will be derived from the range of colors and the number 
of regions. 

• Interpolation (2): Sets two colors that will define the regions color range. 
The regions color will be derived from the range of colors and the number 
of regions. 

• Group: Controls the fill of all the 3DRegion objects under the defined 
3DRegions Container (apply the material added to the 3DRegionControl 
container).

• Selected Region: Controls the selected regions on the map only.
• Apply Sender Matrix: Applies a matrix to the regions. Available options are 

None, Multiply, Translate, Scale and Full.
• None: Uses the 3D Region matrix.
• Multiply: Uses the 3D Region matrix multiplied by the 3D Region Control 

matrix.
• Translate: Uses only the translated part (x, y and z position) of the 3D 

Region Control matrix.
• Scale: Uses the scale part (x, y and z scaling) of the 3D Region Control 

matrix.
• Full: Uses the 3D Region Control matrix.

• Apply On: Applies the sent matrix on all regions or only the selected sub 
regions.

• Sub Region Borders: Enables control of the sub region borders properties as 
defined in the Sub Region Borders parameter.
• All: Controls all borders of the 3DRegion objects under the 3DRegion 

Container.
• Selected: Controls the borders of the 3DRegion objects that are the selected 

regions in the map.
• Width: Defines the border width in pixels.

Note: The color palette is visible in all tabs but it will affect the last selected color 
parameter in the UI. 
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12.13 3D Region Manager

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps-Man.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps-Man.

The 3DRegionManager plugin is used to create sub regions of a selected region 
on the map, using a 3D Region design. The plugin receives the region name and 
gets all the sub regions of that region from the server or a shape file. The 3D 
Region design is duplicated for each sub region and displayed on the map.

 Figure 80: Regions and sub regions, 3D Region Manager

This section contains information on the following topics:
• Plugin Description
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12.13.1 Plugin Description
 Figure 81: Target set to Me, 3D Region Manager editor

• Design: Sets the region design container that is used for building sub -
regions. The design container should be built with a 3D Region object and a 
material. No special naming convention is required.

• Target: Defines the container to be used as the parent container for the sub 
regions containers:
• Me: Builds the 3DRegion objects under the current container (holding the 

3DRegionManager plugin).
• Next: Builds the 3DRegion objects under the next container (next container 

in the tree and at the same level as the 3D Region Manager container).
• Down: Builds the 3DRegion objects under the first child container.
• Container: Builds the 3DRegion objects under the container dragged into 

the “Target” container place holder.

 Figure 82: Target set to Container, 3D Region Manager editor

• Build Region: Defines the source for which the 3DRegion objects will be 
created.
• Local: Builds the 3DRegion objects for the container that the 3D Region 

Manager is applied to. The container must be a 3D Region object for the sub 
regions to be built for the defined region.

• Selection: Builds the sub-regions or regions for selected regions. Press the 
Select Region button to select the regions to be built.
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• Border Visible Filter: Sets which borders should be cropped to map. Any 
border lower or equal to the selection will be cropped to the map. Available 
options are Country, Region and None.

• Scan: Defines what regions to display.
• Selected: Displays only the selected regions, selected by pressing the Select 

Region button.
• Recursive: Displays all selected regions and their sub regions.

• Select Region: Opens the Viz World Maps Editor (WME), enabling the selection 
of regions to be used in Selection mode.

 Figure 83: Shaped Regions set to Merge, 3D Region Manager editor

• Shape Regions: Defines how the regions will be built. Available options are 
Merge, Split and Advanced.
• Merge: Creates all regions in the file as one object.
• Split: Creates all regions in the file as separate objects.

• Shape File: Defines a path to the shape file (*.shp), containing the region 
definitions. Shape files are bought from vendors specialized in Geographic 
Information System (GIS) and holds the actual shape data; polygons, splines, 
and others for the container that the 3D Region Manager is applied to. The 
container must be a 3D Region object for the sub regions to be built for the 
defined region. Note that shape files must be stored in individual folders.
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 Figure 84: Shaped Regions set to Advanced, 3D Region Manager editor

• Advanced: Enables the additional parameters Conversion File, State Column 
and Name Column. Conversion File defines a file for converting regions 
indexes into region names (*.txt file). Parent Id Column, Parent Name 
Column and Names Column refer to columns in the database (*.dbf) file that 
comes with the shape file. The database files describes what is attached on 
the shape file. Note that database files can be opened with Microsoft Office 
Excel.

• Shape File: Defines a path to the shape file (*.shp), containing the region 
definitions. Shape files are bought from vendors specialized in Geographic 
Information System (GIS) and holds the actual shape data; polygons, splines, 
and others. Note that shape files must be stored in individual folders.

• Prepare Cache Files: Instead of building large amounts of regions from a 
shape file (which may overload the system), pre-creation of the cache files and 
then building the required regions only (directly from the cache files) will 
minimize the memory usage.

 Figure 85: Build Region set to Command, 3D Region Manager editor

• Command: Builds a 3DRegion object from the specified command. The 
command defines the region coordinates using pairs of longitude and latitude 
values. The command format is as follows:

<3DRegionContainerName>: Long1,Lat1 Long2,Lat2...
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 Figure 86: Build Region set to Region Id, 3D Region Manager editor

• Region ID: Enables the user to show a specific region by region ID after having 
prepared the chache files.
• Region Id: Sets the region’s ID for the required region.

• Clear and Build: Deletes all previously built objects and rebuilds the regions 
according to the current settings.

• Add To Existing: Builds the new objects without deleting the old 3D Region 
objects from the hierarchy.

• Clear Target Tree: Removes all objects built by the plugin from the Viz scene 
hierarchy.

12.14 3D Roads

The plugin can be found in the following folders:
• Viz Artist 2: Object -> Built in.
• Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

 Figure 87: 3D Roads example

This section contains information on the following topics:
• Plugin Description

12.14.1 Plugin Description
The plugin has three different plugin editor views; Data, Width and Outline.
134 Chapter 12: Maps Plugins



The Data parameters editor defines what type of roads will be drawn by the 
selected 3DRoads object. Select one or more types of roads to be displayed, using 
the plugin graphic properties.

The Width parameters editor defines the width of the roads drawn by the plugin.

The Outline parameters editor defines the objects outline properties and 
behavior.

This section contains information on the following topics:
• Data
• Width
• Outline

Data

 Figure 88: Data, 3D Roads editor

• Freeways/Motorways, Primary, Main, Secondary and Other Roads: When 
enabled (On), the plugin will draw roads rated according to the selection in the 
loaded roads data.

• Major and Other Railways: When enabled (On), the plugin will draw railways 
rated according to the selection in the loaded railways data.

• Wireframe: Displays the road as wireframe.
• Height Offset: Offsets the borders from the map (on the fly).
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Width

 Figure 89: Fixed width, 3D Roads editor

• Width: Selects how the road width will be calculated.
• Fixed (Pixels): When set to Fixed the road will maintain a fixed width during 

camera zoom movements. Available options are Width (pixels) and Fade Edge 
(%).
• Width (Pixels): Sets the width of the roads in number of pixels. 
• Fade Edge (%): Sets the percentage of softness applied to the road edges. 

 Figure 90: Scaling width, 3D Roads editor

• Scaling: When set to Scaling the road width will vary according to the camera 
zoom movements.
• Width (Meters): Sets the physical road width (in Meters). This value is 

translated into drawn pixels according to the camera zoom position and the 
size of the map.

• Minimum Width (Pixels): Sets the minimal size that the roads will be drawn. 
If the calculated road size in pixels is lower than the minimum width, the 
road will not be drawn.

• Maximum Width (Pixels): Sets the maximal size that the roads will be drawn. 
If the calculated road size in pixels is higher than the maximum width, the 
road width will be set to the maximum width.
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• Minimum Draw Width (Pixels): Sets the minimal size that the roads will be 
drawn. When zooming into an area, this will be the point where the roads 
begin to fade in and be drawn over the map.

• Fade Edge (%): Sets the percentage of softness applied to the road edges. 

 Figure 91: Fixed width, 3D Roads editor

• Fixed (mm): When set to Fixed (mm) the road will maintain a fixed width 
during camera zoom movements. Available options are Width (millimeters) 
and Fade Edge (%).
• Width: Sets the width of the roads in number of millimeters. 
• Fade Edge (%): Sets the percentage of softness applied to the road edges. 

Outline

 Figure 92: Outline, 3D Roads editor

• Outline: Selects one of the options for adding outline to the roads. Available 
options are None, Master, Slave and Stand Alone. 

• None: No outline will be added to the roads drawn by the plugin. 
• Master: Sets the plugin as the master plugin for outline behavior. Other 3D 

Roads plugins can be set as clients of this plugin. The same outline attributes 
will be applied to roads drawn by the master plugin and by all other slave 
plugins. When selected, available additional parameters are Outline Width (%), 
Outline Fade (%) and Outline Color.
• Outline Width (%): Sets the width of the outline, as a percentage of the road 

width, where 0% is the road width. 
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• Outline Fade (%): Sets the percentage of softness applied to the outline 
edges.

• Outline Color: Sets the color of the outline and the alpha value of the 
outline.

• Slave: Draws the outline according to the defined outline in the master plugin 
above it in the scene hierarchy. All other parameters will be disabled, 
displaying the master’s values.

• Stand Alone: Defines the outline parameters for the roads drawn by this 3D 
Roads plugin only. When selected, available additional parameters are Outline 
Width (%), Outline Fade (%) and Outline Color.
• Outline Width (%): Sets the width of the outline, as a percentage of the road 

width, where 0% is the road width. 
• Outline Fade (%): Sets the percentage of softness applied to the outline 

edges.
• Outline Color: Sets the color of the outline and the alpha value of the 

outline.

Note: The hierarchy structure is important when using the master/slave outline 
configuration. The master plugin should always reside as the first container in the 
group of 3D Roads containers. An Expert plugin should be added to the map (above 
the 3D Roads containers) and Z-Buffer Draw should be set to OFF.

Note: Road data should be loaded (using the CWM Client plugin) before working on 
roads design.

12.15 3D Road Manager

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Maps-Man.
• Viz Artist 3: Built Ins ->Function-> Maps-Man.

The 3DRoadManager plugin is used for creating 3D Roads objects. The plugin 
uses a shape file design to create roads according to the defined settings.

This section contains information on the following topics:
• Plugin Description

12.15.1 Plugin Description
• Roads Mode: Applies one set of road design for all roads (Global), or uses a 

design per CWMClient (Design).
• Design: Sets the doards design container that is usd for building border data 

from a shape file. The design container should be built with a 3DBorder object 
and a material. No special naming convention is required.
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• Target: Defines the container to be used as the parent container for the road 
designes. Me builds the 3DRoads objects under the current container (holding 
the 3DRoads Manager plugin). Next builds the 3DRoads objects under the 
next container (next container in the tree and at the same level as the 
3DBorderManager container). Down builds the 3DRoads objects under the first 
child container. Container builds the 3DRoads objects under the container 
dragged into the Target container place holder.

• Target Container: Specifies the container that will hold all the 3DBorder 
objects.

• Source: Select street/road source. Available options are; Viz World Maps Editor 
(WME) using the CWM client plugin to connnect to the map server, or from a 
shape file that contains street data.
• Select Streets: Opens Viz World Maps Editor (WME).

• Shape File: Defines a path to the shape file (*.shp), containing the border 
definitions. Shape files are bought from vendors specialized in Geographic 
Information System (GIS) and holds the actual shape data; polygons, splines, 
and others. Note that shape files must be stored in individual folders.
• Sort Roads By: Sets the loaded roads from the shape file in a category.
• Category enables the user to select one predefined category of street data. 

Available Road Types are Freeways, Primary, Main, Secondary and Other.
• Advanced splits the data into different categories using specific string 

types. Road Type Column specifies a column name that holds each road 
category. Freeways/Motorways, Primary Roads, Main Roads, Secondary 
Roads and Other Roads specify what string in the database file (*.dbf) that 
matches the road type.

• Simplify Threshold: Sets the detail reduction factor for the shape of the roads.
• Persistent Roads: Defines if the roads data is removed from Viz memory when 

the scene is closed or not.
• Sort Roads By: Defines which road type will be associated to the created 

objects. If Advanced is selected, additional parameters will be enabled 
allowing the configuration of road types according to the data associated to 
the shape file.

 Figure 93: Category, 3D Road Manager editor

• Category: Enables the selection of road types. Available options are: 
Freeways, Primary Main, Secondary, Other.
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 Figure 94: Category, 3D Road Manager editor

• Advanced: Sets parameters according to the data in the files associated with 
the shape file. Defines the road type column and the specific road type Id in 
the file.

• Rebuild All: Rebuilds all data. If Roads mode is set to Design, 3DRoads objects 
will be created from design. If Roads mdoe is set to Global, global 3DRoads 
renderers will render built data.

• Clean All: Cleans Target container from sub containers.

12.16 Atlas

The plugin can be found in the following folders:
• Viz Artist 2: Object -> Built in.
• Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The Atlas plugin is used for displaying Microsoft satellite imagery. This object 
plugin is used with a navigator plugin, enabling interactive navigation to any 
location on Earth. The plugin can be used to display imagery for a Navigator 
animation (Hops), while creating the required image tiles for a smooth and 
complete camera movement.

This section contains information on the following topics:
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• Plugin Description

12.16.1 Plugin Description
The plugin has two plugin editor tabs; General and Advanced.

This section contains information on the following topics:
• General
• Advanced

General

 Figure 95: Atlas plugin General tab

The General tab is used to define imagery parameters.

• Data Source: Defines if the Atlas plugin will use data from Microsoft Bing 
(requires an internet connection) or display data from a cmr file. If Bing is 
selected, select one of the data types to be used:
• Satellite: Sets the plugin to use satellite images.
• Map: Sets the plugin to use road and border maps with labels (names of 

places)
• Combined: Sets the plugin to use satellite images with roads, borders and 

labels imposed over the satellite image.
If CMR is selected, set the path to the CMR file. The CMR Data Status field will 
indicate if the file was loaded correctly or not.

• Use Base Map: this option is used when working with a base map above the 
Atlas container, and the base map is projected. Microsoft imagery is 
unprojected, so in order to have the images positioned correctly over the map 
set this parameter to On.

• Map Size: Defines the size of the Atlas image.

• Mode: Defines the mode of retreiving the tiles from Microsoft server. When set 
to Serial, and new image tiles are required, Atlas plugin will send a request to 
the server and wait for a reply. Only after the reply another tile will be 
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requested, and so on. During the time that the plugin as waiting for a replay 
the UI is locked the user cannot perform other operations. When set to 
Multithreaded, the images are requested by a thread of the plugin and the UI 
is not locked.

• Fade Time: Defines the duration of the transition between tile resolutions 
when zooming in/out of the image.

• Texture Compression: Select one of the required compression modes for the 
images.

• Quality: Select the quality of the images requested from the server.

Advanced

 Figure 96: Atlas plugin Advanced tab

The Advaned tab is used for configuring connection and operation parameters.

• Temp Folder: Defines a specific cache folder for the retreived imagery.
• Requests per Frame: Defines the maximal image requests from the server in a 

frame.
• Layers: Defines the number of images (with different resolution) per one area. 
• Stop Support Margins: When set to ON, additional image tiles surrounding the 

displayed area will be retreived, to enable immediate display of high 
resolution images when the user moves the image.

• Use Proxy: When set to ON, proxy configuration parameters will be enabled. 
Use this option when working an a network with proxy:
• IP: Proxy server IP number
• Socket: Proxy socket number
• Username/Password: Sets the username and password.
• Set Proxy: Applies the proxy settings.

• Warmup: Prepares all image tiles for a defined animation. once tiles are in the 
cache folder, the animation will play smoothly.
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12.17 Curious 3D Terrain

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Shader (button) -> Maps.
• Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The C3DTerrain plugin is used for displaying terrain objects. The terrain is 
retrieved from the Viz World Server (WoS) when a CWM Client plugin is added to a 
C3DTerrain object. When the CWM Client plugin is added to the C3DTerrain 
plugin, terrain tessellation parameters will be enabled in the Miscellaneous tab of 
the CWM Client plugin.

This section contains information on the following topics:
• Plugin Description

12.17.1 Plugin Description
The plugin has three different plugin editor views; Terrain, Pyramid and 
Advanced.

This section contains information on the following topics:
• Terrain
• Pyramid
• Advanced

Terrain

 Figure 97: Terrain, Curious 3D Terrain editor

• Terrain Mode: Defines the data source for the terrain height:
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• File: Load height from terrain file (*.c3d).
• Image: Use a Vizimage to create the terrain data.
• Memory: Terrain data may be accessible from three different sources: from 

a terrain file on disk (file), from server by using the CWMClient (memory) or 
from server using the CWMClient but then saved to the Viz Graphic Hub as 
an image (Image).

• Terrain File Name: Defines a path to the file to be loaded. 

Note: The Terrain File Name parameter will be disabled when a CWM Client plugin 
is attached to the Atlas container. 

• Height Scale Mode: Sets the height scaling option for the terrain:
• Manual: Sets the height scale manually by changing the Height Scale 

parameter. When selected, additional parameters will be enabled:
• Height Scale: Sets the scaling value for the terrain elevation. Using a low 

value will flatten the terrain surface.
• Soft: Sets the terrain surface to be softened by interpolating points over the 

terrain. This option prevents the sharp edges over the terrain surface.
• Normal: Uses the same terrain elevation values received from the server.
• Exaggerate: Applies a large scaling factor to the terrain height differences, 

exaggerating the terrain surface.
• Absolute: The terrain height will not take into account the map size. Setting 

Height Scale Mode to Absoulute may therefore be needed for the terrain 
tiling, or else the tiles might not connect properly (due to height 
differences).

• Sampling Resolution: Defines the number of points that will be used to 
calculate the terrain. The higher the sampling resolution, the less detail will be 
shown. When Pyramid mode is enabled (On), this parameter will be disabled 

• Globe: When enabled (On), the terrain will be drawn as part of a globe and the 
Globe Radius parameter will be enabled.

• Globe Radius: Sets the size of the globe used for drawing the terrain. 

Note: The Globe and the Globe Radius parameters will be disabled if Use Base Map is 
enabled (On).

• Use Base Map: Defines the geographical referencing of the terrain. If Use Base 
Map is enabled (On), the terrain will move to its geographic location on the 
base map, and the Base Container parameter will be enabled.
• Base Container: If empty and Use Base Map is enabled (On), the first map 

above the C3Dterrain container in the hierarchy will be used as the base 
map. To use a specific map as the base map, drag a map container to the 
Base Container place holder. If Use Base Map is disabled (Off), the Globe 
parameter will be enabled and the terrain will be drawn as part of a globe. 
Set the Globe Radius to modify the terrain size and curve.

• Delta Z: Sets the Z axis offset for the terrain (mainly used when using the base 
map).

• Freeze Terrain: Saves the terrain image and data as Viz images for faster 
loading and for archiving.
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Pyramid

 Figure 98: Pyramid, Curious 3D Terrain editor

A Pyramid in WoC is a set of map textures in different resolutions used for 
zooming into a defined area. When the camera is far from the map, a low 
resolution map texture is used (covering a wide area). As the camera zooms into 
the map, it will zoom into an area with higher resolution texture, until the final 
map, with the highest resolution, is used. In order to enable the Atlas’s Pyramid 
parameters a CWM Client plugin must be attached to its container. Note that this 
will disable Atlas’s Terrain File Name parameter. See the Terrain editor view.

• Pyramid: This parameter defines if a pyramid of map textures will be created 
for the terrain area. When enabled (On) the Max Height and 3D Levels 
parameters will be enabled.
• Max Height: Defines the number of textures that will be created.
• 3D Levels: Defines the number of terrain objects that will be created.

• Blend Textures: Defines if the edges of the maps will be soft, blending into the 
larger map of the pyramid. When enabled (On), the edges will be softened and 
the Blend Amount parameter will be enabled.
• Blend Amount: Defines the amount of softness added to the map edges.

• Rebuild Pyramid: Builds the pyramid levels.

Note: The parameter Rebuid Pyramid is enabled only if Pyramid is enabled (On) and it 
will be visible in all tabs.
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Advanced

 Figure 99: Advanced, Curious 3D Terrain editor

• Wireframe: Displays the terrain as wireframe.
• Sides Smoothing: When enabled (On), the edges of the terrain will be drawn as 

flat lines (height is zero). This option is useful when using the terrain object 
over the base map. When enabled (On), additional parameters are enabled:
• Sides Smoothing Factor: Defines the width of the area, close to the edges, 

that will be interpolated to create the smooth transition from terrain info to 
a flat edge.

• Uniform Smoothing: Applies smoothing for all sides. Enabling Uniform 
smoothing (On), will set smoothing for all sides, and hide the individual 
parameters. Available individual parameters are; Left, Right, Top and 
Bottom smoothing.

• Texture Compression: Sets the compression level for the texture (DTX5 is the 
highest compression level; hence, less texture quality).

• Terrain Status: Displays the terrain object status. If the terrain object was 
rebuilt successfully, the indicator will dispaly OK, otherwise, the indicator will 
be display Not Rebuilt.

12.18 Curious 3D Terrain Shader

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Shader (button) -> Maps.
• Viz Artist 3: Built Ins -> Shader -> Maps.

This shader has no configuration and is added automatically when using the Atlas 
plugin.
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12.19 Center Map 

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The Center Map plugin is used, with map objects, for keeping a point on the map 
in the center of the map object. The map is moved while the defined point 
remains centered. With a Flat map, the map is moved, but with a Globe map the 
globe is rotated. See also Map Tiler for more information on Flat and Globe maps.

Note: The Center Map plugin should only be applied to map objects.

This section contains information on the following topics:
• Plugin Description

12.19.1 Plugin Description
 Figure 100: User, Center Map editor

• Position: Defines how the map will be centered:
• User: Enables the user to manually define a center point by setting Map 

Center Longitude and Map Center Latitude values.

 Figure 101: WPosition, Center Map editor

• WPosition: Centers the map at the location of a WPosition container dragged 
into the Remote Container place holder.
• Navigator: Centers the map at the location of a Navigator container dragged 

into the Remote Container place holder.
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• WPoint: Centers the map at the location of a WPoint container dragged into 
the Remote Container place holder.

• Map: Centers the map at the center of a dragged map into the Remote 
Container map. 

• Local Scale: Sets the scale parameter for the map.

12.20 Color Matrix

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Shader (button) -> Maps.
• Viz Artist 3: Built Ins -> Shader -> Maps.

Color Matrix is used to perform automatic color correction on tiles when 
performing zoom operations on for example satellite imagery.

Zooming can be a problem (e.g. when zooming to street levels) as the tiles often 
shift color from one level to another. Tiles also change color depending on the 
size of the tile(s) used. The result will often be that the tiles look like stamps.

The color correction is done using Pyramid Control which assigns the Color Matrix 
shader plugin to fix the colors.

This section contains information on the following topics:
• Plugin Description
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12.20.1 Plugin Description
 Figure 102: Manual, Color Matrix editor

• Mode: Sets the color matrix mode. When set to Fading, only fading of texture 
edges are active. When set to Manual, all parameters of the plugin can be 
managed manually. When set to Slave, all parameters of the plugin is managed 
by other plugins.

• Translate R,G,B: Shifts the corresponding color component.
• Scale R,G,B: Shifts the corresponding color component.
• Fade Factor: Sets the fade factor for the texture edges.
• Keying Mode: Sets the keying mode.

• None: Color keying is disabled.
• Full: All colors are keyed out.
• Color: All colors in the range (Key Color - Key Color Threshold, Key Color + 

Key Color Threshold will be keyed out.
• Alpha: All colors with the 0.0 in the alpha channel will be keyed out.
• Color and Alpha: All colors in the range (Key Color - Key Color Threshold, 

Key Color + Key Color Threshold and colors with the 0.0 in the alpha 
channel will be keyed out.

• Color or Alpha: All colors in the range (Key Color - Key Color Threshold, Key 
Color + Key Color Threshold or colors with the 0.0 in the alpha channel will 
be keyed out.

• Key Color: Sets the key color used in Keying Mode.
• Key Color Threshold: Sets the key color threshold use in Keying Mode.
• Key Color Attack: Smoothens the key color edges.
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12.21 CWM Client

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The CWMClient plugin is the main plugin in Viz World Client (WoC). The 
CWMClient plugin launches the Viz World Maps Editor (WME) and retrieves the 
map from the Viz World Server (WoS) after the user applied the changes to the 
map in WME.

Note: The plugin uses the VizMapsManager.dll to connect to the Viz World Server 
machine configured in Viz Config page.

This section contains information on the following topics:
• Plugin Description

12.21.1 Plugin Description
The CWM Client plugin has five different plugin editor views; Texture, Labels, 3D 
Objects, Miscellaneous and CMR. In addition it has two default buttons that 
applies to the plugin as a whole.
• Viz World Maps Editor (WME): Opens the WME. WME connects to Viz World 

Server that is defined in Viz Config, and retrieves the current map or opens the 
defined default project if no map exists (fresh plugin instance).

• Refresh Map: Re-draws the map and refreshes the related Viz objects using 
Viz World Client (WoC)plugins in the scene hierarchy. For example if a label 
design has been changed in Viz Artist, clicking Refresh Map will redraw the 
map with the new label design without opening WME.

• Refresh Map (Force New): Re-creates the map on the server and saves it to the 
cache. This operation will force the map creation, even if the map exists in the 
cache folder.

This section contains information on the following topics:
• Texture
• Labels
• 3D Objects
• Miscellaneous
• CMR
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Texture

 Figure 103: Texture, CWM Client editor

The texture section defines the geo map image parameters:

• Lock Aspect Ratio: Effects texture height and texture width parameters. When 
enabled (On) any change in the texture height or width will affect both 
parameters. When disabled (Off), each parameter is controlled separately.
• Texture Size: Presets for texture sizes.
• Auto Adjust To Globe - If texture size is other than manual, this parameter 

defines if the texture size will be modified when mapped on a globe. This 
option is used when displaying maps that are close to Earth’s poles.

• Texture Width: Defines the number of pixels in the map width. When aspect 
ratio is locked, changing the texture width will automatically change the 
Texture Height parameter.

• Texture Height: Defines the number of pixels in the map height. When 
aspect ratio is locked, changing the texture width will automatically change 
the Texture Width parameter.

• Texture Compression: Sets the compression level for the texture (DTX5 is the 
highest compression level, i.e. less texture quality).

• Texture Quality: If set to Linear it will use the same image resolution in the 
entire zoom range, or when set to Mipmap it will change resolution according 
to the distance from the image (managed automatically in Viz Artist).
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Labels

 Figure 104: Image labels, CWM Client editor

• 3D Designs & Holder: Defines the labels usage and behavior over the map, and 
has three available options; Image, Viz and Compatibility.
• Disabled: Labels produced by the Viz World Server will be displayed as part 

of the map texture.
• Local: Requires you to manually define the 3D Designs & Holder path (e.g. 

On Map Designs: Vizrt/VizCuriousMapsClient/MapBuilder/Regions/)
• Global: Enables you to use a global design defined by the 3D Map Setting 

scene plugin.

IMPORTANT! Global labels will not work with on screen labels so you will still need to 
configure them (if needed).

 Figure 105: Viz Labels, CWM Client editor

• Create Labels: Select All to build all labels defined in WoC. Select Visible to 
build only labels that are shown on the selected map.

• Labels Type: Defines the source of the label designs. Available options are 
Dynamic and Scene. Selecting Viz-DB or Scene defines where the label designs 
are stored.
• Dynamic: Dynamically creates new labels based on label designs created in 

the scene itself or fetched from the Viz Graphic Hub (Viz DB). All designs are 
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referenced by the On-Map Designs placeholder. When selecting labels in the 
Viz World Maps Editor (WME) all your labels will be dynamically added 
underneath the CWMClient’s container and receive the correct label type 
(provided it is defined by your label design). Note that this approach does 
not allow you to use control plugins. As the number of labels are dynamic 
this approach does not allow you to use control plugins.

• Static: Unlike the Dynamic label type, Static will not create new labels 
underneath the CWMClient’s container, but will instead use the number of 
labels already defined by the designer (achieved by by adding copies of the 
label designs as sub containers of the CWMClient’s container). As the 
number of labels and label types are static this approach allows you to use 
control plugins.

• Viz-DB: Label source is a merged object from the Viz objects library, 
containing the label designs.

• Scene: Label source is a group container in the scene hierarchy, containing 
the label designs.

• On Map Designs: Defines the source of the labels that are displayed on the 
map. When Viz DB (Viz Graphic Hub) is selected, define the path to a merged 
object, containing the label designs, in Viz object library. When Scene is 
selected, drag a group container with the label designs to the container place 
holder.

• On Screen Designs: Defines the source of the labels that are displayed on a 
plane in front of the screen. When Viz DB is selected, define the path to a 
merged object, containing the label designs, in Viz object library. When Scene 
is selected, drag a group container with the label designs to the container 
place holder.

• On Map Holder: This parameter is a container used for grouping all the 
generated labels on the map. When a map with labels is selected, the plugin 
will duplicate the label designs and create the labels. The duplicated labels will 
be placed under the On Map Holder container.

• On Screen Holder: This parameter is a container used for grouping all the on 
screen labels (labels that are not geo-referenced) used in the map. When a 
map with on screen labels is used and Viz is selected, the on screen label 
designs will be copied to the holder container and the label information will be 
sent to the copied designs.

Note: Back slash (\) in label names will be treated as a new line (carriage return).

3D Objects
The 3D Objects section defines 3D properties of objects on the map, other than 
labels (regions, roads and so on).
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 Figure 106: 3D Objects and Regions, CWM Client editor

• 3D Designs & Holder: Defines if the regions will be part of the received texture 
or 3D objects. When set to Disabled, regions will be displayed as part of the 
texture. When set to Local the Viz-DB and Scene parameters are made 
available. When set to Global, the global region designs and holder will be 
used to create the O Map 3D region objects. On Screen parameters will be 
enabled to define the on screen region designs and holder.

Note: The global designs and holder are defined in the 3D Map Setting scene plugin.

• Source: Sets the source for region designs. Available options are Viz-DB and 
Scene.
• Viz-DB: Sets region source to be a merged object from the Viz objects 

library, containing the region designs.
• Scene: Sets region source to be a group container in the scene hierarchy, 

containing the region designs. 
• On Map Designs: Defines the source of the 3D Region objects that are 

displayed on the map. When Viz DB is selected, define the path to a merged 
object, containing the region designs, in Viz object library. When Scene is 
selected, drag a group container with the region designs to the container 
place holder.

• On Screen Designs: Defines the source of the 3D Region objects that are 
displayed on a plane in front of the screen. When Viz DB is selected, define the 
path to a merged object, containing the region designs, in Viz object library. 
When Scene is selected, drag a group container with the region designs to the 
container place holder.

• On Map Holder: This parameter is a container used for grouping all the 
generated 3DRegion objects on the map. When a map with regions is selected, 
the plugin will duplicate the region designs and create the 3D Region objects. 
The duplicated regions will be placed under the On Map Holder container.

• On Screen Holder: This parameter is a container used for grouping all the on 
screen regions (regions that are not geo-referenced) used in the map. When a 
map with on screen regions is used and Viz is selected, the on screen region 
designs will be copied to the holder container and the region information will 
be sent to the copied designs.
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 Figure 107: 3D Objects and Borders, CWM Client editor

• Map 3D Borders: Defines if the border line will be part of the received texture 
or drawn as a 3D object. When set to Disabled, borders will be displayed as 
part of the map texture. When set to Local the Viz-DB and Scene parameters 
are made available and the shapes added in the WME will be drawn as a 3D 
object by Viz. When set to Global, the global border designs and holder will 
be used to create the 3D border objects.

Note: The global designs and holder are defined in the 3D Map Setting scene plugin.

• Visible Filter: set the filter level for border details. If None is selected, all 
border data is drawn. If Region is selected, Sub Region data will not be drawn. 
If Country is selected, region and sub-region borders will not be drawn.

• Source: Sets the source for the border designs.
• Viz-DB: Sets the border source to be a merged object from Viz objects 

library, containing the border designs.
• Scene: Sets the border source to be a group container in the scene 

hierarchy, containing the border designs. 
• On Map Designs: Defines the source of the 3D Line objects that are displayed 

on the map. When Viz DB is selected, define the path to a merged object, 
containing the border designs, in Viz object library. When Scene is selected, 
drag a group container with the border designs to the container place holder.

• On Map Holder: This parameter is a container used for grouping all the 
generated 3DBorder objects on the map. When a map with borders is selected, 
the plugin will duplicate the border designs and create the 3D Line objects. 
The duplicated borders will be placed under the On Map Holder container.
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 Figure 108: 3D Objects and Shapes, CWM Client editor

• Map 3D Shapes: Defines if the shapes will be part of the received texture or 
drawn as a 3D object. When set to Disabled, shapes will be displayed as part of 
the map texture. When set to Enabled the Viz-DB and Scene parameters are 
made available and the shapes added in the WME will be drawn as a 3D object 
by Viz.When set to Global, the global shape designs and holder will be used 
to create the 3D shape objects.

Note: The global designs and holder are defined in the 3D Map Setting scene plugin.

• Source: Sets the source for the shape designs.
• Viz-DB: Sets the shape source to be a merged object from Viz objects 

library, containing the shape designs.
• Scene: Sets the shape source to be a group container in the scene hierarchy, 

containing the shape designs. 
• On Map Line Designs: Enables the user to add vector line data to the map. 

Either by using the draw option in the WME (Add Shape), or from selecting an 
existing line data (e.g. street).

• On Map Area Designs: Vector area designs. This option has support for the 
area draw option in the WME.

• On Map Designs: Defines the source of the 3D Region objects that are 
displayed on the map. When Viz DB is selected, define the path to a merged 
object, containing the shape designs, in Viz object library. When Scene is 
selected, drag a group container with the shape designs to the container place 
holder.

• On Map Holder: This parameter is a container used for grouping all the 
generated 3DShape objects on the map. When a map with shapes is selected, 
the plugin will duplicate the shape designs and create the 3D Region objects. 
The duplicated shapes will be placed under the On Map Holder container.
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 Figure 109: 3D Objects and Roads, CWM Client editor

• 3D Roads: Defines if the road data will be drawn on the map and the way the 
roads will be drawn. Available options are None, Crop To Map and All.
• None: The roads data will not be available to be drawn on the map.
• Crop To Map: Enables the Visibility Filter and Visibility Factor (%) settings, 

limiting the roads data. 
• All: Loads the selected road data.
• Labels Only: only the road labels will be drawn.

• Visibility Filter: Sets the highest level of road type that will be cropped. 
Available options are Freeway, Primary, Main, Secondary and Other.
• Freeway: Crops all roads rated as freeways and lower (that is all roads) using 

the Visibility Factor.
• Primary: Crops all roads rated as primary roads and lower (that is primary, 

main, secondary and other) using the Visibility Factor.
• Main: Crops all roads rated as main roads and lower (that is main, secondary 

and other) using the Visibility Factor.
• Secondary: Crops all roads rated as secondary roads and lower (that is 

secondary and other) using the Visibility Factor.
• Other: Crops all roads rated as other roads (that is none of the above) using 

the Visibility Factor.
• Visibility Factor (%): Defines the cropping area of the roads on the map. 100% 

means the roads will be cropped at the map edges and cover the entire map 
area. A lower value will cause the selected road types in the Visibility Filter to 
be cropped (evenly from the map edges).

• Simplify Threshold (Meters): Applies a simplifying algorithm on road data. The 
number represents the buggest allowed error.

• Ignore Filter: Disables creation of roads that are lower or equal to the 
selection.

• Roads Mode: Applies one set of road design for all roads (Global), or uses a 
design per CWMClient (Design).

• Source: Sets the source for road designs. Available options are Viz-DB and 
Scene.
• Viz-DB: Sets road source to be a merged object from Viz objects library, 

containing the road designs.
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• Scene: Sets road source to be a group container in the scene hierarchy, 
containing the road designs. 

• On-Map Designs: Defines the source of the 3D Roads objects that are 
displayed on the map. When Viz-DB is selected, define the path to a merged 
object, containing the road designs, in Viz object library. When Scene is 
selected, drag a group container with the road designs to the container place 
holder.

• On-Screen Designs: Defines the source of the 3D Roads objects that are 
displayed on a plane in front of the screen. When Viz-DB is selected, define 
the path to a merged object, containing the road designs, in Viz object library. 
When Scene is selected, drag a group container with the road designs to the 
container place holder.

• On Map Holder: This parameter is a container used for grouping all the 
generated 3D Roads objects on the map. When a map with roads is selected, 
the plugin will duplicate the road designs and create the 3D Roads objects. 
The duplicated roads will be placed under the On Map Holder container.

• On Screen Holder: This parameter is a container used for grouping all the on 
screen roads (roads that are not geo-referenced) used in the map. When a 
map with on screen roads is used and Viz-DB is selected, the on screen road 
designs will be copied to the holder container and the road information will be 
sent to the copied designs.

 Figure 110: 3D Objects and Advanced, CWM Client editor

• Create Regions: Defines if all the selected regions will be created (when using 
3D regions) or only the regions that are visible on the selected map. 

• Sort Regions: Defines how the labels and 3D Objects will be duplicated in the 
scene tree.
• No: Creates the duplicated labels and 3D objects in the scene tree grouped 

by geographic levels that is for each country, first the country, then the 
regions, then the sub regions, and so on.

• Ascending: Creates the duplicated labels and 3D objects created in the 
scene tree sorted by ascending geographic levels, that is first the sub 
regions, then the regions, then the country container.

• Descending: Creates the duplicated labels and 3D objects in the scene tree 
sorted by descending geographic levels, that is first the sub regions, then 
the regions, then the country container.

• Copy Map To Region: Sets if a map of the region will be applied to the 3D 
Region object.
158 Chapter 12: Maps Plugins



• Auto Borders: Defines if borders will be added automatically to the map and 
the level of the borders:
• Off: No borders will be added.
• Highest: Draws country borders for the selected area (or region borders if 

only a region was selected).
• Intermediate: Draws region borders (or sub-regions if only a region was 

selected).
• Lowest: Draws sub-region borders.

Miscellaneous

 Figure 111: Miscellaneous, CWM Client editor.

The Miscellaneous section includes additional general parameters of the map.
• WME Aspect– Defines the aspect of the map in the WME window:

• Image: When enabled, the aspect is set by the texture size defined in the 
texture screen of the CWM Client plugin.

• User: When enabled, the user can manually set the aspect. When selected, 
the Aspect parameter will be enabled. The aspect is modified by changing 
the aspect value.

• Camera: Sets the aspect to be the same as the current camera in use. 
Selecting this option will therefore open the WME in the same aspect as the 
current camera.

• Auto: When enabled, the plugin will look for a Navigator plugin in the 
hierarchy, above the CWM Client plugin. If a Navigator is found the camera 
aspect will be used. If the Navigator plugin was not found, the image aspect 
will be used.
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 Figure 112: Freeze enabled for Miscellaneous, CWM Client editor.

• Freeze: When enabled (On), the map retrieved from the server will be saved as 
an image in the Viz image library and used as a static geo-referenced image. 
All map dynamic parameters will be hidden.

• Trio Mode: When set to Off, the plugin will request the map from the server or 
cache when the scene is loading. If Trio mode is set ON, the scene will load 
without requesting a map since Viz Trio (or other external application) will 
send the parameters for a map to use. This option saves time during 
initialization of scenes using a dynamic map.

• Is Linked: When the Is Linked parameter is set, a CWMClient (slave) is 
controlled by another CWMClient (master). To control another CWMClient, 
drag and drop a container with a CWMClient (slave) plugin onto the CWMClient 
(master) plugins’ Linked Map placeholder (see next parameter).

• Linked Map: When set, this parameter is a container placeholder that defines 
the map that will be linked to the current map. The linked map is another CWM 
Client container that will receive the same map as the map selected from the 
WME.

• Linked Map Size: Defines the size of the linked map as a percentage from the 
main map, that is if 50% is defined the linked map will show half of the area 
defined in the main map.

• Terrain Tessellation Locked: Appears when a C3DTerrain plugin is combined 
with the CWMClient plugin. 
• Tessellation is the terrain resolution, which is the number of polygons used 

to build the terrain object. The higher the tessellation, the more detailed the 
terrain will be. Use the Width Tessellation and Height Tessellation 
parameters to fine tune the quality versus the performance of the scene.

• When set to On, only the Width Tessellation parameter can be changed; 
hence, the setting will apply for both Width and Height. 

• When set to Off, the parameters can be set individually.
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CMR

 Figure 113: CMR, CWM Client editor.

The CMR (Curious Multi Resolution) section includes Curious Maps Terrain 
configuration options.

• Use CMR: Defines if the map will be generated from a CMR file or from the 
server. When enabled (On) additional parameters are made available, and the 
Viz World Maps Editor (WME) button is disabled.

• CMR: Defines a CMR file to be used as a source for the map.

Note: Most CMR’s requires a valid license.

• Lon: Sets the map longitude.
• Lat: Sets the map Latitude.
• Width (deg): Sets the area width in degrees, kilometers, miles or nautical 

miles.
• Status: Displays the current CMR operation status.
• Get CMR: Retrieves the defined CMR data (of the area defined by Lon, Lat and 

Width parameters).
• Center Longitude Latitude: When clicked, the CMR will be created with the 

longitude and latitude values as the center of the CMR.

Note: The longitude and latitude values must be within the CMR area. If the values 
are not within the CMR area no map will be created.

12.22 Fade Texture

The plugin can be found in the following folders:
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• Viz Artist 2: Function -> Shader (button) -> Texture.
• Viz Artist 3: Built Ins -> Shader -> Texture.

The FadeTexture plugin is used to apply soft edges to a texture and to crop the 
texture.

This section contains information on the following topics:
• Plugin Description

12.22.1 Plugin Description
The plugin has three plugin editor views that enables the different Curve control 
options; Constant, Spline and Uniform. 

This section contains information on the following topics:
• Constant
• Spline
• Uniform

Constant

 Figure 114: Constant curve, Fade Texture editor

Texture edges are controlled separately but no softness is applied to the texture 
edges. 
• Crop Top: Sets the crop value for the top of the texture.
• Crop Bottom: Sets the crop value for the bottom of the texture.
• Crop Left: Sets the crop value from the Left of the texture.
• Crop Right: Sets the crop value for the right of the texture.
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Spline

 Figure 115: Spline curve, Fade Texture editor

Texture edges are controlled separately and a common softness value is applied 
to all edges. 
• Crop Top: Sets the crop value for the top of the texture 
• Crop Bottom: Sets the crop value for the bottom of the texture 
• Crop Left: Sets the crop value for the Left of the texture 
• Crop Right: Sets the crop value for the right of the texture 
• Fade: Sets the softness value for the edges of the texture.

Note: If an edge is not cropped, the softness will affect the edge.

Uniform

 Figure 116: Uniform curve, Fade Texture editor

All texture edges are controlled together with a fixed softness value applied. 
• Uniform Crop: Sets the crop value for all edges of the texture (fixed softness 

will be added to all edges).

12.23 Flat MR

The plugin can be found in the following folders:
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• Viz Artist 2: Object -> Built in.
• Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The FlatMR plugin is used for displaying CMR files over a flat object. The texture 
for the terrain is defined in the file or retrieved from the Bing Maps Platform (when 
licensed).

IMPORTANT! This plugin is included in Viz World Client package for compatibility 
reasons, and is not maintained. It is recommended to use the Atlas and other 
plugins for designing new scenes. 

12.24 GeoImage

The plugin can be found in the following folders:
• Viz Artist 2: Object -> Built in.
• Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The GeoImage plugin is used as a base object with maps to enable geographic 
referencing options. GeoImage is short for Geographical reference Image.

This section contains information on the following topics:
• Plugin Description

12.24.1 Plugin Description
 Figure 117: GeoImage editor

• Use Base Map: Defines the geographical referencing of the GeoImage. If Use 
Base Map is enabled (On), the GeoImage will move to its geographic location 
on the base map and resize accordingly.
• Enabling (On) Use Base Map enables the Base Container parameter. 
• Disabling (Off) Use Base Map enables the Map Size parameter.

• Map Size: Sets the size of the GeoImage geometry.
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 Figure 118: Use Base Map, GeoImage editor

• Base Container: If empty, the first geo-referenced map above the GeoImage 
container in the hierarchy will be used as the base map. To use a specific map 
as the base map, drag a map container to the Base Container place holder.

• Delta Z: Sets a Z offset for the GeoImage geometry.

 Figure 119: Crop Lon/Lat, GeoImage editor

• Crop Mode: Defines if the GeoImage will be cropped:
• None: The map will not be cropped.
• Manual: Allows the user to manually set the crop values for the map: West 

and East sets the Longitude value for the western and eastern edge of the 
GeoImage map. North and South and sets the Latitude value for the 
northern and southern edge of the GeoImage map.

• Base Map: Crops the GeoImage according to the base map, that is, if the 
GeoImage exceeds the base map edges, it will be cropped accordingly. 

• Apply Fade Plugin: When clicked, a Fade Texture plugin will be applied to the 
container.
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12.25 Focus On Map

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps-Adv.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps-Adv.

The FocusOnMap plugin is used to create a single “hop” (high resolution map over 
a large referencing map) without using a navigator plugin and with no animation. 
This plugin is used when creating a large map (reference map) with 3DObjects 
over it (roads, shapes, and so on). It enables the user to display a high resolution 
area of the large map without recreating the 3DObjects when changing the 
displayed area.

This section contains information on the following topics:
• Plugin Description

12.25.1 Plugin Description

The FocusOnMap plugin has three different tabs; Position, Camera and Labels.
• Position: Enables the parameters for the requested map area where the 

Position Source defines the source of the viewed area.
• Camera: Defines the camera parameters such as camera number and minimal 

and maximum distance of the camera fromthe map.
• Labels: Defines label parameters for how labels should be displayed.

This section contains information on the following topics:
• Position
• Camera
• Labels
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Position

 Figure 120: Position, Focus On Map Editor

• Map: Fits the selected map in the FocusOnMap container to the screen 
according to the Fit To Screen By selection.
• Fit To Screen By: Sets the map attribute that will be used to fit the map to 

the screen: Width, Height, Min (the minimal value of the map’s width and 
height), Max (the maximal value of the map’s width and height), Average 
(the average of the map’s width and height).

• Longitude Offset: Sets a longitude offset from the center of the selected 
map

• Latitude Offset: Sets a latitude offset from the center of the selected map
• Distance Offset: Sets a distance offset from the center of the selected map
• Pan: Sets a pan value for the camera.
• Tilt: Sets a tilt value for the camera.

• Absolute: Enables the user to manually set the parameters for the viewed area:
• Longitude: Sets the Longitude of the viewed area (center).
• Latitude: Sets the Latitude of the viewed area (center).
• Distance offset: Sets a fixed distance offset from the selected map.
• Distance: Sets a distance from the map.
• Pan: Sets a pan value for the camera.
• Tilt: Sets a tilt value for the camera.

• 3D Region: The selected map in the FocusOnMap container will be fitted to the 
screen according to the Fit To Screen By selection. 
• Fit To Screen By: Select the 3DRegion attribute that will be used to fit the 

map to the screen: Width, Height, Min (the minimal value of the map’s width 
and height), Max (the maximal value of the map’s width and height), 
Average (the average of the map’s width and height).

• Longitude Offset: Sets a longitude offset from the center of the selected 
3DRegion.

• Latitude Offset: Sets a latitude offset from the center of the selected 
3DRegion.

• Distance Offset: Sets a distance offset from the center of the selected 
3DRegion.

• Pan: Sets a pan value for the camera.
• Tilt: Sets a tilt value for the camera.
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Note: Pan and Tilt parameters will be disabled unless the Pan & Tilt Animation 
parameter in the Navigator plugin is enabled (On).

Camera

 Figure 121: Camera, Focus On Map Editor

• Camera: Defines the camera number that will be affected by the FocusOnMap 
plugin.

• Clipping Plane Control: Defines the selected camera’s clipping plane. Static 
(Viz) draws the objects within the clipping plane values defined in Viz. For Viz 
2.x see Setup->Camera->Camera Clipping Plane. For Viz 3.x see Scene 
Settings->Renderer->Camera Clipping Plane. FocusOnMap adjusts the 
clipping plane values according to the camera position. This is automatically 
done by the Focus On Map plugin based on the Near Distance and Far Distance 
parameters.
• Near distance (%): Defines the minimal distance of the camera from the 

map.
• Far Distance (%): Defines the maximal distance of the camera from the map.

Labels

 Figure 122: Labels, Focus On Map Editor

• Labels: Defines how the labels will be displayed:
• Overlay: Labels are displayed as a layer on the screen not affected by the 

camera movement when a new area is selected.
• On Map: Labels are displayed on the map, moving with the map as the 

selected area is changed.
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• Label Camera: Defines the camera number used for displaying the on screen 
labels.

• Get Map: When clicked, the camera will jump to the defined area.

12.26 Geo Text

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps.

 Figure 123: GeoText example.

The GeoText plugin is used to display the longitude and latitude values received 
from a variety of sources. The geographic data is displayed in two text objects (or 
one) defined by the  longitude and latitude containers.

This section contains information on the following topics:
• Plugin Description

12.26.1 Plugin Description

The Source defines the source of the geographic data that will be displayed in the 
definedcontainers under the Containers tab.
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• User: Sets the value manually in the Compass, Longitue and Latitude 
parameters for the position and range values. The Compass, Longitude and 
Latitude parameters will be enabled only when Position is set to User.

• WPosition: The defined Containers display the values recieved from the World 
Position plugin on the same container as the GeoText plugin.

• Navigator: The GeoText plugin receives the geographic data from the 
Navigator plugin in the scene. The received data from the Navigator plugin is 
the location of the center of the Navigator point of view and the differance 
between the edges of the current Navigator map. The GeoText plugin also has 
placeholders (all requiring a running Viz World server) for defining the 
administration levels:
• Country: Gets the current Country
• Admin 1: Gets the current administration level 1 (e.g. Region)
• Admin 2: Gets the current administration level 2 (e.g. Town)
• Location: Gets the lowest administration level (e.g. Place)

• WPoint: The defined Containers display the value recieved from the WPoint 
plugin on the same container as the GeoText plugin.

Note: WPoint is a Viz Weather plugin which is not covered in this manual.

• Map: When placed on a map container, the GeoText plugin will send the center 
of the map data to the Longitude and Latitude containers and the differance 
between the edges of the map to the range containers.Line: When placed on a 
3DLine container, the GeoText plugin will send the center of the line data to 
the defined containers in the Containers tab.

There are three parameter tabs for each option in the position pareameter:

 Figure 124: Source set to User and Position, Focus On Map editor

• Position: Defines the position text format. Select the required format from the 
Degrees Format list.
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 Figure 125: Source set to User and Range, Focus On Map editor

• Range: Defines the range text format. Select the units for the displayed values 
and select the required format from the Degrees Format list. If Kilometers, 
Miles or Nautical Miles are selected, Dot or Comma can be selected as a 
separator with a fixed decimal point.

 Figure 126: Source set to User and Containers, Focus On Map editor

• Containers: defines the font objects that will display the longitude and latitude 
values of the position and range:
• Longitude Position: When set, this parameter is linked to the text object 

displaying the longitude position data received from the GeoText plugin. 
• Latitude Position: When set, this parameter is linked to the text object 

displaying the latitude position data received from the GeoText plugin.
• Compass: When set, this parameter is linked to an object that will be rotated 

to show the North (based on navigator direction).
• Longitude Range: When set, this parameter is linked to the text object 

displaying the longitude range data received from the GeoText plugin. 
• Latitude Position: When set, this parameter is linked to the text object 

displaying the latitude range data received from the GeoText plugin.
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• Legend: When set, view width and view height values will be scales based on 
the object used for the legend.

• Length: When set, this parameter is linked to the text object displaying the 
length of the line object as received from the GeoText plugin.

12.27 Globe

The plugin can be found in the following folders:
• Viz Artist 2: Object -> Built in.
• Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The Globe plugin is used as a base object, with maps, to enable geographic 
referencing options over a globe. The globe object will geographically reference 
the map at the correct location over the globe.

 Figure 127: Globe example

This section contains information on the following topics:
• Plugin Description
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12.27.1 Plugin Description
• Tessellation: Defines the number of polygons used to create the Globe 

geometry.
• Sub Tessellation: This parameter devides each of the Globe flat areas, to 

increase texture coordinates and improove the way the teaxyres look on a 
globe.

• Radius: Defines the radius of the globe.
• West: Sets the Longitude value for the western edge of the Globe. The globe 

object will be cropped at that Longitude.
• East: Sets the Longitude value for the eastern edge of the Globe. The globe 

object will be cropped at that Longitude.
• South: Sets the Latitude value for the southern edge of the Globe. The globe 

object will be cropped at that Latitude.
• North: Sets the Latitude value for the northern edge of the Globe. The globe 

object will be cropped at that Latitude.
• Enable Hole: Saves performance when building pyramids using globe objects. 

When the globe objects for the pyramid layers are created, a hole is created 
where the higher resolution maps are, to avoid rendering multiple pixel layers 
(and to save performance). It can be used manually to create a hole in a globe 
object by setting values which are in the area of the map in use. When enabled 
(On) additional parameters will be enabled:
• Hole West (From lon): Defines an inner Longitude in the map area where the 

hole will begin (West side).
• Hole East (To lon): Defines an inner Longitude in the map area where the 

hole will begin (East side).
• Hole South (From lat): Defines an inner Latitude in the map area where the 

hole will begin (South side).
• Hole North (To lat): Defines an inner Latitude in the map area where the hole 

will begin (North side).
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 Figure 128: Globe editor

• Crop Globe: Select an option for cropping the globe:
• Manual: the globe object will be cropped according to the values set in the 

West, East, South and North parameters.
• Automatic: the globe object will be cropped according to the geographical 

properties of the map applied to the Globe.
• Texture Mapping: This parameter defines how the texture (map) will be 

mapped over the Globe:
• Absolute: the globe object will be cropped according to the values set in the 

West, East, South and North parameters.
• Relative: the globe object will be cropped according to the geographical 

properties of the map applied to the Globe.
• GeoRef: The map will be mapped over the globe object according to its 

geographical properties.
• GeoRef Only: Defines if the Globe is used for geographical referencing only 

(not drawn) or as an object (will be drawn).
• If set to No, the globe object will be drawn (with the attached map).
• If set to Yes, the globe object will be used for geographic referencing only 

and will not be drawn.
• This mode is used when creating globe tiles. The reference map is not used, 

since only the tiles are visible. If the reference globe is not drawn, it saves 
performance.

• Map Status: Reports if the map was loaded as expected (Ok), geographic 
referencing of the map, and so on. 
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• Apply Fade Plugin: When clicked, a Fade Texture plugin will be applied to the 
container.

• Face Z Axis: When clicked, the globe object will rotate and centre facing the Z-
axis. This button can be used when not a full globe is rendered (for example 
only Asia). Do not use this feature with the Navigator plugin as it assumes no 
rotation.

12.28 Globe Zoom

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps.

IMPORTANT! This plugin is included in Viz World Client package for compatibility 
reasons, and is not maintained. It is recommended to use the Navigator and 
NavFinder plugins for designing new scenes.

12.29 Hop Sync

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The HopSync plugin is used to coordinate between labels and other 3D objects 
with built-in animations and hop animations. The HopSync plugin is applied to 
the same container as the Label It plugin, or to a container above the label design 
containers but below the top design container which will be used to create the 
label merged object. To use HopSync plugin, the label designs must include a 
merged object containing the design. The plugin defines a point in the label 
animation that will be matched with the hop point in the Navigator animation.

This section contains information on the following topics:
• Plugin Description
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12.29.1 Plugin Description
 Figure 129: Hop Sync editor

• Director: Defines to which director the label animation will be copied to.
• Navigator: Copies the label animation to the Navigator director. This option 

is used when the label animation should end before or at the time the 
Navigator animation has reached a hop point. When the navigator director 
reaches a hop point and Continue is pressed (or pause time will end) the 
label animation will also continue, causing the label to disappear.

• Hop Director: Copies the label animation to a new director. This option is 
used when the label animation should end after the hops animation has 
stopped (or paused). If the label animation will be copied to the Navigator 
director, the label animation will stop before the entire label was revealed.

• Separate: Copies the label animation to a new director (not the Hop or 
Navigator director) in order to give you more options.

• Animation Start Time: Defines the point in the label animation that will be 
matched to the hop point in the Navigator animation. The value is set by 
typing in a number (in seconds), or clicking and sliding the mouse over the 
parameter until the animation point is reached. Another option is to use the 
Set Highlight Time button. Play the animation and when reaching the 
requested point in the label animation, stop and click the Set Highlight Time. 
The current label animation value will be copied to the Animation Start Time 
field. 

• Order Offset: Enable/disable an offset between the animation of the objects. 
• Animation Order Offset Time: How much time to offset the animation, e.g 

when setting this value to 1.2, the 3rd detail animation will start after 2.4 
seconds after the animation has reached the destination.

12.30 Hops Manager

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps-Adv.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps-Adv.

The Hops Manager plugin is used to control from one interface multiple instances 
of several plugins. The plugin should only be used if all parameters for the control 
plugins should be the same. If for any reason different values are needed the 
plugin should not be used.
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The plugin controls the CWM Client plugin, Map Pyramid plugin and NavFinder 
plugin; however, only instances which are part of a hop will be controlled. The 
plugin has two main options; global values and hops.

This section contains information on the following topic:

• Plugin Description

12.30.1 Plugin Description

Global values are used in order to update values globally on all control plugins.

Under the global values tab all parameters are the same as those found in the 
actual plugins you want to control. For more information see:

• CWM Client
• Map Pyramid
• NavFinder

Hops are used to jump to a specific hop. From this tab you can select and refresh 
a map and fine tune NavFinder’s pan values.

12.31 KML Reader

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps-Man.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps-Man.

The KMLReader plugin is used to add objects from KML files to the scene. KML 
files are XML formatted files containing information about geografic objects: 
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labels, shapes, lines. The KML Reader plugin reads the files and generates objects 
according to the file’s content.

This section contains information on the following topics:
• Plugin Description

12.31.1 Plugin Description
 Figure 130: KMLReader editor, General

• KML File: Defines the path to the KML file.
• Label Designs & Holder: Defines the graphic designs for labels.

• Disabled: No label designs are used. Labels found in the file will not be 
drawn.

• Local: Specific label design containers and holder will be used. When 
selected additional parameters will be enabled: Label Designs and Label 
Holder. Assign the required designs and holder to the plugin.

• Global: The global label designs and holder container will be used. The 
global designs and holder are defined in the 3D Map Setting plugin.

• Shape Designs & Holder: Defines the graphic designs for shapes.
• Disabled: No shape designs are used. Shapes found in the file will not be 

drawn.
• Local: Specific shape design containers and holder will be used. When 

selected, additional parameters will be enabled: Shape Designs and Shape 
Holder. Assign the required designs and holder to the plugin.

• Global: The global Shape designs and holder container will be used. The 
global designs and holder are defined in the 3D Map Setting plugin.

• Line Designs & Holder: Defines the graphic designs for lines.
• Disabled: No line designs are used. Lines found in the file will not be drawn.
• Local: Specific line design containers and holder will be used. When selected 

additional parameters will be enabled: Line Designs and Line Holder. Assign 
the required designs and holder to the plugin.
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• Global: The global line designs and holder container will be used. The global 
designs and holder are defined in the 3D Map Setting plugin.

• Georef Images: Defines if georef images found in the KML file will be used.
• Disabled: Images found in the file will not be drawn.
• Enabled: Images defined in the file will be drawn and geographically 

referenced. When selected an additional parameter will be enabled: Georef 
Images Holder. Assign the required holder to the plugin.

 Figure 131: KMLReader editor, Advanced

• Use Proxy: Defines the network uses a proxy server. If set ON, additional 
parameters will be enabled:
• IP: Sets the IP address of the proxy server.
• Port: Sets the port number to be used.
• Username, Password: Sets the login credentials.

• Debug Printing: When set to ON, debug messages will be printed to the Viz 
console.

• Read File: Triggers the plugin to read the files and re-draw the objects.

12.32 Label AddOn

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps-Adv
• Viz Artist 3: Built Ins -> Container Plugins -> Maps-Adv

The Label AddOn plugin can be used to assign images, geometries and text based 
on label parameters. Labels can have up to 4 extra parameters.

• Label parents: Country, Admin1, Admin2 (see also Place Finder plugin)
• Label type: Type

Based on the container name (case sensitive) the CWM Client plugin will update 
the Value field in the plugin with the correct value.
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So if for example you have selected London and you have a Label AddOn plugin 
on a container named “Country” it will receive the value of United Kingdom and if 
you  have another Label AddOn plugin on a container named “Type” It will receive 
the value of  “Capital”.

A use case for this plugin is whenever you want to have flags for all countries in 
the world in a folder and use the right flag based on the country.

Another use case is having different images for different types and using the 
correct image based on the type.

This section contains information on the following topics:

• Plugin Description

12.32.1 Plugin Description

• Type: Options are Image, Geometry and Text
• Images can be applied from the database on a local container
• Geometries can be applied from the database on a local container
• Text can be changed on the local container

• Value: Values used to seraph the object or set the text. Can be edited for 
testing.

• Prefix: Prefix used for searching the database. For example MyImages/Flags/
Suffix or _small

• Hide If Empty: Hides (Off) the container if an object/image is not found 
• Update: Tests the prefix and suffix

12.33 Label It

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps.
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The LabelIt plugin is used for managing 3D labels and place indicators. The plugin 
creates a hierarchy under its container for adding a caption, body and pointer 
objects.

This section contains information on the following topics:
• Plugin Description

12.33.1 Plugin Description
The plugin has four plugin editor views; Caption, Overlay, OnMap Scale and Fade. 
In addition this section also explains some Practical Use aspects of the plugin.

This section contains information on the following topics:
• Caption
• Overlay
• OnMap Scale
• Fade
• Practical Use

Caption
Caption defines the relation between the label components (text and pointer).

 Figure 132: Caption disabled, Label It editor

• Caption: When disabled, duplicated labels will use the label design exactly. 
When enabled the labels will use the following options:

 Figure 133: Caption enabled, Label It editor

• Presets: The Labelit object is controlled by the Label Manager plugin.
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• WME: The default pointer direction (angle) and default distance between the 
pointer and the label is set by the map label parameters and used by the Viz 
World Maps Editor (WME). If the direction and distance are changed while 
using the WME the Default Direction and Default Distance values will be 
ignored.
• Number of Presets: Defines the number of label position presets avalible to 

the user (one to four presets). This parameter will be enabled only when 
Caption Mode is set to Controlled.

• Direction: Sets the angle of the label in relation to its geographical position.
• Distance: Sets the distance of the label from its geographical position.
• Caption Pivot: When caption is moved (rotated along the tip) the two 

options, Fixed and Edge, define the connection point between the caption 
and the body. Fixed sets the connection point to be the center of the 
caption. Edge sets the connection point to depend on the correct rotation. If 
the caption is above the tip, the connection point will be the middle lower 
side of the caption. If the caption is on the right side of the tip it will be on 
the left side of the caption. For example: A line moving from the tip to the 
center of the caption and where it crosses the caption bounding box is the 
connection point.

• Collision Mode: Defines how the labels will be placed when an overlap or 
collison between two labels occur. With Tip, the pointers of overlapping 
labels can cross or touch, but no overlap of label bodies are allowed. With 
Bounding Box, a bounding box is calculated around the entire label (label 
body and pointer). An overlap between labels bounding boxes is not 
allowed.

• Rotate Labels: Defines if labels, created in Viz (3D labels), will be rotated 
like the labels in Viz World Maps Editor (WME). If set to Disabled, all labels 
will be displayed horizontally. If set to Enabled, labels that were rotated in 
Viz World Maps Editor will be rotated in Viz.

• WME Offsets Distance: When WME is enabled, this parameter enables the 
WME to offset the distance (default ON). When disabled (OFF) only the 
direction offsets from WME is used and the distance ignored.

Overlay
Navigator Overlay defines how the label will be displayed over the map. Available 
options are Disabled, Fixed, Scaling, Near Scale and Far Scale.

 Figure 134: Overlay, Label It editor

• Disabled: Places the label on the map using its geographical referencing.
• Fixed: Places the label by keeping its geographical referencing but using a 

different camera (either with dynamic image or with a front layer). The label 
size will remain fixed.
182 Chapter 12: Maps Plugins



• Scaling: Places the label by keeping its geographical referencing but using a 
different camera (either with dynamic image or with a front layer). The Label 
will scale trying to imitate the camera movement.
• Near Scale: Defines the maximal size of the label on the screen (that is when 

zooming in what will be the final size of the label). 
• Far Scale: Defines the minimal size of the label on the screen (that is when 

zooming out what will be the final size of the label).

OnMap Scale

 Figure 135: OnMap Scale, Label It editor

• Static Map Scale: Defines a scaling factor for the duplicated labels on a static 
map without camera movement. When disabled (Off), no scaling will be used.

Fade

 Figure 136: StandAlone fade, Label It editor

• Fade: Defines the fade effect parameters to be used with the duplicated labels. 
Available options are Stand Alone and Controlled. Stand Alone enables the 
user to define the fade parameters of the labels, while Controlled can be 
enabled to define the fade parameters when working with the Label Manager 
plugin.

• Fade On Time: Defines a label fade effect, beginning at a relative point to the 
defined hop duration. An additional parameter will be enabled, Time To Hop, 
defining when the fade will occur. 

• Fade On Distance: Defines a label fade effect, beginning at a relative distance 
from the hop final location. 

• Fade On Lat/Long: Defines a label fade effect, beginning at a Longitude and 
Latitude offset from the hop final location. An additional parameter will be 
enabled, Lat/Long, defining the offset from in degrees.
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Note: The Fade On Distance parameter is enabled only if Overlay is set to Scaling.

 Figure 137: Controlled fade, Label It editor

• Step: Controls when the label will fade in and out in relation to an animation. 
In general the fade can be based on the camera distance (for example; captials 
are in view when disctance is below 1000KM) or on timing in relation to the 
hop:
• Auto: When a label is of type point (added by the user) it will fade in and out 

based on distance to hop. If the label is of type place/region it will be faded 
in and out based on the distance set in Label Manager plugin. If the hop is 
not close enough for the label to show and the label was added by the user 
it will be faded in based on hop timing and not distance.

• On Hop: Links the fade to the hop timing.
• Point 1/Point 2: These are reserved for labels where the distance is 

configured by the Label Manager plugin.
• Selected Label Timings: Sets one of the timing options for the fade to occur:

• At End: the label will fade after the animation stops and before it continues.
• Close To End: Fades the label just before the animation stops and just after 

the animation continues.
• Ahead: Fades the label before the animation stops and after the animation 

continues.
• Well Ahead: Fades the label long before the animation stops and long after 

the animation continues.
• Label Priority: Sets the duplicated labels priority. This parameter is used when 

the number of labels on the screen is high and not all of the labels can be 
displayed. The priority levels define which labels will be displayed and which 
labels will be hidden:
• Auto: Priorities are set by the Label Manager plugin.
• Normal, High: Priorities are set to normal and high.
• Always: Labels will always be displayed.

Practical Use
When adding a LabelIt plugin, three containers will be added under the LabelIt 
container: CAPTION, BODY and TIP. Drag a text object under the CAPTION 
container. The BODY container is the pointer’s body and the TIP is the pointer’s 
end. 
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IMPORTANT! A text object under the label design must be named “label” to receive 
the name of the object from the CWMClient plugin.

12.34 Label Manager

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Scene (button) -> Maps.
• Viz Artist 3: Built Ins -> Scene Plugins -> Maps.

The LabelManager plugin is a scene plugin, used for retreiving label information 
from Viz World Server and control the label’s appearance when working in an 
automatic label mode. The LabelManager generates labels, based on the defined 
label designs, according to parameters defined in the Navigator plugin, Label It 
objects and 2D Label objects in the label designs.

Note: Scene plugins are added under the Scene Settings’ Plugin tab.

This section contains information on the following topics:
• Plugin Description

12.34.1 Plugin Description
The plugin has four plugin modes.

This section contains information on the following topics:
• Map Data
• Auto Labels
• Definitions
• Shadows
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Map Data

 Figure 138: Map Data, Label Manager editor

The Map Data tab defines settings for the label types received from the Viz World 
Server (WoS). These settings will be used when calculating label appearance in 
automatic mode. For every type of label selected in the list, set the required 
parameters.

• Type: Sets the type of labels data to display.
• Start View: Defines the map size from which the labels of the selected type will 

appear during the Navigator animation. Parameter units are defined in the 
Definitions tab’s Units parameter.

• Life Span: Defines the duration of the label appearance on screen. Note that 
this setting is most useful for country and region types.
• Full: The label appears at the defined Start View and remains on screen 

throughout the entire animation.
• Long: The label remains on screen for a long period of time.
• Regular: The label remains on screen for a medium period of time.
• Short: The label remains on screen for a short period of time.
• Manual: The label remains on screen until the defined End View value is 

reached.
• End View: Defines the map size at which the labels of the selected type will 

disappear. This parameter is only enabled if the Life Span is set to Manual. 
Parameter units are defined in the Definitions tab’s Units parameter.

Note: The Label Manager plugin controls and manages the automatic labels 
appearance, using various parameters from different plugins. The Life span and 
Auto Label parameters will vary between labels during the animation (hop), to 
optimize labels display.
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Auto Labels

 Figure 139: Auto Labels, Label Manager editor

The Auto Labels tab defines if automatic labelling will be enabled and the label 
designs used for automaic labelling.

Auto Labels can be limited to specified countries and/or regions. The format of 
valid input is:
• ‘;’ between locations.
• ‘/’ or ‘\’ to specify the path to the regions.

Note: Abbreviations can be used (after defining such list in the WoS)

Some examples:
• USA;Mexico
• USA\TX;Mexico;Canada
• United States of America\Florida;United States of America\Georgia;USA\NY

• Auto Labels: Sets the auto labels mode to disabled, endabled or interactive.
• Disabled: No automatic labelling will be used in the scene.
• Enabled: The scene will use automatic labelling based on the defined 

designs and labels holder container.
• Interactive: Enables the Auto Labels Quantity.

• Auto Labels Quantity: Allows you to set the amount of labels that should be 
shown. Few will show approximately 75 labels (or less), Average 100 labels (or 
less) and Many 150 labels (or less). Manual sets the distance where the labels 
should appear (see Start View under Map Data) providing a consistent behavior 
(e.g. Town 1K will always appear/disappear at the same distance).

• Manual Labels: Defines if manual labels, defined for the map, will be displayed 
with the auto labels. When Enabled is set, the Select Manual Labels button will 
appear at the bottom of the editor. When clicked, WME will open, enabling the 
user to set manual labels.

• Road Labels: Defines the level (number) of road labels that will be displayed. 
Select the required option, ranging from 0-None to 5-All.
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• 3D Designs & Holder: 
• Designs (text field): Defines a path in Viz’s objects database that contains 

label designs. Automatic label designs are based on 2D Label and Label It 
plugins.

• Designs (place holder): Displays the selected (drag&drop) top container 
holding the label designs.

• Holder (place holder): Displays the selected (drag&drop) container that 
resides under the map. This container will be used by the Label Manager 
plugin to store the scene’s generated labels.

• Limit Auto Labels: Defines if the auto labels will be limited to a defined 
region/s or not. When enabled, the Limit To Region text field will be 
enabled.

• Limit To Region: Defines the region to which the auto labels will be 
generated.

Definitions

 Figure 140: Definitions, Label Manager editor

The Definitions tab is used to set general parameters for Label Manager 
behaviour.
• Intersection Mode: See Map Data.
• Screen Culling Mode: Defines if a label will be drawn when it is outside the Viz 

renderer’s scope/view.
• Center: The label object fades out when the center of the object is outside 

the Viz renderer’s scope/view.
• Anything: The label object fades out when any part of the object is outside 

the Viz renderer’s scope/view.
• Complete: The label object fades out when the entire object is outside the 

Viz renderer’s scope/view.
• None: No culling will be used. The labels will be drawn according to the map 

data parameters only.
• Map Culling Mode: Defines if a label will be drawn when it is outside the map 

area but inside Viz renderer’s scope/view.
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• Units: Defines the units used to calculate map size for the Start View and End 
View parameters. Available options are Degrees, Kilometers, Miles and  
Nautical Miles, where the default measurment unit is Kilometer.

• Fade Time (in fields): Defines the label’s fade duration in fields.
• Labels in Overlay: When enabled the labels will be in a different layer (dynamic 

image/layer). When disabled the labels will be on the map.
• Debug Info Mode: Shows different levels of debug information regarding the 

auto layout.

Shadows

 Figure 141: Shadows, Label Manager editor

• Intersection Mode: See Map Data.
• Cast Shadows: Turns option to cast label shadows on/off.
• Light Type: Simulates different light types to cast the shadows.
• Horizontal Angel: Defines the horizontal angle position of the light.
• Vertical Angel: Defines the vertical angle position of the light.
• Distance: Defines light distance.
• Shadow Plane: Casts planar shadows on an imaginary plane and this option 

defines the spatial rotation of such a plane. Select one of the options:
• Straight: The casted plane is parallel to the screen.
• Up Tilt: The casted plane is tilted 45 degrees up from the screen.
• Down Tilt: The casted plane is tilted 45 degrees down from the screen.
• Manual: Manually set the pan and tilt values of the casted plane.
• World: The casted plane is tangent to the world.

• Tangent Point: Pivot point for connection shadow to object.
• Shadow Pan: Manual Shadow Pan.
• Shadow Tilt: Manual Shadow Tilt.
• Shadow Distance: Distance of the shadow plane from the object.
• Shadows Camera: Select a camera for rendering the shadows. Since shadows 

are done by first rendering objects in a distant place and then overlaying their 
black silhouettes on the screen, this option defines the camera that will look at 
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such distant place where objects are rendered. (Actually this camera is used 
for overlay).

• Show Light Direction: Visualize light direction on screen or not. The light 
direction is visualized by showing a lit ball or an arrow.

12.35 Light On Globe

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Scene (button) -> Maps.
• Viz Artist 3: Built Ins -> Scene Plugins -> Maps.

 Figure 142: Light on globe example

The LightOnGlobe plugin is a scene plugin used for applying light sources to a 
globe object. The plugin is required when designing a hops scene and the 
animation is going from the lighted area of the globe to the dark area of the 
globe. When using the LightOnGlobe plugin, the lights will follow the camera 
animation. The light sources are Viz lights, and the lighting parameters should be 
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adjusted in the Viz light editor. The LightOnGlobe plugin will lock the light 
sources to the selected camera in the plugin parameters.

Note: Scene plugins are added under the Scene Settings’ Plugin tab.

This section contains information on the following topics:
• Plugin Description

12.35.1 Plugin Description
 Figure 143: Light On Globe editor

• Camera: Sets the camera number for setting the light sources. The light 
sources will be locked to the selected camera number.

• Key Light Type: Sets the main light source type. Available types are Local, 
Spot, Infinite or None.

• Key Light Angle: Sets the angle of the key light source, which is the longitude 
value for the center of the light projected on the globe.

• Key Light Elevation: Sets the elevation of the key light source, which is the 
latitude value for the center of the light projected on the globe.

• Distance Scale: Sets a scale value on the globe distance so the light can be 
closer or further away.
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• Attenuation: Sets the level of light attenuation.
• Back Light Type: Sets the back light source type. Available types are Local, 

Spot, Infinite or None.
• Back Light Angle: Sets the angle of the back light source, which is the 

longitude value for the center of the light projected on the globe.
• Back Light Elevation: Sets the elevation of the back light source, which is the 

latitude value for the center of the light projected on the globe.
• Distance Scale: Sets a scale value on the globe distance so the light can be 

closer or further away.
• Fill Light Type: Sets the fill light source type. Available types are Local, Spot, 

Infinite or None.
• Fill Light Angle: Sets the angle of the fill light source, which is the longitude 

value for the center of the light projected on the globe.
• Fill Light Elevation: Sets the elevation of the fill light source, which is the 

latitude value for the center of the light projected on the globe.
• Distance Scale: Sets a scale value on the globe distance so the light can be 

closer or further away.
• Camera Light Type: Sets the camera light source type. Available types are 

Local, Spot, Infinite or Off. The camera light will follow the camera 
movements.

• Camera Light Horizontal Shift: Sets the horizontal shift of the light source in 
relation to the camera location.

• Camera Light Vertical Shift: Sets the vertical shift of the light source in relation 
to the camera location.

• Toggle Mode: Sets the lights behavior mode during camera movement:
• Static: All light sources, except for the camera light, will remain in a fixed 

location in relation to the globe.
• Dynamic: All light sources will keep a fixed location in relation to the 

defined camera (that is it will move with the camera).

12.36 Locator Control

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The LocatorCtl plugin is used to link an object positioned on one map to another 
map, showing its position. The object marking the point on the linked map must 
reside under a geographically referenced map. The linked object will show the 
position of the linked map or object on the map its parent map.

This section contains information on the following topics:
• Plugin Description
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12.36.1 Plugin Description
 Figure 144: Position type Map, Locator Control editor

Position Type defines the link between the object and the map. Available options 
are Map, Navigator, WPosition, WPoint and User. 

Map links the object to a map, showing its entire area over theparent map.
• Remote Container: Defines the linked map container.
• Control Size: When disabled (Off), the entire area of the linked map will be 

marked on the parent map. When enabled (On), the size of the marked area 
can be controlled.

• Basic Size: Defines the percentage of the linked map area to be marked.
• Min Size: Defines the minimal size of the linked map area to be marked.
• Max Size: Defines the maximal size of the linked map area to be marked.

 Figure 145: Position type Navigator, Locator Control editor

Navigator links the object to a Navigator plugin, showing its position on the 
parent map. The plugin will locate the navigator container above it in the scene 
tree.
• Control Size: When disabled (Off), the entire area of the linked map will be 

marked on the parent map. When enabled (On), the size of the marked area 
can be controlled.

• Basic Size: Defines the percentage of the linked map area to be marked.
• Min Size: Defines the minimal size of the linked map area to be marked.
• Max Size: Defines the maximal size of the linked map area to be marked.
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 Figure 146: Position type WPosition, Locator Control editor

WPosition: links the object to a WPosition plugin, showing its position on the 
parent map.
• Remote Container: Defines the WPosition container.

WPoint links the object to a WPoint plugin, showing its position on the parent map 
(The WPoint plugin is used in Viz Weather).
• Remote Container: Defines the WPoint container.

 Figure 147: Position type user, Locator Control editor.

User enables the user to position the object on the map.
• Map Center Longitude: Defines a Longitude value for the object.
• Map Center Latitude: Defines a Latitude value for the object.
• Tangent To Globe: When enabled (On), the controlled object will be rotated to 

match the globe surface.

Note: Tangent To Globe is only visible when the locator is under a globe object.

12.37 Map Builder

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Scene (button) -> Maps.
• Viz Artist 3: Built Ins -> Scene Plugins-> Maps.

Map Builder is a wizard like solution, with a simple and easy interface to create 
generic map scenes.

The Map Builder solution consists of 2 major parts:
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1. Map Builder Plugin – is a Viz Artist scene plugin that builds a scene from a map 
template (*.mtpl) file, and saves the map scene changes to the map template 
file.

2. Map Builder Wizard – is a simple user interface that allows the user to create a 
scene descriptor (*.mtpl files) that represents a map scene and its containing 
elements. The wizard is accessible from within Viz Artist, and as a standalone 
application (see C:\Program Files\Vizrt\Common\Maps\MapBuilder.exe).

This section contains information on the following topics:
• Plugin Description
• Map Builder Wizard

12.37.1 Plugin Description
 Figure 148: Map Builder editor

• Map Template Filename: Sets the name of the scene template file or click the 
browse button to select a file.

• Build Scene: Updates the scene tree with changes from the wizard.
• Launch Wizard: Runs the MapsBuilder wizard application.
• Clean Scene: Cleans the scene heirarchy.
• Build Scene From Scratch: Cleans the scene tree and rebuilds the scene 

heirarchy using the defined map template file.
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12.37.2 Map Builder Wizard

IMPORTANT! Prior to using the wizard you need To import basic map elements.

In general, a map scene consists of a few basic elements, built in this order:

1. Create a Base Map.
2. Define the Navigation.
3. Create a Destination List.
4. Define label, region and border Designs.
5. Set the map Orientation.
6. Configure the design source and object pool Settings.
7. Refresh Thumbnails when re-launching the wizard to make changes.

This section contains information on the following topics:
• Base Map
• Navigation
• Destination List
• Designs
• Orientation
• Settings
• Refresh Thumbnails
• To import basic map elements
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Base Map

Base Map is the Globe/Flat World Map in a specific style and data. The map 
created at this level is usually good for country level view.

Navigation

Defines the camera’s trajectory animation setting. It describes how the navigation 
animation should be (e.g. map origin + 3 destination animations, each “hop” 
animation based on 5 seconds, with stop points between destinations).

Destination List

Defines if each destination could be of type Geo Position Only, Map - Single Image 
or Pyramid of Maps.

A Geo Position Only destination will only use a Geo Position reference to the 
navigation. This mode is useful for destinations that are always far away from the 
base map. No map will be created in this mode (as it will save texture memory).
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Note: When destination is set to Geo Position Only, it cannot be controlled by an 
external application such as Viz Trio or Viz Content Pilot.

Map – Single Image enables operators to control a destination using an external 
application (either a Map or Pyramid has to be selected). If the selected 
destination is used for a reference point, and it needs to be controlled, use this 
type (e.g. a far away starting point).

Pyramid of maps is used when the base map is not suitable for close-ups. A 
pyramid of maps built around the destination will smoothen the resolution 
difference between the base map and the destination target.

Each destination can consist of map elements (labels, regions and miscellaneous 
map elements), and if it is controlled (e.g. by Viz Trio or Viz Content Pilot) 
destinations can be linked to each other – to allow the user to easily control 
multiple destination elements. Linking is only a help to the user and has no effect 
on the scene.

Copying (duplicating) a destination is possible by selecting a destination and 
clicking the add button.

Note: The selected destination will not be duplicated if the destination type is Geo 
Position Only.
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Designs

Describes how complex and complete the map elements designs will be, the 
Designs part is divided into 3 major groups:
• On map labels.
• On screen labels design.
• Regions & borders design.

Each design group can be customized; however, in addition they also have four (4) 
predefined presets: None, Simple, Detailed and Complete.

To distinguish on a country level using Region labels, it is possible to select the 
Country option as this will create two region label designs:

• Country – designs for selected countries.
• Any Region – for all other regions labels.

To distinguish between major towns, capitals and all other towns, it is possible to 
select the Town > 1M option as this will create three town label designs:

• Town > 1M: for major towns.
• Capital: for country capitals.
• Any Town: for all other town types.
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Orientation

Orientation is a small map in the bottom corner of the screen, which shows a 
small world map and a marker showing what part of the world is currently being 
navigated to.

Settings

Allows the user to specify the design source and object pool path.

Designs source is an option that allows designs to be shared between scenes by 
using the Object Pool, instead of the in-scene designs.

Object Pool Path is an option to specify an alternative Viz Graphic Hub or Object 
Pool folder instead of the default object path (/vizrt/VizCuriousMapsClient/
MapBuilder).

Note: A custom Object Pool Path must use the same hierarchy structure as the 
default object path (see /vizrt/VizCuriousMapsClient/MapBuilder).

Refresh Thumbnails

Refreshing Thumbnails must be done after manually editing a wizard generated 
scene and re-launching the wizard as all thumbnails of maps (Base Map, 
Destinations and Orientation) are lost. In order to refresh them press the F5 key, 
or click the refresh button in the toolbar.
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To import basic map elements
1. Start Viz Artist.
2. Click Import and select Archives from the drop-list
3. Navigate to C:\Program Files\Vizrt\Common\Maps\Archives, and select the 

VizCuriousMapsClientObjects3x.via archive.
4. Click Import Archive.

12.38 Map Layers

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The MapLayers plugin is used to expose map layers to an external application. 
Map layers are labels, regions, and so on.

This section contains information on the following topics:
• Plugin Description
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12.38.1 Plugin Description
 Figure 149: Mode dynamic, Map Layers editor.

• Mode: Defines the layer maps mode Static and Dynamic.
• Static: Enables maps to be imported to Viz Artist’s image library and saved 

with the scene.
• Dynamic: Enables pyramid maps to be loaded from the cache and temporary 

folder. When the CWM Client plugin receives a new map, all layers will be 
updated.

• Texture Compression: Sets the compression level for the texture (DTX5 is the 
highest compression level, which is less texture quality).

• Texture Quality: Sets linear for using the same image resolution in the entire 
zoom range, or Mipmap to change resolution according to the distance from 
the image (managed automatically in Viz Artist).

• Edited Layer: Sets the layer number for editing. Each layer is then assigned 
map properties to display.

• Active: Activates or disables the selected layer.
• Container: Assigns the container for holding the created layer map.
• Flags: Enables (On) the requested property to expose the map property or 

feature in the selected layer. Flags refer to all the settings from Base Map to 
Overlay Data.

• Build Tiles: Builds the map layers.
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12.39 Map Layers Control

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps-Adv.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps-Adv.

The MapLayersControl plugin is used to control map layers in an individual map 
and in map tiles (Pyramid or MapTiler tiles). The plugin should reside on the CWM 
Client container which generates the maps and tiles.

This section contains information on the following topics:
• Plugin Description

12.39.1 Plugin Description
 Figure 150: Map control enabled Map Layers Control editor

Select an option to configure: Map or Tiles. Each can be enabled and configured 
separately. When Control is enabled, the layer parameters will be enabled. See 
Map Layers plugin for the layers description.
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12.40 Map Pyramid

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The MapPyramid plugin is used to build a set of map layers for displaying an area 
in high resolution when zooming into a specific area. The maps are created as 
GeoImage (flat map) or Globe objects and placed under a low resolution map of 
the entire area for geographical referencing. The Map Tiler plugin is also used for 
managing Pyramid object maps when used in a scene.

This section contains information on the following topics:
• Plugin Description

12.40.1 Plugin Description
 Figure 151: Mode dynamic, Map Pyramid editor

• Mode: Defines the maps mode. Available modes are Static and Dynamic.
• Static: Enables the maps to be imported to Viz Artist’s image library and 

saved with the scene.
• Dynamic: Enables the pyramid maps to be loaded from the cache and 

temporary folder. When the CWM Client receives a new map, the pyramid 
will be generated.

• Map Style: Defines the map style to be used for the pyramid maps:
• Source: Uses the top CWM Client container (Map Tiler) style selection when 

creating the pyramid maps.
• Target: Uses the hop CWM Client style selection when creating the pyramid 

maps.
• Satellite (Split): Splits the pyramid layers style, based on image latitude and 

longitude size. If the image size is smaller then the threshold the target style 
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will be used, if larger then then source style will be used. Additionally, it is 
possible to turn on the color correction option in Pyramid Control which will 
color correct the target image to match the source images.

• Max Pyramid Height: Defines the maximal number of maps that will be created 
in the pyramid. The optimal number of pyramid maps is calculated by the 
MapPyramid plugin. If the optimal number exceeds the Max Pyramid Height 
value, then the plugin will generate the maximal number defined.

• Pyramid Factor: Calculates the number of maps required defining the size 
factor between the maps of the pyramid.

• Auto Hide Local Texture: Defines if the map created by the CWM Client plugin, 
located on the MapPyramid container, will be turned off when the texture 
resolution of that map is lower than the Globe or GeoImage map tiles 
resolution. If it is enabled (On), the maps with lower resolution will be turned 
off automatically by the MapPyramid plugin. If it is disabled (Off), the 
MapPyramid will not turn off the low resolution maps.

• Apply Fade: Defines if the maps used in the pyramid will use soft edges. 
Available options are Off, Target and Pyramid.
• Off: No soft edges will be used. The transition between the maps will be 

visible (the maps will have sharp edges).
• Target: Sets the last map (target) to have soft edges only.
• Pyramid: Sets all maps in the pyramid to have soft edges.

• Fade Range: When Apply Fade parameter is used, the Fade Range is used to 
set the fade level (the area of the image that the fade will be applied to). 

• Build Tiles: Triggers a rebuild of the pyramid maps.

12.41 Map Tiler

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The Map Tiler plugin is used to build a set of map tiles for displaying an area in 
high resolution. The maps are created as GeoImage (flat map) or Globe objects 
and placed under a low resolution map of the entire area for geographical 
referencing. The Map Tiler plugin is also used for managing Pyramid object maps 
when used in a scene (see the Map Pyramid plugin for more information).

IMPORTANT! Do not modify the container hierarchy under the MapTiler container.

This section contains information on the following topics:
• Plugin Description

See Also
• GeoImage
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• Globe
• Map Pyramid

12.41.1 Plugin Description

The plugin has five tabs; Tiling, Texture, Terrain,Destination and Advanced. Each 
tab relates to differnet tile parameters.

This section contains information on the following topics:
• Tiling
• Texture
• Terrain
• Destination
• Common Buttons

Tiling

 Figure 152: Tiling tab, Map Tiler editor

• Selected Region: Defines the area of the map for which the tiles will be 
created.
• World: Creates tiles for the entire world.
• Selected Map: Creates tiles for the area of the selected map in the 

CWMClient plugin attached to the MapTiler container.
• Region List: When Region List is selected, a list of regions will be displayed. 

An item from the list can be selected to create map tiles for the selected 
area.

• Long Lat: Sets the Longitude and Latitude minimum and maximum values. 
The map tiles will be created for the defined area. When Long Lat option is 
selected, additional fields will be enabled:

• West: Sets the Longitude value for the western edge of the map.
• East: Sets the Longitude value for the eastern edge of the map.
• South: Sets the Latitude value for the southern edge of the map.
• North: Sets the Latitude value for the northern edge of the map.
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• View: Defines the point of view (Outer Space, Space, World, Continent, 
Country, Large Region,Region, Manual and Total) of the area (that is the 
amount of zoom to be used). The higher the point of view, the lower the 
number of tiles will be and lower resolution.
• When set to Manual, the Pixels Per Degree parameter will be enabled.
• When set to Total, the Total Pixels parameter will be enabled.

• Pixels Per Deg: Defines the resolution of the map. Resolution is determined by 
the number of pixels per degree. The higher the number is the higher the 
resolution is.

• Total Pixels: Defines the total number of pixels for all the tiles combined.
• Geometry Type: Selects the object type of the created tiles.

• Globe: Creates the tiles using the Globe plugin.
• Flat: Creates the tiles the GeoImage plugin.

• Radios/Map Size: Sets the size (in Viz units) of the globe or map tiles (all 
together).

• Tessellation: The number of polygons used in the object. The higher the 
number is, the smoother the object is drawn.

• Apply Fade: Uses soft edges for the tiles. When fade is applied it will be 
applied to the outer edges of the selected area which are the outer tile edges. 
The inner edges of the tiles will not be soft. This option is used when trying to 
apply a very large area of the world, in high resolution, over a world map with 
low resolution.

• Fade Range: Defines the fade (softness) size.
• Pyramid Offset: Defines the offset between the pyramid map layers, defined to 

avoid z-drawing problems. Increase the default value if the layers are not 
drawn correctly. Units are 1/10000 cm.

Texture

 Figure 153: Texture tab, Map Tiler editor

• Texture Compression: Sets the compression level for the texture (DTX5 is the 
highest compression level which is less texture quality).

• Texture Quality: When set to Linear the same image resolution will be used in 
the entire zoom range. When set to Mipmap the resolution is changed 
according to the distance from the image (managed automatically in Viz 
Artist).
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Terrain

 Figure 154: Terrain tab, Map Tiler editor

• Build Terrain: Builds terrain data for the created tiles
• Smooth Terrain: Smoothens terrain edges so they blend with the base map 

surface. When enabled (On) the Terrain Smoothing Factor will be enabled.
• Terrain Smoothing Factor: Sets the precentage of the smoothed area.
• Terrain Height Scale: Sets the scaling factor for terrain height. The higher the 

factor is, the more extreme the terrain will be.
• Terrain Resolution: Sets the total terrain reolution for all tiles. A high 

resolution value will result in a more detailed terrain (effecting performance).

Destination

 Figure 155: Destination tab, Map Tiler editor

• Texture Size: Sets the base size for the CWMClients in the scene. Select one of 
the preset sizes or Manual.

• Texture Width: Sets the base texture width (in pixels).
• Texture Height: Sets the base texture height (in pixels).
• Sub Tesseleation - When building Globe objects, this parameter will determine 

the sub tesselation value in the Globe objects.
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Advanced

 Figure 156: Advanced tab, Map Tiler editor

• Map Only: Builds only the map tiles, without adding other Viz Curious Client 
plugins (Navigator, etc.).

Common Buttons
• Map Status: Displays plugin status messages. When configuring the tiles, the 

Map Status field will display the number of tiles required and tile size 
according to the current plugin setup.

• Build Tiles: Build the geo-reference map and tiles.
• Change All Maps: Builds the geographical reference map, tiles and applies 

style changes made in the CWM Client plugin to all child containers 
(recursively) under the MapTiler container.

• Build Maps (Force New): Builds the geographical reference map and tiles 
without checking the cache for existing maps (from the server).

• Change All Maps (Force New): Builds the geographical reference map, tiles and 
applies style changes made in the CWM Client plugin to all child containers 
(recursively) under the Map Tiler container, without checking the cache for 
existing maps (from the server). 

• Calculate Tiles Info: Calculates the tiles information, without building the tiles, 
and displays it in the Map Status field.

12.42 Mute

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) ->Tools.
• Viz Artist 3: Built Ins -> Container Plugins -> Tools.

The Mute plugin is used to determine if a container will be drawn or not. The 
difference between using the Mute plugin and setting the visibility off is that when 
using the plugin only containers with the plugin will not be drawn, but all child 
objects will be drawn and the geometry properties will be used in the hierarchy 
(geographical reference, and so on). When setting the visibility off the entire 
container and its child containers will be set off and not be used in any way.
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This section contains information on the following topics:
• Plugin Description

12.42.1 Plugin Description
 Figure 157: Mute editor

• Draw Geometry: When enabled (On), the geometry will be drawn. When 
disabled (Off), the geometry will not be drawn but its child containers will be 
drawn.

12.43 NavCom

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps_Adv.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps-Adv.

The NavCom plugin is used for controlling the Navigator plugin. The plugin is an 
example showing how to externally control the Navigator plugin when special 
applications should be used to control the scene. An example for a special case 
where external control of the Navigator plugin is required is Elections. When using 
Viz 3.x scripting, complicated logics and commands can be used with the 
NavCom plugin.

This section contains information on the following topics:
• Plugin Description

See Also
• NavCom Scripting

12.43.1 Plugin Description

The NavCom plugin has three tabs; Commands, Control and Advanced.

This section contains information on the following topics:
• Commands
• Control
• Advanced
• NavCom Scripting
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Commands
The Commands tab is used for communicating with the Navigator plugin in means 
of sending formated commands and receiving formated responses from the 
Navigator plugin:

 Figure 158: Commands tab, NavCom editor

The Command text field is where you enter the command. The NavCom plugin 
receives predefined, fixed syntax, commands and returns a reply from the 
Navigator plugin.

The Response field contains the reply returned from the Navigator plugin. The 
format of the reply is defined in the Advanced tab.

The Immediate Response option defines if the command will be sent while typing 
(every change to the command field will sent the command to Navigator), or only 
after pressing the Execute Command button.

The following is a list of commands, example commands and return values:

Mouse To Lon Lat: Converts screen coordinates to Long/Lat values from the map. 
This needs the Navigator plugin.
• Command: MTLL x y
• Response: lon lat

MTLL 360 288

-116.998 38.088

Mouse To Region: Returns the region name in which the given screen coordinates 
reside. This command requires the Navigator plugin.
• Command: MTR x y
• Response: CountryID "Country Name" RegionID "Region Name" 

SubRegionID "Sub Region Name"

MTR 360 288

1000000000003600 "United States of America" 1000000000038901 "Texas" 
1000000000111302 "Atascosa County"

All Fly To commands require the Navigator and the NavFinder plugin. Also set the 
Navigator plugin’s Interactive Anim setting to On (see Miscellaneous).
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Fly To Region ID: Triggers a Navigator animation from the current location to the 
sent region (RegionID).

• Command: FTRID RegionID

FTRID 81000000000F8285

Fly To Country: Triggers a Navigator animation from the current location to the 
sent country (country name).

• Command: FTC "country name"

FTC "united states of America"

Fly To Region: Triggers a Navigator animation from the current location to the 
sent region (Region name).

• Command: FTR "country" "Region"

FTR "united states of America" "Texas"

Fly To Sub Region: Triggers a Navigator animation from the current location to the 
sent sub region (by name).

• Command: FTSR "country" "Region" "Sub Region"

FTSR "united states of America" "Texas" "young county"

Fly To Lon Lat Level: Triggers a Navigator animation from the current location to 
the sent level area (country, region, or sub region) that the long/lat data resides 
in.

• Command: FTLLL lon lat level

FTLLL -116.998 38.088 1

Note: Levels are: 0 = Country, 1 = Region, 2 = Sub Region

Search database: Searches the map database and as a response generates an XML. 
This command requires a running Viz World server.

• Command: SMDB <query>

Search web: Searches the web and as a response generates an XML. This 
command requires a running Viz World server.

• Command: SWEB <query>

Search All: Searches both resources (map database and web) and as a response 
generates an XML. This command requires a running Viz World server.

• Command: SALL <query>
• Shared memory reply: WS_REPLY
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Nearby: Searches locations in the vicinity of the coordinates of your “mouse” and 
as a response generates an XML. This command requires a running Viz World 
server. This command requires the Navigator plugin.

• Command: NEARBY [mouse-x] [mouse-y]
• Shared memory reply: NAV_NEARBY_REPLY

Shared Navigation memory of the Navigator plugin can be activated by setting 
Publish Geo Data to Bounding box or Location. If Bounding box is selected you 
will, in addition to Bounding box data, get Center and Distance data. If Location is 
selected you will, in addition to the Location data, get all the others. If None is 
selected no data is shared.

All can be used with scripting to define e.g. the administration levels the script 
should fetch from the shared data and consequently display it on screen. For 
interactive scenes such as touch screens this can be used for adding graphics to 
maps based on your selection (thereby avoiding to overpopulate the map with 
information).

For testing you can enable the interactive mode by clicking the E button in Viz 
Artist’s Scene Editor.

Navigation location: Shared data holding the current geographic location(s) of the 
Navigator plugin. To enable it, select Publish Geo Data’s Location option. The data 
is updated when the camera is not moving. Navigation location aslo generates an 
XML with the current geographic location(s) (in the same format as SMDB, SWEB, 
SALL and NEARBY). This requires a running Viz World Server.

• Name: NAV_LOCATION_DATA

Navigation bounding box: Shared memory data holding the current (frame by 
frame) geographic bounding box (lat lon) of the Navigator plugin. To enable it, 
select Publish Geo Data’s Bounding box or Location option.

• Reply: NAV_BB_DATA

Navigation center: Shared memory data holding the current (frame by frame) 
geographic center of the Navigator plugin. To enable it, select Publish Geo Data’s 
Bounding box or Location option.

• Reply: NAV_CENTER_DATA

Navigation distance: Shared memory with the current distance to world of the 
Navigator plugin. To enable it, select Publish Geo Data’s Bounding box or 
Location option.

• Reply: NAV_DISTANCE_DATA

Navigation direction: Shared memory with the current pan and tilt direction of the 
Navigator plugin. To enable it, select Publish Geo Data’s Bounding box or 
Location option.

• Reply: NAV_DIRECTION_DATA
Chapter 12: Maps Plugins 213



Control
The Control tab is used to directly control the Navigator plugin by changing the 
values of the parameters 

 Figure 159: Control tab, NavCom editor

• Lon: Sets the longitude value for the Navigator plugin. The Navigator camera 
will move to the specified longitude value. 

• Lat: Sets the latitude value for the Navigator plugin. The Navigator camera will 
move to the specified latitude value. 

• Distance: Sets the Navigator distance from the map. The Navigator camera will 
move to the specified distance value.

• Pan: Sets the pan value of the Navigator camera.
• Tilt: Sets the tilt value of the Navigator camera.
• Interactive Mode: Defines the interactive behavior of Viz. Available modes are 

None, Editor, On-Air, Always.
• None: Disables interactive mode.
• Editor: Enables interactive mode during scene editing. 
• On-Air: Enables interactive mode when Viz Engine is in On Air mode. 
• Always: Enables interactive mode during scene editing and when Viz Engine 

is in On Air mode.
• Minimal Distance: Sets the minimal distance from the map in Viz units.
• Momentum Mode: When set to Linear you can set how much friction should be 

applied to the momentum.

Note: The Navigator control parameters effect the Navigator immediately.

Advanced
The Advanced tab is used for defining the NavCom plugin’s general behavior 
patterns.
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 Figure 160: Advanced, NavCom editor

• Shape File Support: Defines if the NavCom plugin will include shape objects 
information in the respond. The Shape objects must reside under the NavCom 
container. When the Shape File Support is Limited, the plugin will scan the 
shape files below the container. When a command is recieved, the NavCom 
plugin will return, in the response string, information about the shapes that 
overlap the requested data in the command. When the Shape File Support is 
Only, the plugin will scan the shape files below the container. When a 
command is recieved, the NavCom plugin will return, in the response string, 
only the information about the shapes that overlap the requested data in the 
command.

• Limit Picking: Limits the geographical area that the NavCom plugin will 
perform any of the commands on. When Limit Picking is enabled the Limit to 
Country parameter will be enabled.
• Limit to Country: Sets the country name. If the requested data in the 

command does not exist for the defined country area, the command will not 
be executed. Only commands relating to points within the country area will 
be executed.

• Shared Memory Prefix: This parameter should be used when using more than 
one NavCom plugin in the scene, and when using scripting to send and receive 
information from these plugins. In each NavCom plugin, set the Shared 
Memory Prefix to a different prefix (up to four) to distinguish between the data 
sent to each plugin.

• Protocol Mode: Defines the data displayed in the Response field.
• Full: Includes data on names and IDs for countries, regions and sub-

regions.
• Name: Includes data on names for the countries, regions and sub-regions.
• ID: Includes only ID data (as defined in the Viz World Server) for the 

countries, regions and sub-regions.
• Protocol Separator: Defines the separating character between the Response 

data. The defined separator will be used between country and region, region 
and sub-region, and so on.

• Use Quotes: Defines if the response string will be quoted or not.
• Suffix FIPS: Used for USA regions and sub-regions.
• Publish Geo Date: Allows you to publish navigation data to shared memory 

based on your interaction with the graphics scene (e.g. touchscreen or 
mouse). Shared Navigation memory can be activated by setting Publish Geo 
Data to Bounding box or Location. If Bounding box is selected you will, in 
addition to Bounding box data, get Center and Distance data. If Location is 
selected you will, in addition to the Location data, get all the others. If None is 
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selected no data is shared. See the available Navigation data under the 
Commands section.

• Execute Command: When pressed, the defined command will be executed.
• Initialize: This button is used when using shape file support. If the shape 

objects under the NavCom container is changed, press the initialize button to 
re-scan the shape objects.

NavCom Scripting
Viz 3.X scripting ability is a powerful tool for implementing complex logic into a 
scene. In a Navigator scene, NavCom can be used in the scripts to enable such 
advanced Navigator operations. The folowing script example demonstrates how 
to send and receive data from the Navigator plugin through to the NavCom 
plugin.

Example: Script example: main.txt

dim level as Integer
dim ignore as Integer
dim CurCountry as string
dim CurCountryId as string
dim CurState as string
dim CurStateId as string
dim CurCounty as string
dim CurCountyId as string

Sub UpdateCurrent(temp As String)
dim position as Integer
dim temp2 as String
println temp
CurCountryId = temp.left(16)
position = temp.Find("\"")
temp = temp.GetSubstring(position+1,temp.Length-(position+1) )
temp2 = temp
position = temp2.Find("\"")
CurCountry = temp2.Left(position)
println "<" & CurCountryId & "><" & CurCountry & ">" 
position = temp.Find("\"")
temp = temp.GetSubstring(position+2,temp.Length-(position+2) )
CurStateId = temp.left(16)
position = temp.Find("\"")
temp = temp.GetSubstring(position+1,temp.Length-(position+1) )
temp2 = temp
position = temp2.Find("\"")
CurState = temp2.Left(position)
println "<" & CurStateId & "><" & CurState & ">" 
position = temp.Find("\"")
temp = temp.GetSubstring(position+2,temp.Length-(position+2) )
CurCountyId = temp.left(16)
position = temp.Find("\"")
temp = temp.GetSubstring(position+1,temp.Length-(position+1) )
temp2 = temp
position = temp2.Find("\"")
CurCounty = temp2.Left(position)
println "<" & CurCountyId & "><" & CurCounty & ">"

End Sub

Sub OnInit()
ignore = 0 
level = 1 
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if Scene.Map.ContainsKey("MTR") = false  Then 
Scene.Map.CreateKey("MTR")

End If
if Scene.Map.ContainsKey("FTRID") = false  Then 

Scene.Map.CreateKey("FTRID")
End If
if Scene.Map.ContainsKey("FTC") = false  Then 

Scene.Map.CreateKey("FTC")
End If
if Scene.Map.ContainsKey("FTR") = false  Then 

Scene.Map.CreateKey("FTR")
End If
if Scene.Map.ContainsKey("FTSR") = false  Then 

Scene.Map.CreateKey("FTSR")
End If
if Scene.Map.ContainsKey("FTLLL") = false  Then 

Scene.Map.CreateKey("FTLLL")
End If
if Scene.Map.ContainsKey("MTR_REPLY") = false  Then 

Scene.Map.CreateKey("MTR_REPLY")
End If
if Scene.Map.ContainsKey("FTRID_REPLY") = false  Then 

Scene.Map.CreateKey("FTRID_REPLY")
End If
Scene.Map.RegisterChangedCallback("MTR_REPLY")
System.Map.RegisterChangedCallback("REGION_L")
End Sub

Sub OnSharedMemoryVariableChanged(map As SharedMemory, mapKey As 
String) 
println mapKey
dim temp as String
If mapKey = "REGION_L" Then

println "ignore pre"
ignore = 1

else If mapKey = "MTR_REPLY" Then
temp = Scene.Map["MTR_REPLY"]
UpdateCurrent(temp)
println  System.Map["REGION_L"]

if System.Map["REGION_L"] = "1"  then
Scene.Map["FTRID"] = CurCountryId

elseif  System.Map["REGION_L"] = "2"  then
Scene.Map["FTRID"] = CurStateId

elseif  System.Map["REGION_L"] = "3"  then
Scene.Map["FTRID"] = CurCountyId

End If
End If
If mapKey = "MTLL_REPLY" Then 

println Scene.Map["MTLL_REPLY"]
End If
End Sub

sub OnLButtonDown()
dim temp as String
if System.MouseX < (System.RenderWindowWidth: 120 ) then

Scene.Map["MTR"] = (String) System.MouseX & " " & (String)
System.MouseY

end if
end sub
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12.44 NavFade

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The NavFade plugin is used for defining the visibility of an object that the NavFade 
is attached to in a Navigator scene. The Navigator point of view (distance from the 
map) will determine when the object will become visible. The NavFade uses an 
Alpha plugin to control the object’s appearance. The Alpha plugin will be added 
automatically when adding NavFade to the container.

This section contains information on the following topics:
• Plugin Description

12.44.1 Plugin Description

The NavFade plugin has four fade modes; Height,Hops, Distance and Angle.

This section contains information on the following topics:
• Height
• Hops
• Distance
• Angle

Height

The object will fade in or out depending on camera height (above the map).

 Figure 161: Visibility range set to Below, NavFade editor

• Fade Time: Defines the fade transition duration in fields.
• Visibility Range: Defines how the fade point is calculated. Available options are 

Below, Above and Range.
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• Below: The object will be visible when the defined height is heigher than the 
current Navigator distance from the map.

• Above: The object will be visible when the defined height is lower than the 
current Navigator distance from the map.

• Range: The object will be visible between the defined low and high values.
• Set Height: When clicked, the current camera height will be inserted to the 

height field.
• Set Range High: When clicked, the current camera height will be inserted to 

the High range field.
• Set Range Low: When clicked, the current camera height will be inserted to the 

Low range field.

Hops
The object will fade in or out depending on the defined hop point and the 
animation time to/from the selected hop point.

 Figure 162: Hops, NavFade editor

• Fade Time (Fields): Defines the fade transition duration in fields.
• Hop Mode: defines if the NavFade plugin will effect the manually selected hop 

or if the hop will be auto selected when the designs copied by CWM client. 
• Hop To Link: Sets the number of the hop points that NavFade will use as a 

reference. When animating to and from the selected hop, the object will 
appear/disappear.

• Hop and Above: When enabled, all hops which number is higher than the 
selected hop will be considered as the selected hop. defines if the NavFade 
plugin will effect the manually selected hop or if the hop will be selected by 
the NavFade plugin. The Constant option will cause the object to fade on at 
Hop to Link and stay on from that point onwards.

• Time to Hop (%): Sets the point in which the object will appear/disappear. The 
time is set as a percentage of the hop duration.
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Height
The object will fade in or out depending on the height of the camera above the 
map.

 Figure 163: Visibility range set to Below, NavFade editor

• Fade Time: Defines the fade transition duration in fields.
• Visibility Range: Defines how the fade point is calculated. Available options are 

Below, Above and Range.
• Below: The object will be visible when the defined height is heigher than the 

current Navigator height above the map.
• Above: The object will be visible when the defined height is lower than the 

current Navigator height above the map.
• Range: The object will be visible between the defined low and high values.

• Height: Defines the height value that the NavFade plugin will use as the show/
hide point of the object when Visibility Range parameter is set to Below or 
Above.

 Figure 164: Visibility range set to Range, NavFade editor

• Low: Sets the lower value of the height range that the object will be visible in. 
If the current Navigator height is higher than the low value, the object will be 
visible.

• High: Sets the higher value of the height range that the object will be visible 
in. If the current Navigator height is lower than the high value, the object will 
be visible.

• Set Range High: The current Navigator height value will be copied to the High 
parameter. This button will only affect the plugin when Visbility Range is set to 
Range.
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• Set Range Low: The current Navigator height value will be copied to the Low 
parameter. This button will only affect the plugin when Visibility Range is set 
to Range.

Distance
The object will fade in or out depending on the distance from the map.

 Figure 165: Visibility range set to Below, NavFade editor

• Fade Time: Defines the fade transition duration in fields.
• Visibility Range: Defines how the fade point is calculated. Available options are 

Below, Above and Range.
• Below: The object will be visible when the defined distance is heigher than 

the current Navigator distance from the map.
• Above: The object will be visible when the defined distance is lower than the 

current Navigator distance from the map.
• Range: The object will be visible between the defined low and high values.

• Distance: Defines the distance value that the NavFade plugin will use as the 
show/hide point of the object when Visibility Range parameter is set to Below 
or Above.

 Figure 166: Visibility range set to Range, NavFade editor

• Low: Sets the lower value of the distance range that the object will be visible 
in. If the current Navigator distance is higher than the low value, the object will 
be visible.

• High: Sets the higher value of the distance range that the object will be visible 
in. If the current Navigator distance is lower than the high value, the object will 
be visible.
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• Set Distance: The current Navigator distance value will be copied to the 
Distance parameter. This button will only affect the plugin when Visibility 
Range is set to Below or Above.

• Set Range High: The current Navigator distance value will be copied to the 
High parameter. This button will only affect the plugin when Visibility Range is 
set to Range.

• Set Range Low: The current Navigator distance value will be copied to the Low 
parameter. This button will only affect the plugin when Visibility Range is set 
to Range.

Angle
The object will fade in or out depending on the angle between the camera and the 
map.

 Figure 167: Visibility range set to Below, NavFade editor

• Fade Time: Defines the fade transition duration in fields.
• Visibility Range: Defines how the fade point is calculated. Available options are 

Below, Above and Range.
• Below: The object will be visible when the defined angle is heigher than the 

current Navigator angle between the camera and the map.
• Above: The object will be visible when the defined angle is lower than the 

current Navigator angle between the camera and the map.
• Range: The object will be visible between the defined low and high values.

• Angle: Defines the angle value that the NavFade plugin will use as the show/
hide point of the object when Visibility Range parameter is set to Below or 
Above.
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 Figure 168: Visibility range set to Range, NavFade editor

• Low: Sets the lower value of the angle range that the object will be visible in. If 
the current Navigator angle is higher than the low value, the object will be 
visible.

• High: Sets the higher value of the angle range that the object will be visible in. 
If the current Navigator angle is lower than the high value, the object will be 
visible.

• Set Angle: The current Navigator angle value will be copied to the angle 
parameter. This button will only affect the plugin when Visibility Range is set 
to Below or Above.

• Set Range High: The current Navigator angle value will be copied to the High 
parameter. This button will only affect the plugin when Visibility Range is set 
to Range.

• Set Range Low: The current Navigator angle value will be copied to the Low 
parameter. This button will only affect the plugin when Visibility Range is set 
to Range.

Movement

 Figure 169: Fade Invert set to Off, NavFade editor

Alpha values will fade on/off based on if Navigator is currently moving or 
stationary.

12.45 NavFinder

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps.
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• Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The NavFinder plugin is used for setting hop points over a given map. The 
NavFinder must reside under a Navigator plugin container and a map.

This section contains information on the following topics:
• Plugin Description

12.45.1 Plugin Description
• Hop Point: Sets the hop point in the hop sequence. Note that the animation 

will be built in the same sequential order as the list of Hop Points (Map-Start, 
Destination-1, Destination-2, and so on). If two hops use the same Hop Point, 
the animation will not work properly.

• Position Source: This parameter defines how the hop location will be set. 
Available options are Map, Absolute, 3D Region and Link.

• Goto Map: Jumps to the defined hop point on the map.
• Take Current Values: Takes the current position and uses that as the hop 

position. This option is normally used with interactive mode in the Navigator 
plugin. The user moves the object to the required position and sets the values 
for the NavFinder.

• Fly To Map: Creates an instant animation and run from the current map 
location to the current hop point defined by the NavFinder plugin. This feature 
is active only if the Interactive Anim parameter in the Navigator plugin is 
enabled (On). 

• Get Map: The user can navigate manually to any destination and by pressing 
the Get Map button, the currently viewed map will be used. CWMclinet must be 
on the same container and if a pyramid plugin is used, the pyramid layers will 
be built.

• Add Linked Hop: Adds a hop (container with NavFinder set to Link) under the 
current NavFinder container. See Link tab description for more information.

Tip: Take Current Values can be used in interactive mode. The user can position 
itself using the mouse and then tell NavFinder to use the current values.

This section contains information on the following topics:
• Map
• Absolute
• 3D Region
• Link
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Map

 Figure 170: Map, NavFinder editor

The Position Source Map uses the current location from the map (center of the 
screen values) and adds offsets for fine tuning.
• Fit To Screen By: Defines what the end frame of the animation (hop) will be. 

When the hop is defined as a 3D Region object on the map, the animation will 
end when the bounding box of the object fills the frame. Available parameters 
for defining how the bounding box will be calculated are Width, Height, Min, 
Max and Average.
• Width: Uses the width of the object’s bounding box to calculate the last 

frame of the hop animation.
• Height: Uses the height of the object’s bounding box to calculate the last 

frame of the hop animation.
• Min: Uses the minimal value between the width and the height of the object 

to calculate the last frame of the hop animation. 
• Max: Uses the maximal value between the width and the height of the object 

to calculate the last frame of the hop animation.
• Average: Uses the average value between the width and the height of the 

object to calculate the last frame of the hop animation.
• Longitude offset: Defines Longitude offset based on the current position.
• Latitude offset: Defines Latitude offset based on the current position.
• Distance offset (%): Changes the distance zoom from the map (zoom in or 

out).
• Pan: Sets a pan value for the camera.
• Tilt: Sets a tilt value for the camera.

Note: Pan and Tilt parameters will be disabled unless the Pan & Tilt Animation 
parameter in the Navigator plugin is enabled (On).
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Absolute

 Figure 171: Absolute, NavFinder editor

Absolute sets the Longitude and Latitude values of the hop point location. 
Changes the Distance and Distance Zoom parameters:
• Longitude: Defines the Longitude for the hop position.
• Latitude: Defines the Latitude for the hop position.
• Distance: Changes the distance from the map.
• Pan: Sets a pan value for the camera.
• Tilt: Sets a tilt value for the camera.

Note: Pan and Tilt parameters will be disabled unless the Pan & Tilt Animation 
parameter in the Navigator plugin is enabled (On).
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3D Region

 Figure 172: 3DRegion, NavFinder editor

3D Region uses the current location from the 3D Region plugin (center of the 
region values). Add offsets for fine tuning.

See the Map section for references to the Position Bounding Box, Offset, Distance, 
Pan and Tilt parameters.

Note: Pan and Tilt parameters will be disabled unless the Pan & Tilt Animation 
parameter in the Navigator plugin is enabled (On).

Link

 Figure 173: Link, NavFinder editor

The Link mode is used when one hop resides as a child of another hop. the child 
hop is set to link. When changing the top hop, the child hop will change 
accordingly, maintaining the same animation that was created during the design.
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In Country and Region mode the navigator position will be based on the country 
or region where the destination (link source) is, whereas in Level up mode the 
navigator position will be one administration level (e.g. Place is leveled up to 
Town) above the destination (link source). In Country, Region and Level Up mode 
you have the following settings:
• Distance Offset: Sets an offset from the calculated distance after the top hop 

was changed.
• Pan Offset: Sets an offset from the calculated pan after the top hop was 

changed.
• Tilt Offset: Sets an offset from the calculated tilt after the top hop was 

changed.

In Interpolation mode you have the following setting:
• Interpolation: Navigator position will interpolate between the gap above and 

below (useful for a drill down with a pause in the middle)

In Offset mode you will have the following settings:
• Longitude Offset: Sets an offset from the calculated hop longitude location 

after the top hop was changed.
• Latitude Offset: Sets an offset from the calculated hop latitude location after 

the top hop was changed.
• Min Distance/Max Distance: Sets the minimum and maximum distance from 

the map. Using the same parameters for both settings gives you a fixed 
distance.

See the Map section for references to the Position Bounding Box, Offset, Distance, 
Pan and Tilt parameters.

12.46 Navigator

The plugin can be found in the following folders:
228 Chapter 12: Maps Plugins



• Viz Artist 2: Function -> Container (button) -> Maps.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The Navigator plugin enables the user to create realistic animations from one 
point to another on the map (for example fly over a flat map or globe). It is also 
used for navigating on a map (moving the camera) to a defined location using pan 
and tilt values.

This section contains information on the following topics:
• Plugin Description

12.46.1 Plugin Description
The plugin has four main plugin editor views; Camera, Animation, Miscellaneous 
and Advanced. In addition the plugin has two common features that applies for all 
editor views.

Note: Only containers with a NavFinder plugin will be refreshed.

This section contains information on the following topics:
• Camera
• Animation
• Miscellaneous
• Advanced
• Common Buttons
• Known issue(s)

Camera

 Figure 174: Camera (Position), Navigator editor

The Position button displays the camera position parameters.
• Camera: Defines the camera that will be affected by the position parameters. 
• Longitude: Defines the Longitude camera position on the map/globe.
• Latitude: Defines the Latitude camera position on the map/globe.
• Distance: Defines the Camera distance from the map.
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• Pan: Defines the Camera pan value.
• Tilt: Defines the Camera tilt value

 Figure 175: Camera (Advanced), Navigator editor

The Advanced button displays the advanced camera parameters.
• Roll: set the roll value of the camera. This parameter is enabled only if the 

Keep The Horizen Horizontal parameter is set OFF.
• Keep The Horizen Horizontal: When set on the horizon will always be 

horizontal and  roll movement will allow animation.
• Clipping Plane Control: Defines the distance range that will be drawn by the 

camera. Objects located closer to the camera than the Near parameter and 
objects located farther that the Far parameter will not be drawn. 
• Static (Viz): Draws the objects within the clipping plane values defined in 

Viz. For Viz 2.x see Setup->Camera->Camera Clipping Plane. For Viz 3.x 
see Scene Settings->Renderer->Camera Clipping Plane.

• Navigator: Adjusts the clipping plane values according to the camera 
position. This is automatically done by the Navigator plugin based on the 
Near Distance and Far Distance parameters.

• Near Distance (%): Defines the percentage of the camera distance from the 
map, which will be used as the Near distance of the clipping plane. 

• Far Distance (%): Defines the percentage of the camera distance from the map, 
which will be used as the Far distance of the clipping plane.
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Animation

 Figure 176: Animation,Basic (Pause Points), Navigator editor

The Animation button displays the camera animation parameters. There are two 
parameter tabs: Basic and Advanced.

The Basic tab:

• Number of Hop Points: Sets the number of key frames (hops) used in the 
animation.

• Hop Duration Mode: Defines the time gap between two key frames.
• Fixed: Uses the same duration as set in the Hop Duration parameter for all 

hops.
• Auto: Automatically calculates the duration of the animation between hops. 

Minimal hop duration will be based on the Hop Duration parameter and the 
Hop Min Time parameter.

• Manual: Disables the Hop Duration parameter. Enables the user to set hop 
duration manually in the stage editor.

• Hop Duration: Sets the animation length, between one hop to another, in 
seconds.

• Hop Min Time (%): Sets a minimal time for each hop when Hop Time Mode is 
set to Auto.

• Stop Type: Defines the animation behavior at each hop.
• Disabled: Enables the animation to only use stage properties.
• Stop Points: Enables the animation to stop at each hop point and wait for a 

continue command.
• Pause Points: Adds a pause point to each hop. An additional parameter, 

Pause Time, will be added to define the pause length in seconds.
• Flyover: Simulates a flight pass over the hop points in a spline path, using 

the Flyover Minimal Height parameter. When selected, additional 
parameters will be enabled.

• Per Hop: The user will set the hop stop type in the navFinder pluing. 
different stop types can be set per different hops.
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 Figure 177: Animation,Basic (Flyover), Navigator editor

• Flyover Path Profile (Stop Type is set to Flyover): Defines flying curve profile 
(curvature) of animation path.

• Lag On Point: Similar to "Flyover Path Profile" button, but defines timing 
profile of the flyover animation.

• Flyover Minimal Height: Sets the minimum flyover height in centimeters.
• Stop At First Hop: Defines whether a stop point will be added to the first hop 

(the beginning of the animation). The parameter is enabled only when using 
Stop Points or Pause Points as the Stop Type value.

• Pan & Tilt Animation: Enables or disables the pan and tilt values of the camera 
of each hop in the animation. When enabled (On) this setting will enable the 
Pan and Tilt values for the NavFinder plugin.

• Progress Profile: Defines timing profile between stop points  of animation. 
Smooth option causes the animation to ease in and out of hop points.
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 Figure 178: Animation,Advanced, Navigator editor

The Advanced tab:
• Preferred Flight Height: Defines the camera height that will be used in the 

animation between the hops.
• Preferred Flight Style: Defines the camera movement between the hops.

• Zoom: Enables linear movement from hop point to the high point and back 
into the next hop point.

• Auto: Calculates the movement according to distance, height, and so on.
• Flyover: Enables a smooth movement from one hop to another.

• Preferred Landing: Defines the animation behavior when approaching the hop 
points.
• Helicopter: Uses a steeper approach to the hop point.
• Auto: Calculates the approach according to distance, height, and so on.
• Airplane: Uses a flatter approach to the hop point.

Note: The drifting options allow camera pan and tilt drifting during the animation. 
This option is used to give the animation movement a kind of satiate feeling.

• Drifting Pan Time (Frames): Defines the time to complete a full turn of the pan.
• Drifting Tilt Time (Frames): Defines the time to complete a full turn of the tilt. 
• Drift Phase Shift (%): Defines the offset between the pan movement and the tilt 

movement.
• Stop Drifting: Defines if the drifting should stop at the start point or during 

stop points. If Never is selected drifting will not stop.
• Flight Direction: force the direction of the flight. Default is the shortest route 

to the next hop. If East or West is selected, flight route will be set according to 
the selected option.
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Miscellaneous

 Figure 179: Miscellaneous (Interactive), Navigator editor

The Miscellaneous button displays the editor view for setting interactivity and 
label related parameters.
• Interactive Mode: Defines the interactive behavior of Viz. Available modes are 

None, Editor, On-Air, Always Fly To and On “i”.
• None: Disables interactive mode.
• Editor: Enables interactive mode during scene editing.
• On-Air: Enables interactive mode when Viz Engine is in On Air mode.
• Always: Enables interactive mode during scene editing and when Viz Engine 

is in On Air mode.
• Fly To: Defines destination properties. Available Fly To options in Interactive 

mode are Country, Region, Sub Region and Home. Country makes the 
camera animate to the country in which the mouse was clicked. Animation 
will stop when the camera reaches a distance from the country as defined by 
the Extra Zoom Country parameter. Region makes the camera animate to 
the region in which the mouse was clicked. Animation will stop when the 
camera reaches a distance from the region as defined by the Extra Zoom 
Region parameter. Sub Region makes the camera animate to the sub region 
in which the mouse was clicked. Animation will stop when the camera 
reaches a distance from the sub region as defined by the Extra Zoom Sub 
Region parameter. Home makes the camera animate to the position defined 
by the Home Lan, Home Lat and Home Distance parameters.

• On “i”: Enables interactive mode during scene editing and when Viz Engine 
is in On Air mode, when pressing the “i” key while using the mouse to 
navigate.

• Interactive Anim: When enabled (On), user activated animation from the 
current map position to the current selected hop is enabled. This animation is 
triggered by the user in the NavFinder plugin, by pressing the Fly To Map 
button. The Fly To option will enable the user to select a point on the map, by 
clicking the mouse, and the animation will run from the current camera 
position to the selected point.

• Extra Zoom Country: Defines the extra zoom value added to the camera 
animation when animation destination is a country. The camera will zoom in 
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to the selected country until the bounding box of the country will fill the 
render window. The extra zoom will define an additional zoom value to the 
final camera position calculations. 

• Extra Zoom Region: Defines the extra zoom value added to the camera 
animation when animation destination is a region. The camera will zoom in to 
the selected region until the bounding box of the region will fill the render 
window. The extra zoom will define an additional zoom value to the final 
camera position calculations. 

• Extra Zoom Sub Region: Defines the extra zoom value added to the camera 
animation when animation destination is a sub region. The camera will zoom 
in to the selected region until the bounding box of the sub region will fill the 
render window. The extra zoom will define an additional zoom value to the 
final camera position calculations. 

• Home Lon: Defines a longitude value for a home point.
• Home Lat: Defines a latitude value for a home point.
• Home Distance: this parameter defines a distance from a home point.

 Figure 180: Miscellaneous (Labels), Navigator editor

• Labels: Defines the label behavior. The Labels setting will override all labels (in 
all levels of the hierarchy) under the navigator container.
• Overlay: Places labels on a plane in front of the map (see Label It for 

description). When this mode is selected an additional parameter will 
enabled, Label Camera, which defines the camera to be used for the labels.

• On Map: Places labels on the map.
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Advanced

 Figure 181: Advanced, Navigator editor

The Advanced button displays additional animation parameters.
• Helicopter Lift Duration: Sets the time, in seconds, for the helicopter to go out 

from a hop point to the high point in the middle.
• Helicopter Smooth Level: Sets the animation smoothness between one hop to 

another. This parameter will affect the animation path when a helicopter flight 
is simulated.

• Airplane Smooth Level: Sets the animation smoothness between one hop to 
another. This parameter will affect the animation path when a Airplane flight is 
simulated.

• Tilt Smoothing: This parameter is enabled when the Pan & Tilt parameter in 
the animation tab is enabled. When set to On, an additional parameter, Tilt 
Smoothing Rate, is enabled. Set the required smoothing value for the tilt 
animation,

• Height Mode: Defines how the camera distance from the map during the 
animation and at the hop points will be calculated:
• Regular: Sets the height that is calculated by the Navigator plugin based on 

the hop locations and distance from map as set by the user.
• Fixed: Sets a fixed height for the camera while animating between the hops 

and at the hop point. When set to fixed, User selected distance at the hop 
point is ignored.

• Minimal: Sets the minimal height to which the camera will descend at the 
hop points and during the animation. If the calculated distance is larger 
than the minimal value, the camera will use the calculated distance.

• Min Height: Sets the minimal height value.
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• Update Stage in OnAir: Defines if the stage will jump to the hop position when 
updating a map in OnAir mode.

Common Buttons
• Calculate Animation: Re-builds the animation between the hops using the 

parameters defined in the plugin.
• Center Map: Aligns the center of the map with the center of the screen. 
• Refresh All Maps: The Navigator plugin will search its sub-tree for containers 

with CWMClient and NavFinder and refresh the CWMClients maps. 

Known issue(s)
• Rotation, scaling and translation above the Navigator container might affect 

the plugin behavior. Do not apply any rotations above the container in the 
hierarchy and use only the pan/tilt parameters of the plugin to control the 
orientation of the camera.

12.47 NavScale

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The NavScale plugin maintains the scale of an object,related to the screen, during 
the Navigator animation. The plugin is placed on a child container under the 
Navigator plugin, and it will maintain the its defined scaling throughout the 
animation.

This section contains information on the following topics:
• Plugin Description

12.47.1 Plugin Description
 Figure 182: NavScale editor

• Scale On Distance Factor: Sets the value of the Scale On Distance Factor 
parameter to the required number by modifying the scale factor and checking 
the result in the renderer.

Note: This factor does not use any measurment units, but it calculates the object’s 
scaling using a number of parameters from the Navigator plugin.
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12.48 NavSlave

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps-Adv.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps-Adv.

The NavSlave plugin creates a relation between its container and a Navigator 
plugin container in the scene. This plugin will lock the NavSlave container to the 
longitude and latitude values of the Navigator plugin. The plugin will search the 
hierarchy above it for the navigator container.

This section contains information on the following topics:
• Plugin Description

12.48.1 Plugin Description
 Figure 183: NavSlave editor

• Altitude: Defines the altitude of the object in relation to the Navigator 
container.

• Tangent To Globe– When enabled (On) sets the object to move over the globe 
surface.

12.49 Place Finder

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps-Adv.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps-Adv.

The plugin is used to generate a map or map animation without having to actually 
select the map, but using “rules” in order to define what map will you get.

There are two ways of selecting a map location. The first is simply by entering 
longitude and latitude values, whereas the second is based on searching the map 
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database for the location and using the first value (that was ranked the highest). 
Since you as a user cannot select the final location out of a list it is important to 
enter more information in order to make sure you the correct location is found.

If you are looking for Paris in Texas, USA, and you are simply entering “Paris” you 
will end up in Paris, France because the capital of France is ranked the highest. 
Searching for “Paris USA” will give you a town named Paris in the USA; however, 
searching for “Paris TX USA” or “Paris Texas” will give the result you are looking 
for.

This section contains information on the following topics:
• Plugin Description

12.49.1 Plugin Description

• Longitude: Map center Longitude. Changing the value will not affect the map 
until you hit “Take”.

• Latitude: Map center Latitude. Changing the value will not affect the map until 
you hit “Take”.

• Longitude/ Latitude: Map center Longitude and Latitude in one field (very 
useful for external control). Changing  the value will not affect the map unless 
the last character  is ‘;’.

• Location: Map location to search for. Changing the value will not affect the 
map unless the last character is ‘;’.

• Frame by location: If the location option is used should the map be framed by 
the location found?

• Label location: Should a label be added to the map based on the location 
found? Short will only add the location name, while Long will add more 
information (e.g. country and so on).

• Default map size: Default map size to use when that option is selected in 
“frame by” or if for any reason the other methods have failed.
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• Frame map by: How the map should be framed. This option is relevant if the 
map center is based on longitude and latitude values (and not a search 
location), or if the “Frame by location” is disabled (Off).
• Default size is based on default map size.
• Country, Admin1, Admin2 is first trying to find the relevant information 

(e.g. country and so on) and will fail for example if map center is in the sea. 
Next it will use the bounding box of the user selection (please read about 
the Texas example in the Place Finder introduction section).

• If the user selects Admin2 the map’s frames will be based on Lamer County 
which is Admin2 in that specific Longitude and Latitude.

• If user selects Admin1 the map’s frames will be based on Texas which is 
Admin1 in that specific Longitude and Latitude.

• If user selects Country1 the map’s frames will be based on USA which is the 
country for that specific Longitude and Latitude

• Scale Factor: A factor on frame by percentage
• Place Label: Should a text be added to the location? 
• Place text: Text to add (floods, fire, festival)  by default Default_design  will be 

used. In order to use a different design you can use a pipe symbol ( | ) as 
separator, e.g. “Fire|Fire in LA” will use a design named Fire and the text will 
be Fire in LA. Changing the value will not affect the map unless the last 
character  is ‘;’.

• Region Labels: Should labels for region be added? Relevant only when “Frame 
map by” is set to one of the region types (i.e. Region/Country/Admin1/
Admin2/Sub_region).

• Label designs: Location for Label designs. Normally the plugin resides next to 
CWM client plugin and it will use its designs, or the global designs.

• Label Holder: Location for Label holder. Normally the plugin resides next to 
CWM client plugin and it will use its holders, or the global holders.

• Long Region Names: When disabled (Off) it will only add the region name. 
When enabled (On) it will add more information (e.g. country and so on).

• 3DRegions: Should 3D regions be added? Relevant only when “Frame map by” 
is set to one of the region types (i.e. Region/Country/Admin1/Admin2/
Sub_region).

• 3DRegion Designs: Location for 3D region designs. Normally the plugin 
resides next to CWM client plugin and it will use its designs, or the global 
designs.

• 3DRegions Holder: Location for 3D region holder. Normally the plugin resides 
next to CWM client plugin and it will use its holders, or the global holders.

12.50 Publish To Design

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps-Adv.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps-Adv.
240 Chapter 12: Maps Plugins



Enables updated parameters to be set directly to the design they came from 
(either container hierarchy or object pool) by pressing Publish To Design or create 
a new design out of modified data by assigning a new name under the New 
Design tab.

This section contains information on the following topics:
• Plugin Description

12.50.1 Plugin Description
 Figure 184: New Design, Publish To Design editor

• Publishing Target: Publish using the original design or create a new design.
• Design Name: Sets the new name for the new design or select a design from 

the Designs list.
• Publish And Refresh: Sends the label back to where i came from and refreshes 

the scene.

12.51 Pyramid Control

The plugin can be found in the following folders:
• Viz Artist 2: Object -> Built in.
• Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The purpose of the Pyramid Control geometry plugin is to sort overlapped layers 
of the pyramids in the scene such that tiles with higher resolution will not be 
hidden by tiles with lower resolution

Note: Plugin must be located somewhere in the hierarchy of the MapTiler plugin.

This section contains information on the following topics:
• Plugin Description
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12.51.1 Plugin Description
 Figure 185: Enabled, Pyramid Control editor

• Color Correction: Defines if and how the color correction will be applied to 
pyramid layers.
• Disabled - No color correction is applied.
• Simple - An automatic color correction will be applied to pyramid layers.
• Advanced - Color correction will be applied according to user selection

• Histogram Key Out Mode: To apply a proper color correction, the histograms 
of the tiles should be calculated and the sea areas should be keyed out 
(removed) from the calculation. This parameter defines the method to key out 
the sea areas during color correction calculations:
• None - Nothing is keyed out
• Color - The keying is based on the key color selected in the Sea Color 

control, Key Color Threshold and Key Color Attack parameters.
• Alpha - The keying is based on the alpha channel in the map image
• Color and Alpha - both of the previous criteria are used during key 

calculations.

Note: The sea area defined in the Histogram Key Out Mode is not removed from the 
map image during rendering. It is only removed for color correction calculations.

• Render Key Out Mode: This parameter defines the method to key out the 
sea areas from rendering. Modes are the same as in Histogram Key Out 
Mode.

• Sea Color: Sets the color of the sea usedfor keying and color correction 
calculations.

Note: The alpha value in this case has no effect (it is only a standard property of the 
color component).

• Key Color Threshold: The range of colors around the selected Sea Color that 
will be keyed out. threshold of the keying. The color values in the range 
[Color_value - Threshold_value, Color_value + Threshold_value] will be keyed 
out

• Key Color Attack: This parameter defines the blending range of the key edges. 
The heigher the Attack value is, the softer the key edge will be.

• Refresh All Pyramids: Apply the new settings to all pyramid layers.
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12.52 Region Halo

The plugin can be found in the following folders:
• Viz Artist 2: Object -> Built in.
• Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

The RegionHalo plugin is used to create a halo around 3D Region objects. The 
plugin is used in the region design hierarchy with the 3D Region plugin. The 
plugin and the 3D Region objects are placed under a group called ‘region’, while 
the RegionHalo object is above the 3D Region object.

Note: The halo effect does not work with 3D Region’s extrusion setting(s).

This section contains information on the following topics:
• Plugin Description
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12.52.1 Plugin Description
 Figure 186: RegionHalo editor, Simple

There are two UI modes: simple and advanced. Simple displays the most common 
parameters for manipulating the region’s halo. Advanced displays all parameters 
for manipulating the region’s halo.

• Relative Width: Defines the halo width, relative to the region object’s size.

 Figure 187: RegionHalo editor, Advanced

• Stencil: Defines if the defined mask channel will be used when drawing the 
halo (ON), or if no masking will be used (OFF). When using a channel, the halo 
shape will follow the object’s shape more accurately.

• Stencil Channel: Defines which of the mask channels will be used for the halo 
(Scene Settings->Global Settings). 

WARNING! Default value is channel 6 (inverted), since Viz uses channels 7 and 8 for 
shadows. This parameter is used in a scene which makes intense use of object 
masks, and the mask channels may collide.

• Wireframe: Draws a wireframe of the halo (for debug purposes).
• Number of Biggest Polygons To Show: Defines the number of regoin areas that 

the halo will be applied to. If the selected region consists of islands, then this 
value will define which island and the number of islands that the halo will 
apply to.

• Refresh: Redraws the halo when changing the parameter values.
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12.53 Region Halo Shader

The plugin can be found in the following folders:
• Viz Artist 3: Built Ins -> Shader Plugins -> Maps.

The RegionHaloShader is applied automatically when using the Region Halo 
plugin.

Note: The plugin has no user interface.

12.54 Screen Scale

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps-Obs.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps-Obs.

CAUTION! The ScreenScale plugin is no longer supported (discontinued) and should 
not be used. The plugin is installed for compatebility reasons only. The NavScale 
plugin should be used instead of the ScreenScale plugin.

The ScreenScale plugin is used in order to keep an object in the same size 
regardless of the camera movement.

This section contains information on the following topics:
• Plugin Description

12.54.1 Plugin Description
 Figure 188: Screen Lock (Off), Screen Scale editor

• Screen Lock: Defines the way the screen and the ScreenScale object interact:
Chapter 12: Maps Plugins 245



• Off: Scales the object holding the ScreenScale plugin normally with camera 
movement. When enabled (On) the Camera parameter is made available.

• Camera: Defines the camera for which the object will keep its scale when the 
camera is moved.

 Figure 189: Screen Lock (Size Lock), Screen Scale editor

• Size Lock: Locks the object scaling, and sets the Scale Factor to resize the 
object while keeping the scale fixed.
• Scale Factor: Sets the scale factor.

 Figure 190: Screen Lock (Pixel Lock), Screen Scale editor

• Pixel Lock: Locks the object according to the defined number of pixels by the 
Lock Size (px) parameter, by Width or by Height.
• Lock Size (px): Sets the number of pixels for the Pixel Lock.

CAUTION! The ScreenScale plugin is no longer supported (discontiued) and should 
not be used. The plugin is installed for compatebility reasons only. The NavScale 
plugin should be used instead of the ScreenScale plugin.

12.55 Shadow Agent

The plugin can be found in the following folders:
• Viz Artist 2: Object -> Built in.
• Viz Artist 3: Built Ins -> Geom Plugins -> Maps.

Shadow Agent is an agent for the Shadows parameters covered by the scene 
plugin Label Manager.

This section contains information on the following topics:
• Plugin Description
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12.55.1 Plugin Description
 Figure 191: ShadowAgent UI

Render With Camera - this parameter defines for which camera shadows will 
apply:

• All - shadows will be rendered on all cameras (Compatible with previous 
versions).

• Label - shadows are rendered only for the defined off screen labels camera.
• Map - shadows are rendered only for the defined map camera.
• Shadow - shadows are rendered only for the defined shadows camera, as 

defined in the 3DLabelsManager plugin (Shadows tab).

12.56 Trace It

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Maps.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The TraceIt plugin is used to place the 3D object it is attached too over a line, 
created with the 3D Line plugin, and follows the line’s end point. The object will 
follow the line animation as the object with the TraceIt plugin move with the 3D 
Line end point.

This section contains information on the following topics:
• Plugin Description

12.56.1 Plugin Description
The TraceIt plugin has three options; General, Camera and Advanced.

This section contains information on the following topics:
• General
• Camera
• Advanced
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General

 Figure 192: General tab, Trace It editor

• Progress: Indicates the animation position of the 3D Line object. This field is 
disabled and cannot be modified.

• Height: Defines the 3D object’s height in relation to the 3D Line object.
• Smooth Direction (%): Defines the object’s motion behavior when changing 

direction. When set to a low value the direction will change faster.
• Quality: Tells the plugin which resolution to track when tracing a border that 

by default has 3 levels of detail (LOD). Available options are High, Medium and 
Low.

• 3DLine: Defines the 3D Line container that the Trace It plugin will follow.
• Previous: Follows the animation of the 3D Line plugin in the previous 

container.
• Above: Follows the animation of the 3D Line plugin in the above container.
• Container: Follows the animation of the 3D Line plugin in the container 

dragged to its container place holder.
• Progress Control: Defines how the object’s progress will be controlled:

• None: The progress id manually created by the user (stage animation).
• Navigator: Follows the animation of the Navigator plugin.
• Slave: Slave to the 3Dline plugin which is the source of the trace.
• Master: control the 3D line plugin progress which is the source of the trace.
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Camera

 Figure 193: General tab, Trace It editor

The Camera tab defines the mode for camera tracing.
• Progress: Indicates the animation position of the 3D Line object. This field is 

disabled and cannot be modified.
• Trace Camera: Manually driven (standalone) or control a navigator's animation 

between a specified hop and the corresponding one. Available options are Off, 
Navigator, Standalone, General and Locks.

• Off: No camera tracing.
• Navigator: trace the camera animation between the selected hop and the 

following hop. 
• General: the general tab defines the tracing parameters:

• Smooth Camera Position (%): Smooth camera position path
• Smooth Camera Direction (%): Smooth camera direction path
• Start Hop: Select a hop in the Navigator animation. The camera trace will be 

inserted between the selected hop and the next one.
• Update Hop Data: updates data in NavFinder plugins where the camera trace 

is inserted (actually sets start and end values of the tracing route to insert 
camera trace smoothly to the navigator animation).

• Locks: the locks tab enables the user to lock camera animation parameters:
• Lock Pan: when set ON, the camera pan will follow the path direction. When 

set Off, pan animation will be use the navigator parameters.
• Pan Offset: Set the pan offset to path directions.
• Lock Tilt: when set ON, the camera tilt will follow the path direction. When 

set Off, tilt animation will be use the navigator parameters.
• Tilt Offset: Set the tilt offset to path directions 
• Lock Distance: when set ON, the camera distance from the map during the 

animation will be use the Distance parameter value. When set Off, the 
distance during the animation will use the navigator parameters.
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• Distance: Set the distance to use during the animation.
• Standalone: trace the camera animation between the selected hop and the 

following hop. 
• General: the general tab defines the tracing parameters:

• Smooth Camera Position (%): Smooth camera position path
• Smooth Camera Direction (%): Smooth camera direction path

• Locks: the locks tab enables the user to lock camera animation parameters:
• Lock Pan: when set ON, the camera pan will follow the path direction. When 

set Off, pan animation will be use the navigator parameters.
• Pan Offset: Set the pan offset to path directions.
• Lock Tilt: when set ON, the camera tilt will follow the path direction. When 

set Off, tilt animation will be use the navigator parameters.
• Tilt Offset: Set the tilt offset to path directions 
• Lock Distance: when set ON, the camera distance from the map during the 

animation will be use the Distance parameter value. When set Off, the 
distance during the animation will use the navigator parameters.

• Distance: Set the distance to use during the animation.

Advanced

 Figure 194: Advanced, Trace It editor

• Segmentation: When tracking, a line can be split into different segments (for 
example a region might have several islands) the segmentation option tells 
the Trace It plugin what segment to track. Available options are Auto, Largest, 
Sectioned and All.

IMPORTANT! Maximum number of line segments are 10000. Shape files that exceed 
this limit will result in lines not being drawn.

• Overlay: Transfers the object from a position on the actual map to a position 
in a different camera (similar to the Label It plugin’s Overlay options).

12.57 World Image Refresh

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Weather.
• Viz Artist 3: Built Ins -> Container Plugins -> Weather.
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The WImageRefresh plugin is placed on a map container and when the map is 
changed the WImageRefresh plugin will refresh objects residing under the map 
container. This action will cause all the geographically referenced objects, under 
the map container, to recalculate their position and move to the correct position 
according to the new map.

This section contains information on the following topics:
• Plugin Description

12.57.1 Plugin Description

The World Image Refresh plugin has no parameters.

12.58 World Position

The plugin can be found in the following folders:
• Viz Artist 2: Function -> Container (button) -> Maps.
• Viz Artist 3: Built Ins -> Container Plugins -> Maps.

The WPosition plugin is used to place an object over a geographically referenced 
map by setting the Longitude, Latitude and Altitude parameters. When the object 
is moved over the map, the current values of Longitude, Latitude and Altitude will 
be updated in the WPosition plugin. The object with the WPosition plugin must be 
placed under a map in the hierarchy.

This section contains information on the following topics:
• Plugin Description
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12.58.1 Plugin Description
 Figure 195: World Position editor

• Longitude: Sets the parameter to the requested Longitude. The object will 
move over the map to the requested location. Another option is to move the 
object and read its Longitude value from this field.

• Latitude: Sets the parameter to the requested Latitude. The object will move 
over the map to the requested location. Another option is to move the object 
and read its Latitude value from this field.

• Altitude: Sets the parameter to the requested Altitude. The object will move 
over the map to the requested location. Another option is to move the object 
and read its Altitude value from this field.

• Tangent To Globe: When enabled (On), this parameter will always keep the 
object parallel to the globe surface. The parameter is enabled when the 
WPosition plugin is placed in a child container of a container with a Globe 
plugin.

• Update Long/Lat From Position: Gets the current container location and 
updates the Longitude, Latitude and Altitude parameters:
• Auto: Updates the  Longitude and Latitude values when a new position is 

dragged over the container and never again.
• Never: Never updates the object’s position, only Longitude and Latitude 

values are updated.
• Always: Always  check the object’s position and update WPosition when it 

changes.
• Follow Terrain - The height (Altitude) will be read from the terrain in case of a 

terrain geometry.
• Longitude Offset: Positions the object at a given offset from the actual 

Longitude.
• Latitude Offset: Positions the object at a given offset from the actual Latitude.
• Move to Map Center: When clicked, the object will move to the center of the 

parent map.
• Update Lat/Long From Container Position: When clicked, the Latitude and 

Longitude position parameters will be updated.: 
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13 Geographically Referenced Maps
 Figure 196: Geo Maps, Viz Artist 3.x.

CWM Client plugin produces geographical maps (geo maps). Geo maps are images 
of maps that are geographically referenced (that is the image contains 
information about its longitude and latitude).

 Figure 197: Geo Maps icon, Viz Artist 2.x.

Geo maps are identified by a little globe icon next to the image icon. Containers 
that will be placed under the GeoMap container and using geographic data 
referencing will be placed relatively on the GeoMap.

Note: Do not modify the image properties.

Do not scale, rotate or change the position of the image in the image editor. 
Changing any of these parameters will result in loss of the image’s geographical 
reference.

All modifications should be done in the container properties editor.

The geo map can be placed on any Geometry Object; however, the geographical 
referencing will not be correct when placed on 3D objects other than Globe. It is 
recommended, for best geographical referencing results, to use GeoImage, Globe 
or terrain objects.



14 Frequently Asked Questions
This section contains some of the frequenctly asked questions concerning the use
of Viz World Client and Server.
• I can connect Client A to the map server, client B is able to ping the map 

server, but Client B still has no connection to the map server. What is wrong?
• Sometimes, a machine is not accessible to all other computers in the 

network by its hostname.
• For example, if there are two clients, Client A & Client B, and the Viz World 

Server and the Server Allocator running on the MapServer machine, Client A 
might resolve MapServer to the IP 192.168.1.100, but Client B might not 
resolve it to the same IP, or might not resolve it at all because ClientB is on 
another subnet or for any other given reason.

• Both clients can access the MapServer if it was defined as 192.168.1.100 or 
MapServer.company.domain.

• A frequenct problem is therefore that users might write in Client B’s Viz 
Config the IP 192.168.1.100, and in Client A’s Viz Config MapServer 
(because that is the address each can resolve); however, this will result in 
that the Server Allocator will return to both clients the same hostname that 
was specified in the Server Launcher Configuration tool and therefore only 
accessible to ClientA.

• In other words, in the field of ControledMapServer, the hostname/IP that is 
specified has to be known to all clients and the Server Allocator machine.

• I have problems loading my map scenes in Viz Trio?
• Map scenes often use a large amout of texture memory; hence, this will take 

time to load and might cause Viz Trio’s local preview channel to time out.
• In Viz Trio it is possible to adjust the Viz Engine Connection Timeout for the 

local preview channel.
• Click the Config button, and under the Miscellaneous section select Local 

Viz Renderer, and set the Viz Engine Connection Timeout parameter.

Note: There is no such setting for the Viz Content Pilot (VCP) client as the VCP client 
itself does host the Viz process for local preview

• What are the Digital Globe proxy and firewall configuration settings?
• If you need to use a proxy, remember to set your Proxy Server settings.
• All communication to Digital Globe servers goes through https to 
services.digitalglobe.com because https encrypts the entire request 
(i.e. both header and body) .

• Ask your IT department to allow communication to the following Digital 
Globe server address: 205.166.175.52.

• See also Digital Globe cache settings.

• What are the Microsoft Bing Maps proxy and firewall configuration settings?
• If you need to use a proxy, remember to set your Proxy Server settings.
• All communication to Microsoft Bing Maps servers goes through http (SOAP 

and regular HTTP GET) on port 80.
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• Any sub-domain of virtualearth.net should be accessible to Viz World Server 
and Viz Curious Maps. For example: dev.virtualearth.net, 
t1.tiles.virtualearth.net, t3.tiles.virtualearth.net etc.

• See also Microsoft Bing Maps Platform cache settings.

See Also
• Configuring Viz Engine
• Server Launcher
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